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PHẦN I. NHỮNG KIẾN THỨC CƠ BẢN VỀ MÁY TÍNH 

 

Bài 1. Máy tính là gì 

 

I. Các khái niệm 

1. Máy vi tính là một thiết bị điện tử, thao tác thông tin hay dữ liệu. Có có khả năng lưu trữ, 

truy xuất, và xử lý dữ liệu. Như các bạn đã biết, một chiếc máy tính có thể sử dụng để gõ văn bản, 

gửi email, chơi trò chơi hay lướt web. Bạn có thể sử dụng nó để chỉnh sửa bảng tính file excel, file 

thuyết trình power point và cả video. 

 
 

 2. Phần cứng máy tính là bất kỳ 

thành phần nào của máy tính có cấu trúc vật 

lý (to nhỏ, nặng nhẹ, màu sắc hình dạng...) 

hay nói cách khác là cái gì cầm trên tay 

được thì đó là phần cứng. Chẳng hạn như 

chuột, bàn phím, mainbord, chipset... 

 

      

 

3. Phần mềm là bất kỳ cái gì mà 

chạy được trên phân cứng, nó tận dụng phần 

cứng để làm cái gì đó thì đó là phần mềm. 

Phần mềm nó không có cấu trúc vật lý, nó vô hình, không cầm nắm được. Ví dụ: Bộ phần mềm tin 

học văn phòng Microsoft Ofice (word, excel, powerpoint,...), trình duyệt web (chrome, firefox..),  

phần mềm xem phim, nghe nhạc,... 

4. Các loại máy tính: Hầu hết mọi người khi nghe cụm từ máy tính thì họ nghĩ ra một 

cái máy tính để bàn hoặc một cái máy tính xách tay (laptop). Tuy nhiên máy tính có nhiều hình 

dạng, kích cỡ và thực hiện nhiều chức năng khác nhau trong cuộc sống hằng ngày. Ví dụ trong máy 

rút tiền ATM hay máy quét của siêu thị khi tính tiền hay là máy tính cầm tay (casio fx 500,...) chúng 

cũng đc gọi là máy tính, và đó làm một trong những loại máy tính khác với cái máy tính mà ta hay 

gọi (desktop - máy tính bàn hay laptop - máy tính xách tay). 

4.1. Máy tính để bàn 

Main máy 

tính 
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Máy tính để bàn thường được sử 

dụng tại nơi làm việc, văn phòng, công ty, 

trường học, thư viện... Nó có thể to nhỏ, hay 

vừa tùy theo phong cách, cấu hình và điều 

kiện làm việc của người sử dụng. Khi sử 

dụng máy tính để bàn, chúng ta hay gắn thêm 

chuột, bàn phím để sử dụng, thì chúng cũng 

là một phần của máy tính để bàn. 

Hầu hết các máy tính để bàn thì rất dễ 

dàng để nâng cấp phần cứng, hoặc mở rộng, 

hoặc bổ sung các bộ phận mới. Một lợi ích 

của máy tính để bàn là chi phí đầu tư của nó. 

Nếu bạn so sánh một máy tính để bàn với một máy tính xách tay với cấu hình tương tự thì chi phí 

của nó rẻ hơn nhiều. 

4.2. Máy tính xách tay – LAPTOP 

Máy tính xách tay là loại máy tính thứ 2 

rất quen thuộc với bạn, nó còn được gọi là laptop. 

Máy tính xách tay thì chạy bằng pin hoặc nguồn 

một chiều (AC), máy tính cá nhân thì di chuyển dễ 

dàng hơn máy bàn rất nhiều, cho phép bạn sử dụng 

chúng ở bất kỳ đâu. 

Bởi vì một máy tính xách tay nhỏ hơn so 

với máy tính để bàn, nên nó sẽ khó khăn hơn khi 

mở nó ra để xem các thành phần bên trong và cũng 

khó khăn hoặc không cho phép bạn nâng cấp phần 

cứng dễ dàng khi bạn có điều kiện nâng cấp như 

máy tính để bàn.  

4.4. Máy tính bảng - Tablet 

Máy tính bảng còn thường xuyên gọi là 

tablet là một loại máy tính cầm tay mà thậm chí còn cầm 

nhiều hơn, di động hơn so với máy tính xách tay laptop. 

Thay vì có bàn phím và bàn di chuột (touchpad) tách biệt thì 

máy tính bảng sử dụng cảm ứng để gõ và di chuyển, IPad là 

một ví dụ của máy tính bảng đấy. 

Máy tính bảng không thể làm mọi thứ như máy tính 

xách tay máy tính bàn làm làm được, vì vậy bạn nên có một 

cái máy tính để bàn hoặc máy tính xách tay để làm việc. 

Nhưng nếu bạn chỉ muốn chơi game nhỏ và kiểm tra 

email, lướt web hoặc tham gia chát chít trên mạng xã hội, 

nghe nhạc, xem video thôi thì máy tính bảng là một lựa 

chọn tốt. 

4.5. Máy chủ - Server 

Máy chủ cũng là một cái máy tính, loại này ít 

người tiếp xúc với nó hơn, nó là máy tính phục vụ thông 

tin cho các máy tính khác trên mạng. Nhiều doanh nghiệp 

tạo ra các máy chủ để chứa thông tin doanh nghiệp và cho 

phép nhân viên truy cập tập tin trên máy chủ để làm thao 

tác, chia sẻ file. Máy chủ có thể nhỏ như cái máy để bàn, cũng có cái máy chủ (server) rất lớn, có 

khi hệ thống máy chủ to hơn cái sân vận động ấy. 
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Các máy chủ cũng đóng vai trò quan trọng trong việc truy cập internet. Chúng là nơi các 

trang web được lưu trữ, khi bạn sử dụng trình duyệt của bạn bấm vào một liên kết, một máy chủ 

web sẽ cung cấp trang bạn yêu cầu. 

4.6. Các loại máy tính khác 

Ngày nay có rất nhiều thiết bị hàng ngày mà về cơ bản là một máy tính chuyên biệt mặc dù 

chúng ta không nghĩ rằng đó là máy tính. Ví dụ: 

Điện thoại di động: Nhiều loại điện thoại di động có thể làm được rất nhiều chuyện như máy 

tính vẫn làm chẳng hạng như lướt web, cho trò chơi, xem video, viết ghi chú, soạn mail... Các điện 

thoại này thường được gọi là smartphone hay điện thoại thông minh. 

Máy chơi game: là cái máy trò chơi giao diện điều khiển là một dạng riêng biệt của máy tính 

đang sử dụng để chơ trò chơi. Mặc dù nó không đầy đủ các tính năng như máy tính để bàn nhưng 

chơi được nhiều game mới, lớn... 

TV: Nhiều tivi ngày nay bao gồm các ứng dụng hoặc ứng dụng cài thêm giúp bạn truy cập 

nhiều loại nội dung trực tuyến. Ví dụ có thể xem facebook, tin tức hay xem phim trực tuyến... 

 

Bài 2. Tổng quan về Hệ điều hành windows 

1. Hệ điều hành Windows là gì? 

Hệ điều hành là tập hợp các chương trình phần mềm chạy trên máy tính, dùng để điều hành, 

quản lý các thiết bị phần cứng, các tài nguyên, phần mềm trên máy tính. Hệ điều hành đóng vai trò 

trung gian trong việc giao tiếp giữa người sử dụng và phần cứng, phần mềm máy tính, cung cấp một 

môi trường cho phép người sử dụng phát triển và thực hiện các ứng dụng của họ một cách dễ dàng. 

Để biết máy tính đang sử dụng phiên bản hệ điều hành Windows nào, bạn hãy làm theo các 

bước như sau: 

- Bạn bấm đồng thời phím Windows (phím có hình cửa sổ) trên bàn phím và phím R, khi cửa 

sổ Run hiện ra, bạn gõ Winver và bấm OK. 

- Cửa sổ mới xuất hiện sẽ cung cấp cho bạn đầy đủ các thông tin về hệ điều hành bạn đang 

sử dụng. 

 
  

Không phải ngẫu nhiên mà hệ điều hành Windows lại chiếm một vị trí độc tôn về thị phần 

trên thị trường hiện nay. Vậy Hệ điều hành Windows là gì? 

Nền tảng hệ điều hành Windows được Microsoft khai sinh vào tháng 11 năm 1985. Cho đến 

nay, trải qua nhiều phiên bản với nhiều sự thay đổi, hệ điều hành Windows đã gặt hái rất nhiều 
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thành công. Một số loại hệ điều hành windows được kể đến như: Windows 3.1, Window 98, 

Windows XP, Windows 2000, Windows Vista, Windows 7,  và Window 8, Windows 10,... Ngoài 

ra, còn phải kể đến các hệ điều hành dành riêng cho máy chủ (Server) như: Window server 2003, 

2008, 2012,... 

 

2. Những điểm mạnh của nền tảng Windows 
Tính tương thích cao: Vốn là một nền tảng chiếm thị phần sử dụng cao nhất hiện nay nên 

cũng không có gì khó hiểu khi hầu hết các nhà sản xuất đều đầu tư xây dựng phần mềm cũng như 

sản xuất phần cứng hỗ trợ cho hệ điều hành Windows. 

Bảo mật: Về mặt bảo mật, tuy Windows không được bảo mật toàn diện như các nền tảng 

khác như: Linux, Mac OS … nhưng Microsoft vẫn làm việc chăm chỉ hằng ngày để thường xuyên 

cung cấp cho bạn những bản vá các lỗ hổng bảo mật. 

Hỗ trợ nhiều ứng dụng: Có thể nói rằng, Windows hỗ trợ đầy đủ các ứng dụng bạn cần và 

nhiều hơn rất nhiều, vượt trội hơn so với các hệ điều hành khác. Đơn giản một điều, các nhà viết 

ứng dụng luôn muốn nhắm đến một thị trường có số người sử dụng đông đảo như Windows. 

Hỗ trợ tối đa cho màn hình cảm ứng (Windows 8 trở lên): Các dòng Laptop hỗ trợ màn hình 

cảm ứng đều được vận hành trên nền tảng Windows 8 trở lên. Windows 7 cũng hỗ trợ cảm ứng 

nhưng chưa hoàn thiện bằng Windows 8. 

Kho ứng dụng riêng: Bắt đầu từ Windows 8, Microsoft đã đầu tư một giao diện Metro hoạt 

động song song với giao diện Desktop quen thuộc, và điểm đặc biệt trên giao diện Metro này chính 

là kho ứng dụng Windows Store. Gần đây, số lượng ứng dụng đã bắt đầu tăng lên rất nhanh và nếu 

bạn đang sở hữu một thiết bị có màn hình cảm ứng thì sẽ thật sự tuyệt vời khi sử dụng những ứng 

dụng này. 

3. Điểm yếu của Windows 
Do được sử dụng quá phổ biến nên nền tảng Windows tập trung rất nhiều sự chú ý của 

Hacker, vì thế phần lớn các virus, phần mềm gián điệp, mã độc… đều được viết để hoạt động trên 

nền tảng này. Việc phòng chống virus luôn phải được cập nhật thường xuyên và đầy đủ. Đặc biệt do 

tình trạng sử dụng Windows “lậu” rất cao tại Việt Nam dẫn đến việc sử dụng máy tính cá nhân chứa 

nhiều rủi ro tiềm ẩn liên quan đến vấn đề bảo mật. 

 

Bài 3. Hệ điều hành Windows XP 

Windows là phần mềm hệ điều hành của hãng Microsoft. Với giao diện đồ họa thông qua hệ 

thống thực đơn và các hộp hội thoại đa dạng, hệ điều hành Windows dễ sử dụng. Các hệ thống máy 

vi tính hiện nay tại Việt Nam và nhiều nước trên thế giới thường dùng hệ điều hành Windows. Thị 

phần sử dụng Hệ điều hành máy tính thống kê đến tháng 9/2015 như sau: 
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Hệ điều hành Windows 7 đang là hệ điều hành có số người sử dụng cao nhất (57,67%), tiếp 

đến là: Windows XP (12,14%), Windows 8.1 (11,39%), Windows 10 (5,21%), các hệ điều hành còn 

lại đều chiếm dưới 5%. 

Windows là hệ điều hành đa tác vụ (hay đa nhiệm), nghĩa là có thể thực hiện đồng thời nhiều 

nhiệm vụ. Ví dụ, vừa nghe nhạc, vừa sử dụng phần mềm Excel để tính toán, hay phần mềm 

Winword để soạn thảo văn bản. Ngoài ra hệ điều hành Windows còn có chức năng Plug and Play 

(cắm và chạy) tự động cài đặt các thiết bị được gắn thêm vào hệ thống, cũng như các tiện ích để nối 

kết mạng và Internet.  

1. Cách sử dụng chuột và bàn phím: 

1.1. Sử dụng chuột: 

Trong quá trình làm việc với Windows, thiết bị chuột  giúp 

bạn thao tác nhanh hơn và tiện lợi hơn với các đối  tượng trong 

Windows. Chuột thường gồm 3 nút bấm (còn gọi là nút chuột trái, 

phải và lăn).  Hầu hết các chương trình máy vi tính đều có giao 

diện đồ họa trực quan, các thao tác lệnh đều thực hiện thông qua 

các trình đơn Menu nên việc dùng chuột để thao tác rất thông 

dụng. Đối với nhiều người, chuột được sử dụng nhiều hơn bất cứ 

thiết bị nào khác của máy vi tính. Chuột thường được hiển thị trên 

màn hình dưới dạng một biểu tượng (Icon) hay còn gọi là con trỏ 

chuột. Hình dáng của con trỏ chuột có thể thay đổi tùy theo 

chương trình, vị trí, trạng thái làm việc của chương trình... 

1.1.1. Các nút chuột 

- Nút trái (Left Button): Nằm phía bên trái khi cầm chuột, đây là nút chính được sử dụng 

nhiều nhất. Nhấn nút này 1 lần (Left Click) để chọn, nhấn 2 lần liên tiếp (nhấn đúp, Dubble Click) 

để mở hoặc chạy đối tượng đang được chọn. 

- Nút phải (Right Button): Nằm phía bên phải khi cầm chuột, thường có tác dụng để mở một 

trình đơn (Menu) lệnh, và các lệnh này sẽ thay đổi tùy vào vị trí con trỏ hoặc chương trình. 

Nếu một lúc nào đó bạn cảm thấy mất phương hướng không biết sử dụng hoặc thoát khỏi 

chương trình ra sao thì hãy nhấn vào nút phải chuột (Right Click), bạn sẽ tìm được cách giải quyết. 

- Nút cuộn (Scroll Button): Thường nằm ở giữa 2 nút trái và phải, có tác dụng cuộn màn hình 

lên/xuống, trong một số chương trình xử lý ảnh nút này có tác dụng phóng to/thu nhỏ (Zoom). 

Ngoài cách sử dụng trên nút cuộn có một cách sử dụng khác mà ít người biết đến đó là nhấn vào nút 

này sau đó di chuyển chuột... 

1.1.2. Sử dụng chuột – Các thao tác với chuột 

Cầm chuột trong lòng bàn tay phải, ngón trỏ đặt lên nút bên trái, ngón giữa đặt lên nút bên 

phải, ngón cái và các ngón còn lại giữ chặt xung quanh thân chuột. Nếu sử dụng tay trái thì cầm 

ngược lại. 

Định vị con trỏ (Pointing): Cầm chuột di và di chuyển chuột theo các hướng, mắt nhìn vào 

màn hình để định vị trí cho con trỏ chuột chỉ vào đúng các đối tượng cần chọn trên màn hình. 

Chọn (Select) một đối tượng: Chỉ con trỏ chuột vào một đối tượng trên màn hình và nhấn nút 

trái chuột một lần để chọn.  Nhấn và giữ nút trái chuột sau đó kéo thành một đường bao xung quanh 

để chọn một hoặc nhiều đối tượng nằm trong đó. 

Mở, chạy (Open, Run) một tập tin hoặc chương trình: Chỉ con trỏ chuột vào một biểu tượng 

của tập tin hoặc chương trình ứng dụng  và nhấn nút trái chuột hai lần liên tiếp (nhấn đúp) để mở tập 

tin hoặc chạy chương trình đang chọn. 

Kéo và thả (drag and drop): Nhấn, giữ nút trái chuột vào một đối tượng, sau đó di chuyển 

(Move) đối tượng này đến vị trí khác và thả nút trái chuột đang nhấn ra. 

Chọn một đoạn văn bản (Text Select): Đưa con trỏ chuột vào vị trí đầu của đoạn văn bản, con 

trỏ sẽ chuyển thành dấu I, nhấn và giữ nút trái chuột sau đó kéo đến cuối đoạn văn bản muốn chọn. 



6 

 

1.1.3. Con trỏ chuột 

Một số chương trình cho phép thay đổi hình dạng của con trỏ chuột khác nhau. Tuy nhiên về 

cơ bản thì con trỏ chuột có những dạng sau: 

 

1. Trỏ chuột đang ở trạng thái bình thường dùng để 

chỉ, chọn... nhấn chuột vào đối tượng nào đó để chọn 

nó. 

2. Thường xuất hiện khi chỉ vào các liên kết (Link), 

khi nhấn vào các liên kết này thì trình duyệt sẽ được 

mở đến địa chỉ liên kết. 

3. Thường xuất hiện trong các chương trình xử lý 

văn bản hoặc các vùng được phép nhập ký tự văn 

bản (Text), ký tự sẽ xuất hiện ngay tại vị trí của con 

trỏ khi được gõ từ bàn phím. 

4. Xuất hiện để báo thao tác chuột đang thực hiện 

không hợp lệ. 

5. Trỏ chuột đang ở trạng thái xử lý một tác vụ nào 

đó, hiển thị này báo cho người sử dụng biết cần phải 

chờ. 

6. Trỏ chuột đang ở trạng thái thu nhỏ hoặc kéo giãn đối tượng theo hướng của mũi tên. 

7. Trỏ chuột đang ở trạng thái di chuyển (Move) đối tượng theo 4 hướng của mũi tên. 

 

1.2 Sử dụng bàn phím 
 

   

Sử dụng phím  Chức năng thực hiện 

Windows key: Kích hoạt menu start 

Ctrl + ESC Kích hoạt menu start 

Application key: Kích hoạt nhanh Shortcut menu 

ALT + F4 Đóng cửa sổ hiện thời hoặc kết thúc một chương trình 

CTRL + F4 Đóng cửa sổ hiện thời trong một chương trình với giao diện 

tài liệu đa cửa sổ (MDI) 

CTRL + C
 

Sao chép đối tượng vào Clipboard 

CTRL + X Cắt đối tượng vào Clipboard 

CTRL + V Dán đối tượng từ Clipboard 

CTRL + Z Huỷ bỏ (Undo) lệnh, thao tác vừa thực hiện 

CTRL +A Chọn tất cả các đối tượng 

DELETE Xoá các đối tượng đang chọn, xóa kí tự sau con trỏ 

BACKSPACE Quay về cấp thư mục cao hơn, hoặc xóa kí tự trước con trỏ 

F1 Bật chức năng trợ giúp của Windows 

F2 Thao tác nhanh chức năng đổi tên Folder, File 

F3 Bật nhanh chức năng tìm kiếm 

F5 Thao tác nhanh chế độ làm tươi (Refresh) 

 

2. Một số thành phần giao diện cơ bản của Windows XP 

2.1. Thực đơn Start và thanh tác vụ (Taskbar) 

2.1.1. Thực đơn Start  
Nút Start  và  thanh  tác  vụ  thường  nằm ngang  dưới đáy màn hình sau khi khởi động   
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Windows.   Thông  thường,  thanh Taskbar được đặt 

ở chế độ luôn vluôn nhìn thấy được. 

Kích chuột vào nút start, thực đơn start xuất  

hiện với các nhóm chức năng cần thiết để   bắt   

đầu   sử dụng Windows. Thực đơn này sẽ thay đổi 

với từng máy tính khác nhau tuỳ thuộc vào số lượng  

các  chương  trình  được   cài  đặt trong máy. Tuy 

nhiên thực đơn này luôn luôn có những thành 

phần cơ bản nhất định như hình bên trên. 

Đối  với  Windows  XP,  thực  đơn  Start 

được chia thành 2 cột. Cột bên trái chứa các 

chương trình vừa được sử dụng trước đó. 

2.1.2. Thanh tác vụ (Taskbar) 
Khi thực hiện một chương trình hoặc mở một cửa sổ, bạn sẽ thấy xuất hiện trên thanh 

Taskbar một nút thể hiện chương trình hoặc cửa sổ mà bạn đang mở. Tại một thời điểm, có thể 

có nhiều cửa sổ được mở để làm việc. Bạn có thể chuyển tới các cửa sổ khác nhau bằng cách 

kích chuột vào các nút trên thanh Taskbar. 

 

 

 

2.1.3. Tắt máy  
Để kết thúc làm việc với Windows, bạn hãy thực hiện theo các bước sau: 

Kích  chuột trái vào  nút  Start  và chọn  

Turn  off  Computer,  một hộp thoại xuất hiện 

(hình bên). 

Kích  tiếp  chuột trái vào  nút : Turn Off 

 

Tuy nhiên, thực hiện tất cả các lệnh này nhanh chóng, trong Windows mặc định cho chúng 

ta khi nhấn nút Power trên Case máy tính, thì máy sẽ tự động thực hiện tất cả các thao tác trên. 

 

2.2. Màn hình nền (Desktop) 
Màn hình nền (Desktop) của Windows được bố trí rất nhiều các biểu tượng (Icon) khác  

nhau. Sau đây là ý nghĩa một số biểu tượng có sẵn khi cài đặt Windows: 

Biểu tượng Ý nghĩa 

 

Chứa các tài nguyên trong máy của bạn 

 

 

Chỉ cần kích đúp chuột vào đây, bạn có thể mở thư mục chứa các văn 

bản đã có sẵn trên đĩa 

 

 

Thùng rác, chứa các đối tượng đã bị xoá để khi cần có thể khôi phục lại 

 

 

Trình duyệt Internet của hãng Microsoft, đây là chương trình giúp bạn 

truy cập Internet 
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Chương trình Outlook Express, đây là chương trình giúp bạn gửi và nhận 

thư điện tử, rất nhanh và tiện lợi 

 

Các biểu tượng do người dùng tự tạo gọi là Shortcut, có mũi tên nằm ngay ở phía dưới góc 

trái. Các biểu tượng này liên kết đến một chương trình trên máy, khi kích đúp chuột vào các 

biểu tượng này thì chương trình đó sẽ chạy. 

2.2.1. Sắp xếp các biểu tượng 
 

- Kích chuột phải vào chỗ trống trên màn hình nền, xuất hiện menu popup: 

- Kích chuột vào mục Arange Icons, xuất hiện thêm một menu popup nhỏ, bao gồm các lựa 

chọn: 

ƒ by Name:  Sắp xếp theo tên Icon 

ƒ by Type:  Sắp xếp theo kiểu Icon 

ƒ by Size:  Sắp xếp theo kích thước Icon 

ƒ by  Date:  Sắp xếp theo thời gian tạo Icon 

ƒ Auto  Arrange:  Tự động  sắp xếp các Icon 

 

2.2.2. Đổi tên biểu tượng 
- Bấm chuột phải vào biểu tượng cần đổi tên, xuất hiện một menu popup. Kích tiếp chuột vào 

mục Rename. Gõ tên mới cho biểu tượng và nhấn Enter. 

- Phím tắt thực hiện: F2 

 

2.2.3. Xoá biểu tượng 
 

 - Bấm chuột phải vào biểu tượng cần xoá, xuất hiện một menu popup 

- Kích tiếp chuột vào mục Delete. Một hộp thoại sẽ hiện ra hỏi bạn có chắc chắn xoá biểu 

tượng  này  không? Bạn hãy kích chuột vào nút Yes nếu chắc chắn xoá. 

 
 

 

3. Các thiết bị lƣu trữ, thƣ mục, tệp tin 
 

3.1. Xem thông tin về ổ đĩa 

Để xem các thông tin về ổ đĩa, trên màn hình nền 

Desktop, Click đúp chuột vào biểu tượng My Computer. 

Cửa sổ My Computer xuất hiện như sau: 

 

Để xem thông tin về một ổ đĩa, bạn kích chuột phải 

vào ổ đĩa và chọn Properties: 

 

 

3.2. Xem thông tin về thƣ mục 
Để xem thông tin về một thư mục, tệp tin, bạn kích chuột phải vào đối tượng đó và chọn 
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Properties: 

 

 
 

 Phân vùng C: như hình bên phải được định dạng NTFS, đây là định dạng bắt buộc đối với hệ 

điều hành Windows 7, Windows 8, Windows 10.  

Kích thước file và dung lượng tối đa của phân vùng dùng NTFS có thể rất lớn. Một số tính 

năng hiện đại của NTFS có thể kể đến là các tính năng về bảo mật như: đặt quyền truy cập cho tập 

tin; ghi nhận những thay đổi dữ liệu giúp dễ dàng phục hồi nếu máy tính gặp sự cố; tạo các bản sao 

(copy) dành cho sao lưu (backup); mã hoá (encryption); đặt hạn ngạch đĩa (disk quota limit)... cùng 

một số tính năng khác. Chúng rất quan trọng cho các phân vùng hệ thống, đặc biệt là tính năng đặt 

quyền truy cập cho tập tin. 

 

Bài 4: Sử dụng chƣơng trình Windows Explorer. 
 

1. Sử dụng chƣơng trình Windows Explorer 
 

1.1. Khởi động chƣơng trình 
Cách 1: Kích chuột vào nút Start, chọn nhóm Programs sau đó chọn Windows Explorer 

Cách 2: Bấm chuột phải lên nút Start, 

chọn Explorer. Khi đó, trên màn hình xuất hiện 

một cửa sổ như sau: 

1.2. Giao diện của chƣơng 

trìnhWindows Explorer 
Cửa sổ được chia làm hai phần. Phần 

bên trái hiển thị danh sách các ổ đĩa, thư mục, 

các tài nguyên có trong máy của theo dạng 

phân cấp hình cây. Phần bên phải hiển thị nội 

dung của thành phần hiện thời mà bạn đang 

chọn ở bên trái. Bạn cần chú ý đến một số 
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thành phần sau: 

 

Thanh thực đơn (menu): 

 

 

        Thanh thực đơn chứa các nhóm lệnh của cửa sổ chương trình. Nhóm File chứa các lệnh 

tạo thư mục và tệp. Nhóm Edit chứa các lệnh liên quan đến các thao tác Copy, Cut, Paste. Nhóm 

View chứa các lệnh về trình bày, hiển thị giao diện cửa cửa sổ chương trình. Nhóm Favorites 

chứa liên kết liên quan đến các thư mục, chương trình, các trang Web mà bạn yêu thích.... 

Thanh công cụ (Toolbar): 

 

 

 

Trên thanh công cụ chứa một số nút lệnh thông dụng, ý nghĩa của các nút lệnh này được 

trình bày trong bảng sau: 

Nút lệnh  Ý nghĩa 
 

Back    Quay trở lại trạng thái sau 

 

Forward  Quay về trạng thái trước 

 

         Up  Trở về thư mục mẹ của thư mục hiện thời 

         Copy  Sao chép thư mục, tệp 

          Cut  
Di   chuyển   thư   mục,   tệp   vào   bộ   đệm 

(Clipboard) 

         Paste  Dán tệp, thư mục từ bộ đệm ra thư mục đích 

         Undo  Huỷ các thao tác đã thực hiện 

         Delete  Xoá thư mục, tệp 

         Properties  Xem thuộc tính của thư mục, tệp 

 

        Views  Chọn cách hiển thị của thư mục, tệp trên cửa sổ 

 

- Bạn có thể kích chuột vào các nút trên hình cây bên trái để mở rộng hoặc thu hẹp hình cây 

thư mục. 

- Bạn có thể mở một văn bản hoặc khởi động một chương trình bằng các kích đúp chuột vào 

biểu tượng trong cửa sổ bên phải của Windows Explorer. 

- Bạn có thể thay đổi cách thể hiện các biểu tượng trên phần bên phải cửa sổ bằng cách 

thay đổi các lựa chọn hiển thị: Trong thực đơn View, bạn chọn các dạng như Thumbnails, Tiles, 

Icons, List, Detail. 

- Bạn có thể thêm hoặc bớt các biểu tượng trên thanh công cụ. Trên cửa sổ của chương 

trình Windows Explorer,  bạn thực hiện lệnh View/Customize.., một hộp thoại xuất hiện như sau: 
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Phần bên phải của hộp thoại là các nút lệnh đang được hiển thị trên thanh công cụ cửa cửa sổ 

chương trình. Ý nghĩa của một số nút lệnh trên cửa sổ như sau: 

Nút lệnh  Ý nghĩa 
 

Add  
Bổ sung thêm nút lệnh vào thanh công cụ (sau khi chọn nút lệnh 

ở phần bên trái) 

Remove  
Gỡ bỏ nút lệnh trên thanh công cụ (sau khi chọn nút lệnh ở 

phần bên trái) 
Reset  Khôi phục trạng thái ban đầu của thanh công cụ 

Move Up  Chuyển nút lệnh lên trên 

Move Down Chuyển nút lệnh xuống dưới 

 

 

2. Thao tác với thƣ mục và tệp tin trong chƣơng trìnhWindows Explorer 
 

2.1. Lựa chọn thƣ mục, tệp tin 
- Chọn một đối tượng (thư mục, tệp tin): Kích chuột vào đối tượng đó. 

- Chọn nhiều đối tượng kề nhau: Kích chuột vào đối tượng ở vị trí đầu, nhấn và giữ phím 

Shift, sau đó kích chuột vào đối tượng cuối. 

- Chọn nhiều đối tượng rời nhau: Nhấn và giữ phím Ctrl, kích chuột lần lượt vào các đối 

tượng cần chọn. 

- Chọn toàn bộ đối tượng trong một thư mục: Thực 

hiện lệnh Edit / Select All 

hoặc nhấn tổ hợp phím Ctrl + A. 

2.2. Tạo mới, đổi tên, xóa, sao chép, di chuyển thƣ 

mục và tệp tin 

2.2.1. Tạo thư mục mới 
Chọn thư mục mẹ (thư mục sẽ chứa   thư mục mới): 

Kích  chuột  vào  thư  mục mẹ. 
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   Thực hiện lệnh File/New/Folder. 

   Windows sẽ tạo ra một thư mục mới với tên mặc định là New Folder hoặc New Folder 

(2), New Folder (3)… và chờ ta  gõ tên thư mục mới vào để thay thế cho tên mặc định. Bạn hãy 

nhấn Enter để xác nhận tên cho thư mục mới hoặc kích chuột vào một vị trí bất kì trên màn hình. 

 

2.2.2. Tạo tệp văn bản (Text file) 

Chọn thư mục mẹ của tệp cần tạo bằng cách kích chuột vào thư mục mẹ, khi đó phần bên 

phải của cửa sổ sẽ hiển thị nội dung của thư mục đó. 

     Thực hiện lệnh File / New / Text Documet. Windows sẽ tạo ra một tệp văn bản  trống  

với  tên  mặc  định  là  New  Text  Document.txt  hoặc  New  Text Document (2).txt... và chờ ta 

gõ tên mới vào để thay thế cho tên mặc định. Bạn hãy nhấn Enter để xác nhận tên mới cho tệp 

hoặc kích chuột vào một vị trí bất kì trên màn hình. 

Kích  đúp  chuột  vào  tệp  văn  bản  vừa  tạo,  Windows  sẽ  mở  chương  trình 

Notepad để bạn nhập nội dung cho tệp vừa tạo: 

Trên cửa sổ của chương trình Notepad, bạn thực hiện lệnh File / Save để ghi lại tệp văn 

bản vào đĩa. Phím tắt: Ctrl + S 

 

2.2.3. Đổi tên thư mục và tệp tin 
Bấm chuột phải vào thư mục hoặc tệp tin cần đổi tên, kích chuột vào mục Rename trên 

thanh menu popup vừa xuất hiện. Gõ tên mới vào để thay thế cho tên cũ và nhấn Enter để xác 

nhận hoặc kích chuột vào một vị trí bất kì trên màn hình. Phím tắt: F2 

 

2.2.4. Sao chép thư mục, tệp tin 
Trên phần cửa sổ bên phải, chọn thư mục hoặc tệp tin cần sao chép bằng cách kích chuột 

vào chúng. 

  Thực hiện lệnh Edit / Copy , phím tắt: Ctrl + C 

  Chọn thư mục đích mà ta cần sao chép tới, thực hiện lệnh  Edit / Paste. Hộp thoại 

Copying sẽ xuất hiện như hình dưới: 

 

2.2.5. Di chuyển thư mục, tệp tin 
          Trên phần cửa sổ bên phải,  chọn  thư 

mục hoặc   tệp  tin  cần  di chuyển bằng cách 

kích chuột vào chúng. 

Thực hiện lệnh Edit / Cut. 

Phím tắt: Ctrl + X 

Chọn thư mục đích mà ta cần sao chép 

tới, thực hiện lệnh Edit/ Paste 

 

2.2.6 Xoá thư mục, tệp tin 
    Chọn thư mục hoặc tệp tin cần xoá. 

  Thực hiện lệnh Edit / Delete. Windows sẽ 

hiển  thị một  hộp thoại   hỏi bạn có   chắc chắn xoá  

các thư   mục   hoặc tệp  đã chọn không? Bạn 

hãy kích chuột vào nút Yes nếu khẳng định xoá. 

Phím tắt: Delete 

 Khi muốn xóa thư mục, tệp tin mà không 

lưu lại trong Recycle Bin thì ta dùng tổ hợp phím 

Shift+Delete 
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2.2.7. Khôi phục thư mục, tệp tin đã bị xoá 

Trên màn hình nền (Desktop), kích đúp chuột lên biểu tượng thùng rác. Cửa sổ Recycle Bin 
xuất hiện chứa các đối tượng đã bị xoá: 

Kích chuột phải lên đối tượng cần khôi phục, chọn Restore để khôi phục đối tượng đã 

xoá.. 

 

Bài 5. Cách giữ cho Windows của bạn an toàn hơn 

 

Những việc bạn cần làm sau đây sẽ giúp cho chiếc máy tính chạy hệ điều hành Windows 

được an toàn hơn trước những nguy cơ mất an toàn rình rập. 

1. Cài đặt chƣơng trình diệt virus:  

Virus là nỗi lo chung của hầu hết người dùng máy tính. Bất kỳ ai khi sử dụng máy tính đều 

sợ bị lây nhiễm virus máy tính gây ra tình trạng hệ thống chạy chậm, mất kết nối mạng và quan 

trọng nhất là dữ liệu bị đánh cắp hoặc bị tự động xóa. Do đó, người dùng máy tính nên cài đặt một 

phần mềm diệt virus để phòng tránh được những vấn đề đó. 

Phần mềm diệt virus là một phần mềm không thể thiếu đối với windows, máy tính sẽ an toàn 

hơn rất nhiều ngay cả khi bạn sử dụng phần mềm diệt virus miễn phí. 

Kể từ phiên bản Windows 8, Microsoft đã có tích hợp phần mềm bảo vệ Windows Defender 

và mặc định được kích hoạt ngay từ đầu. Defender không đi kèm trong các phiên bản Windows 

trước đây và nói chung cũng không phải là một giải pháp bảo mật đầy đủ tính năng nhất hiện nay. 

Do đó, các hãng sản xuất máy tính thường vô hiệu hóa công cụ này và cài thêm một số phần mềm 

bảo mật khác như Norton hay McAfee, nhưng thường chỉ là bản dùng thử. 

Một số phần mềm diệt virus miễn phí tốt như: Avira, AVG, Avast, Bkav home, CMC 

antivirus,...  

Ngoài ra bạn nên cài thêm phần mềm phát hiện malware để bảo vệ an toàn cho máy tính 

trong thời đại Internet ngày nay.  

Tuy nhiên, có thể nói không một sản phẩm nào là hoàn hảo giúp bảo vệ người dùng khỏi các 

mối nguy hiểm tiềm tàng trên mạng. Và dẫu cho một công cụ nếu được quảng cáo là có khả năng 

bảo vệ người dùng có thể đạt mức an toàn cao nhất đi nữa, thì điều này không có nghĩa là người 

dùng sẽ hoàn toàn được bảo vệ tuyệt đối khi trực tuyến. 

2. Kích hoạt tƣờng lửa 

Tường lửa (firewall) là một phần rất quan trọng giúp bảo vệ máy tính khi kết nối mạng, 

nhưng đôi khi các ứng dụng, phần mềm độc hại hay chính người dùng tắt chúng đi. Giống như các 

chương trình diệt virus, firewall được yêu cầu phải luôn chạy nền để có thể bảo vệ hệ thống. 
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Tường lửa được yêu cầu phải luôn chạy nền để có thể bảo vệ hệ thống. 

Hệ điều hành Windows tích hợp tính năng Firewall rất hiệu quả và bạn phải đảm bảo là nó 

luôn được kích hoạt. Để thực hiện, hãy vào mục Control Panel > Windows Firewall rồi nhấn vào tùy 

chọn “Turn Windows Firewall on or off” để bật hoặc tắt tính năng này. 

3. Cập nhật các bản nâng cấp mới nhất 

Hãng Microsoft thường xuyên phát hành các bản cập nhật Windows nhằm sửa những lỗi hệ 

thống, vá lỗi bảo mật hoặc đưa ra các tính năng mới cho hệ điều hành. Bạn không cần phải thực hiện 

tìm kiếm trên web, thay vào đó hãy thiết lập để hệ thống tự động tải về và cài đặt mỗi khi có bản cập 

nhật Windows mới nhất. 

Ngoài ra, bạn cũng có thể tự mình thực hiện thao tác cập nhật bằng cách mở Control Panel, 

sau đó chọn System and Security > Windows Update > Check for Updates. Hệ thống sẽ tự động tìm 

kiếm các bản cập nhật, tải về và cài đặt. Sau khi hoàn thành, hãy khởi động máy tính lại để các bản 

cập nhật có hiệu lực. Thao tác khởi động lại này có thể phải thực hiện nhiều lần tùy thuộc vào số 

lượng bản cập nhật đã cài đặt. 

4. Tạo hai tài khoản khác nhau 

Mọi phiên bản Windows đều cho phép tạo nhiều tài khoản người dùng khác nhau nếu máy 

tính được chia sẻ dùng chung. Tuy nhiên, đối với máy tính cá nhân, người dùng cũng cần phải tạo ít 

nhất hai tài khoản cục bộ khác nhau, trong đó một tài khoản quản trị để quản lý Windows và một tài 

khoản riêng cho công việc hoặc vui chơi giải trí. Tài khoản này không nên phân quyền cao nhất, chỉ 

nên phân quyền là người dùng bình thường như ví dụ: 

 

Nếu đang sử dụng tài khoản quản trị viên (Administrator), hãy vào công cụ User 

Accounts trong Control Panel. Tiếp theo, hãy tạo một tài khoản Administrator mới, sau đó thay đổi 

tài khoản trước đây của bạn thành Standard User. 

Giờ đây, bạn có thể tiếp tục làm việc trong tài khoản cũ, tức là tài khoản Standard. Trong khi 

đó, tài khoản Administrator hãy để dành sử dụng cho các trường hợp cần thiết khác. 

5. Cập nhật trình duyệt web phiên bản mới 

Đa số người dùng máy tính ngày nay thường duyệt web hàng ngày. Microsoft mặc định đã 

tích hợp sẵn trình duyệt Internet Explorer vào trong tất cả phiên bản Windows của hãng. Tuy nhiên, 

http://www.pcworld.com.vn/articles/cong-nghe/lam-the-nao/2014/11/1236810/15-thu-thuat-windows-giup-tiet-kiem-thoi-gian/
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một số người dùng lại thích chọn những trình duyệt ưa thích khác như Cốc cốc, Chrome, Firefox 

hay Opera. 

Dù đang sử dụng trình duyệt web nào, bạn cũng nên thường xuyên tải về và cài đặt những 

phiên bản mới để đảm bảo được bảo vệ tốt nhất khi lên mạng. Hãy vào trang web của các hãng cung 

cấp phần mềm để tìm và tải về phiên bản mới nhất của các trình duyệt này. 

6. Hạn chế sử dụng các thiết bị lƣu trữ ngoài 

Hiện nay các thiết bị lưu trữ ngoài như USB, thẻ nhớ được sử dụng khá phổ biến. Thiết bị 

này dễ dàng trở thành nơi lưu trữ virus khi bạn được cắm vào một máy tính đã bị nhiễm virus. Khi 

được cắm trở lại vào máy tính cá nhân, bạn nên quét virus để đảm bảo an toàn. 

7. Mã hóa dữ liệu 

Mã hóa là một cách tuyệt vời để giữ cho dữ liệu an toàn, cho dù bạn truyền nó qua mạng 

Internet, sao lưu lên máy chủ hoặc sao chép lên thiết bị lưu trữ di động và mang theo bên mình. Việc 

mã hóa sẽ không cho phép bất cứ ai, chỉ trừ bạn và người sẽ nhận nó, đọc được dữ liệu. 

Hiện nay có nhiều phần mềm văn phòng có chức năng mã hóa tích hợp, đơn giản và dễ dùng. 

Ngoài ra, còn có một số công cụ chuyên dùng để mã hóa dữ liệu cụ thể hay thậm chí toàn bộ dữ liệu 

trong ổ cứng máy tính. Bạn chỉ cần chọn dữ liệu cần mã hóa và làm theo từng bước hướng dẫn tùy 

từng chương trình. 

8. Quản lý mật khẩu 

Ngày nay, mỗi người dùng trong chúng ta đều có rất nhiều tài khoản trực tuyến, từ mạng xã 

hội cho đến email hay các dịch vụ web khác. Bạn sẽ cần một mật khẩu riêng biệt cho mỗi trang web 

đăng nhập vào, đồng thời mỗi mật khẩu phải dài, mạnh và phức tạp. Ghi chép lại mật khẩu và giữ nó 

an toàn khi bạn có quá nhiều thứ cần nhớ. 

Hãy thử tưởng tượng nếu phải nhớ để nhập một dãy mật khẩu phức tạp mỗi khi muốn đăng 

nhập vào tài khoản dịch vụ web thì bạn sẽ hiểu được những khó khăn khi thực hiện. Để khắc phục tình 

trạng này, bạn có thể sử dụng một trình quản lý mật khẩu để giúp lưu lại mật khẩu, nhờ đó tiết kiệm 

đáng kể thời gian cũng như công sức. 

9. Chú ý khi sử dụng e-mail 

Nếu hộp thư email vượt qua tầm kiểm soát, bạn có thể sẽ phải xem xét lại về phương pháp 

sắp xếp email và lọc hòm thư mình. Thông thường, các dịch vụ email hiện nay đều cung cấp tính 

năng lọc email spam (thư rác), tuy nhiên không phải lúc nào chúng cũng chạy tốt. 

Hàng ngày, hãy dành ra một khoảng thời gian để xử lý và sắp xếp email. Sẽ thật tồi tệ nếu 

chẳng may địa chỉ email của bạn là nơi ồ ạt nhận thư rác mặc dù bạn chẳng bao giờ mong muốn việc 

này. 

Không nên mở những e-mail không rõ nguồn gốc, không mở các tệp đính kèm hoặc đường 

dẫn (link) kèm theo không rõ ràng. Điều đó tránh được đáng kể hiện tượng bị virus xâm nhập vào 

máy tính, có một số trường hợp tại tỉnh Lào Cai đã bị nhiễm virus ransomware chuyên mã hóa dữ 

liệu, người dùng gần như mất hoàn toàn dữ liệu trong máy tính. 

10. Tích cực nâng cao hiểu biết về máy tính 

Ngoài những cách đã giới thiệu, bạn nên tìm hiểu thêm nhiều thông tin từ internet để hiểu 

hơn về cách sử dụng máy tính để đảm bảo an toàn đồng thời khai thác tối đa hiệu quả của việc khai 

thác sử dụng. Nâng cao kiến thức về CNTT thông qua học, hỏi những người am hiểu về CNTT 

trong cơ quan. 

Mỗi khi máy tính có thông báo cần phải lựa chọn hiện ra, hãy đọc kĩ mặc dù nó viết hoàn 

toàn bằng tiếng Anh. Bạn có thể sử dụng từ điển hoặc Google Translate để dịch và thao tác cho 

chính xác. 

 

Bài 6. Bảo quản máy tính để sử dụng hiệu quả 
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 Máy tính sử dụng hiệu quả thì không thể thiếu được việc bảo quản và sử dụng nó đúng cách. 

Thậm chí do vô tình hay sơ ý, chiếc máy bạn mua sẽ không được nhà phân phối bảo hành cho bạn vì 

những lý do hết sức ngớ ngẩn, do thói quen không tốt hoặc do bạn không biết sử dụng như nào. 

 1. Bảo quản phần cứng 

Ngay khi nhận bàn giao máy từ cửa hàng, bạn hãy kiểm tra lại các thông tin trên phiếu xuất 

kho, phiếu bảo hành và hóa đơn. Bạn kiểm tra xem tất cả thông tin trên giấy tờ (thông tin cá nhân 

của bạn, số serial, thông tin sản phẩm) có trùng khớp với thông tin trên sản phẩm nhân viên đó đang 

bàn giao cho bạn không? Nếu thấy sai sót hãy yêu cầu nhân viên đó in lại cho bạn những giấy tờ kia 

không nên để nhân viên đó ký vào vì điều đó không đảm bảo được quyền lợi cho bạn khi có những 

phát sinh xảy ra). 

Ngoài ra bạn còn phải kiểm tra sản phẩm xem chúng có bị xướt, bị rạn vỡ hoặc trục trặc 

không. Tốt nhất khi đi mua máy, bạn hãy dẫn một người hiểu biết về máy tính để có thể tư vấn cho 

bạn mua được sản phẩm phù hợp với nhu cầu sử dụng, tránh sự lãng phí không cần thiết. 

2. Bảo quản trong quá trình sử dụng 

- Tránh để máy tính ở gần nơi ẩm ướt hoặc bụi bẩn. Vì những bụi bẩn hoặc nước có thể 

làm giảm rất nhiều tuổi thọ của máy tính. Thậm chí máy có thể bị hỏng nếu dính nước hoặc máy có 

quá nhiều bụi bẩn bám vào quạt CPU. 

- Không nên để nước, café hoặc nước đá gần máy của bạn. Rất có thể do vô tình bạn làm 

đổ cốc nước vào máy tính và máy của bạn sẽ có nguy cơ trở thành một đống rác thải công nghiệp. 

- Khi máy bị vào nước. Hãy rút ngay nguồn điện và làm khô máy tính nhanh nhất có thể. 

Đối với máy tính xách tay, bạn không nên tự ý tháo máy vì trên máy tính có rất nhiều chi tiết khác 

nhau, nếu bạn không rành lắp ráp máy có thể dẫn đến trường hợp các khớp (cá) trên máy bị gãy; các 

chi tiết có thể không được lắp đúng vị trí nhất là bạn lắp ốc vít không đúng, chiếc ốc vít đó có thể 

xuyên thủng mainboard của máy và làm hỏng hoàn toàn nó. 

- Khi di chuyển máy, bạn hãy tắt máy tính đi và đảm bảo nó đã được tắt hoàn toàn bởi vì 

nếu không tắt máy mà di chuyển máy, đầu từ của ổ cứng sẽ có sự rung động tác động lên bề mặt đĩa. 

Nếu hỏng nhẹ ổ cứng có thể bị Bad Sector, còn nếu hỏng nặng bạn phải thay thế ổ cứng đó bằng 

một ổ cứng mới. 

- Không được để những vật nặng lên trên máy hoặc không được tỳ tay lên máy. 

- Khi đi công tác xa mà phải mang theo máy tính xách tay. Bạn hãy cho máy vào một túi 

chống xốc và để riêng nó vào một ngăn, nên kiểm tra và đảm bảo nó được an toàn khi để vào ngăn 

đó. Một điều quan trọng nữa bạn nên nhớ là hãy để những vật cứng như chuột, Adapter, đồ mỹ 

phẩm… tránh xa ngăn để máy tính xách tay. Vì trong quá trình di chuyển, những vật cứng đó có thể 

va đập làm hỏng màn hình của máy. 

- Khi sử dụng máy ở nhà, bạn không nên để máy trên giường đệm, bởi vì những khe thoát 

khí trên máy có thể bị che đi làm cho nhiệt lượng không được tỏa ra. Từ đó máy dễ sinh ra những 

bệnh “kỳ quái” như hay treo, tự tắt, chạy không ổn định… Ngoài ra những sợi bông nhỏ trên giường 

của bạn có thể bị hút vào những khe đó và bám và tấm tản nhiệt CPU, lâu ngày nếu không vệ sinh sẽ 

dẫn đến tình trạng “kỳ quái” như trên. 

- Đảm bảo hệ thống tản nhiệt luôn hoạt động tốt. 

- Nguồn điện sử dụng máy tính nên là nguồn có chất lƣợng tốt, điện áp ổn định. Nguồn 

điện ảnh hưởng lớn đến độ bền của các thiết bị trong máy tính. 

 3. Những nguyên tắc khi sử dụng máy tính 

- Không truy cập vào những trang web đen, những trang web này có thể là nguồn lây nhiễm 

virus gây ảnh hưởng đến máy tính của bạn cũng như các dữ liệu trên máy. 

- Không gắn những thiết bị lưu trữ mà bạn chưa chắc chắn sạch virus vào máy tính của mình. 

Vì những thiết bị đó là nguồn lây nhiễm virus chủ yếu. Khi gắn USB Flash vào máy tính, để an toàn 

bạn không nên click đúp vào biểu tượng USB Flash. Bạn nên mở USB Flash bằng chương trinh 

Explorer nhưng duyệt file theo dạng cây thư mục. 
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- Không để cho người khác tùy tiện sử dụng máy tính cá nhân của bạn. Nếu là máy dùng 

chung nhiều người, bạn hãy tạo nhiều user khác nhau và phân quyền cho những người đó sử dụng. 

- Sử dụng nguyên tắc phòng hơn tránh để giảm thiểu thiệt hại có thể xảy ra. 

 4. Bảo hành 
Nếu do không may mắn, máy tính của bạn có vấn đề. Bạn phải mang máy tính của mình đi 

bảo hành, bạn hãy đọc những lời khuyên dưới đây để tránh những trường hợp xấu (ngoài ý muốn) 

xảy ra với bạn. 

4.1. Công việc phải làm trƣớc khi đem máy đi bảo hành 
- Bạn hãy sao lưu (backup) tất cả dữ liệu trên máy vào một ổ cứng gắn ngoài hoặc một máy 

tính khác. Những dữ liệu của bạn sẽ không được đảm bảo khi bạn mang đến các trung tâm bảo hành. 

Nếu có sự mất mát dữ liệu thì chính bạn là người phải lãnh lấy hậu quả đầu tiên vì vậy câu “cẩn tắc 

vô áy náy” hoàn toàn đúng trong trường hợp này. 

- Vệ sinh máy thật sạch trước khi đem đến các trung tâm bảo hành. Bởi vì, những người kỹ 

thuật không muốn làm trên những máy quá dơ bẩn. Ngoài ra, việc để máy quá dơ bẩn có thể là một 

lý do khiến các trung tâm bảo hành không nhận bảo hành cho máy của bạn. 

- Bạn hãy chuẩn bị tất cả những giấy tờ, những phụ kiện cần thiết cho việc đi bảo hành máy. 

Hãy tưởng tượng khi bạn đến các trung tâm bảo hành, những nhân viên ở đó không chịu nhận bảo 

hành cho bạn do bạn thiếu những giấy tờ cần thiết. Bạn phải đi về lấy chúng, thật là mất thời gian 

đúng không? 

- Trước khi mang máy đi bảo hành, bạn hãy cầm phiếu bảo hành lên và đọc kỹ mọi điều 

khoản (điều kiện) trên phiếu bảo hành. Sau đó xem xét lại máy của mình và đưa ra sự so sánh đánh 

giá điều kiện bảo hành với lỗi mà máy của bạn đang bị. Nếu những lỗi đó đáp ứng được điều kiện 

bảo hành thì bạn hãy tiếp tục đi. Nhưng nếu lỗi đó không trong điều kiện bảo hành, bạn hãy chuyển 

bị trước những tình huống xấu nhất có thể xảy ra. Hãy vui vẻ chấp nhận những điều đó! 

4.2. Khi mang máy đến trung tâm bảo hành 
- Thông báo rõ tình trạng lỗi của máy với nhân viên kỹ thuật, nếu được bạn hãy liệt kê ra 

một tờ giấy và dán lên máy. 

- Bạn yêu cầu nhân viên kỹ thuật kiểm tra lại máy và thông báo rõ tình trạng lỗi của máy, 

thời gian được nhận lại máy. 

- Kiểm tra kỹ các thông tin trên phiếu nhận bảo hành của trung tâm bảo hành và quan trọng 

hơn nữa là giữ phiếu bảo hành đó thật kỹ hoặc để vào một nơi an toàn tránh thất lạc. 

4.3. Khi bạn nhận bàn giao máy bảo hành 
- Gọi điện đến trung tâm bảo hành hỏi tình trạng của sản phẩm bạn gửi bảo hành trước khi 

qua lấy máy tránh tình trạng qua các trung tâm bảo hành bạn phải chờ đợi, xấu hơn nữa nhân viên ở 

đó trả lời bạn “sản phẩm anh chị gửi bảo hành chưa được!” 

- Kiểm tra kỹ tình trạng của máy khi nhận máy. 

- So sánh lại các thông tin trên phiếu nhận với thông tin hiện tại của máy: Thông tin kỹ thuật 

sản phẩm ( Model của sản phẩm ); Thông tin về số serial. 

5. Sửa chữa -Tìm kiếm nơi sửa chữa máy tính xách tay uy tín 
- Khi máy tính của bạn gặp sự cố, mà thời hạn bảo hành của sản phẩm đã hết. Đầu tiên bạn 

hãy mang máy tính đến các trung tâm bảo hành để yêu cầu sự trợ giúp từ những nơi đó, có thể họ sẽ 

giúp bạn khắc phục những lỗi đó giúp bạn hoặc họ tư vấn cho bạn những địa chỉ đáng tin cậy để có 

thể khắc phục những lỗi đang xảy ra. 

- Hỏi người thân hoặc bạn bè hiểu biết về nghành công nghệ thông tin xem nơi nào sửa chữa 

nhiều kinh nghiệm và uy tín. Tiếp theo bạn hãy đặt ra những câu hỏi để có nhiều kinh nghiệm hơn 

trong việc đi sửa chữa máy. 

- Đánh giá một vài cơ sở sửa chữa mà những người thân của bạn đã cho hoặc những trung 

tâm bảo hành đã giới thiệu. Trường hợp này bạn phải đánh giá hai thứ: Kinh nghiệm và trình độ sửa 

chữa; Uy tín của nơi đó: họ có hay “luộc” đồ không? họ chăm sóc có tốt không?… 
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BÀI TẬP 

1. Muốn phục hồi cửa sổ ta chọn 

a. Nhắp vào nút Maximize 

b. Mở Control box / Chọn Maximize 

c. Mở Control box / Chọn Restore 

d. Chọn Menu File / Restore 

2. Muốn thu nhỏ cửa sổ ta chọn 

a. Mở Control box / Chọn Maximize 

b. Mở Control box / Chọn Restore 

c. Mở Control box / Chọn Copy 

d. Các câu trên đều sai 

3. Muốn đóng cửa sổ ứng dụng ta chọn 

a. Alt + F4 

b. Ctrl + F4 

c. Shift + F4 

d. Alt + F5 

4. Khi mở một hộp thoại, muốn chuyển đổi qua lại giữa các thành phần trong hộp thoại, ta 

dùng: 

a. Phím Tab 

b. Phím Ctrl + Tab 

c. Phím Alt + Tab 

d. Hai câu a. b. 

5. Trong chƣơng trình Windows Explore, muốn tạo thƣ mục: 

a. Chọn File / New / Folder 

b. Chọn File / New / Directory 

c. Chọn File / New / Shorcut 

d. Tất cả đều sai. 

6. Trong chƣơng trình Windows Explore, muốn xóa thƣ mục đã chọn: 

a. Chọn File / Delete, chọn yes 

b. Nhấn phím Delete, chọn yes 

c. Nhắp chuột phải lên tên thư mục, chọn Delete / chọn yes 

d. Tất cả đều đúng. 

7. Trong Windows Explore, muốn thay đổi tên tập tin thƣ mục: 

a. Chọn menu File / Rename, gõ tên mới  

b. Click chuột trái vào tên thư mục, nhấn phím F2, gõ tên mới  

c. Click chuột phải vào tên thư mục, chọn menu Rename, gõ tên mới  

d. Tất cả đều đúng. 

8. Tron Windows Explore, muốn thay đổi thuộc tính của tập tin hoặc thƣ mục: 

a. Chọn File / Properties 

b. Click chuột phải, chọn Properties 

c. Click chuột trái, nhấn phím F3, chọn Properties 

d. Hai câu a. b. đều đúng 

9. Trong Windows Explore, muốn xem nội dung tập tin đã chọn: 

a. Nhấn phím Enter 

b. Nhắp đúp chuột vào tên tập tin 

c. Click chuột phải vào tập tin, chọn Open 

d. Tất cả đều đúng 

10. Trong Windows Explore, muốn sao chép tập tin, đã chọn: 

a. Nhấn Ctrl + dùng chuột rê kéo tên tập tin đến vị trí muốn sao chép đến. 

b. Nhấn Ctrl + C, đến vị trí sao chép đến, nhấn Ctrl + V 

c. Chọn File / Copy, đến vị trí sao chép đến, Chọn Edit / paste 

d. Hai câu a. b. đều đúng 

11. Trong Windows Explore, muốn sao chép thƣ mục đã chọn: 

a. Chọn Edit / Copy, đến vị trí sao chép đến, chọn Edit / Paste 
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b. Nhấn Ctrl X, đến vị trí sao chép đến, nhấn Ctrl + V 

c. Nhấn phím Shift + dùng chuột kéo rê tên đến vị trí sao chép đến. 

d. Hai câu a. b. đều đúng 

12. Trong Windows Explore, muốn khôi phục tập tin vừa bị xóa, trong đĩa cứng cục bộ: 

a. Mở Recycle Bin, chọn tập tin, chọn Open 

b. Mở Recycle Bin, chọn tập tin, chọn Restore 

c. Mở Recycle Bin, chọn tập tin, chọn Save 

d. Tất cả đều sai 

13. Trong Windows Explore, muốn tạo Shortcut: 

a. Chọn biểu tượng muốn tạo Shortcut, chọn File / Create Shortcut 

b. Chọn biểu tượng muốn tạo Shortcut, chọn Edit / Create Shortcut 

c. Nhắp chuột phải lên biểu tượng, Chọn Create shortcut 

d. Hai câu a. c. đều đúng 

14. Muốn tạo Shortcut trên Desktop: 

a. Mở Windows Explore, Dùng chuột phải kéo rê biểu tượng ra ngoài Desktop, chọn Create 

shortcut here 

b. Mở Windows Explore, chọn biểu tượng, chọn Edit / Create Shortcut on desktop 

c. Mở Windows Explore, chọn biểu tượng, Chọn File / Create Shortcut on desktop 

d. Hai câu a. c đều đúng 

15. Để cài đặt một số tính năng của màn hình Desktop: 

a. Chọn Start / Setting / Desktop 

b. Chọn Start / Setting /  Control Panel / Display 

c. Chọn Start / Setting / Display 

d. Chọn Start / Setting / Control Panel / Desktop 

16. Khi muốn xóa một tập tin và đồng thời xóa nó luôn khỏi Recycle Bin ta dùng tổ hợp phím: 

a. Ctrl + Delete 

b. Shift + Delete 

c. Alt +Delete 

d. Backspace +Delete 

17. Hệ điều hành Windows nào đang đƣợc nhiều ngƣời dùng nhất hiện nay 

a. Windows XP  

b. Windows 7 

c. Windows 8 

d. Windows 10 

18. Virus ransomware là loại virus chuyên 

a. Mã hóa dữ liệu 

b. Xóa dữ liệu 

c. Sao chép dữ liệu 

d. Không có hại gì 

19. Virus thƣờng đƣợc lây lan qua 

a. Internet 

b. USB 

c. Đĩa CD, DVD 

d. Phần mềm Office 
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PHẦN II.  

CHƢƠNG TRÌNH SOẠN THẢO VĂN BẢN MS - WORD 
 

Bài 1. GIỚI THIỆU CHUNG VỀ MICROSOFT WORD 2003 
 Microsoft Word 2003 là một phần mềm trong bộ phần mềm dùng cho văn phòng Microsoft 

Office gọi tắt là Word 2003 là phần mềm chuyên dùng để soạn thảo văn bản.  Nó là công cụ rất 

mạnh và thân thiện giúp người sử dụng có thể xử lý hầu hết những vấn đề đặt ra trong quá trình soạn 

thảo một văn bản từ đơn giản đến phức tạp. Tuy nhiên, đó là phần mềm phải trả phí bản quyền để 

được sử dụng một cách hợp pháp. Thực tế hiện nay, nhiều cơ quan, tổ chức bắt đầu chuyển sang sử 

dụng bộ phần mềm soạn thảo miễn phí Open Office với đầy đủ tính năng như bộ phần mềm 

Microsoft Office. 

I. Khởi động và giao diện chƣơng trình: 

1. Khởi động:  

 Cách 1: Kích chuột vào nút Start  All Programs  Microsoft Office  Microsoft 

Word 2003  
 Cách 2: Kích đúp chuột trái vào biểu tượng  trên màn hình nền.  

2. Giao diện của chƣơng trình 

a. Thanh tiêu đề: (Title bar) Hiển thị tên tệp tin đang mở và các nút lệnh: Cực tiểu, 

Cực đại, Đóng.  

 
b. Thanh trình đơn: (Menu bar) Chứa tất cả các lệnh của Word, được phân chia theo từng 

nhóm, gồm có các nhóm: File (tệp tin), Edit (soạn thảo), View (Xem), Insert (Chèn), Format 

(Định dạng), Tool (Công cụ), Window (Cửa sổ), Help (Trợ giúp).  

 
c. Thanh công cụ chuẩn: (Standard Toolbar) Chứa các nút lệnh thường sử dụng.  

 
d. Thanh định dạng: (Formating toolbar) Chứa các nút lệnh dùng cho việc định dạng văn bản.  

 
e. Thanh thƣớc: (Ruler) Gồm có thước ngang và thước dọc cho biết kích thước khổ giấy đang 

sử dụng. Thanh thước ngang còn là nơi đặt Tab trong quá trình soạn thảo văn bản. Bật / Tắt thanh 

thƣớc: Chọn menu View  Ruler.  

 
f. Thanh cuộn: (Scroll) Gồm có thanh cuộn ngang và thanh cuộn dọc dùng để cuộn xem văn 

bản.  

 
 Các thanh công cụ trên có thể di chuyển bằng cách rà chuột đến góc trái để xuất hiện mũi tên  

nhấn giữ phím trái và rê chuột để di chuyển.  

 Bật / Tắt thanh công cụ: Chọn menu View  Toolbar  chọn / bỏ chọn tên thanh công cụ 

tương ứng.  

II. Những kỹ năng cơ bản: 

1. Các chế độ hiển thị văn bản: 

Một văn bản có thể được hiển thị nhiều cách khác nhau thông qua các lệnh trong trình đơn 

View hoặc các nút lệnh trên thanh cuộn ngang  

- Normal: Cửa sổ hiển thị có 1 thanh thước đo ngang, chế độ này sẽ hiển thị 

văn bản với kiểu định dạng ký tự, định dạng paragraph, không hiển thị văn 

bản dạng cột.  

- Web Layout: Cửa sổ chỉ có một thanh thước ngang, thường chỉ áp dụng khi 
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văn bản ở dạng Web.  

- Print Layout: Cửa sổ có đủ 2 thanh thước, văn bản hiển thị như trang giấy in với đầy đủ 

cách trình bày, người sử dụng thường sử dụng chế độ này.  

- Reading Layout: Văn bản hiển thị dưới dạng trang sách có mục lục giúp người dùng có thể 

di chuyển nhanh đến 1 trang bất kỳ.  

- Outline: Cửa sổ không có thước đo, chế độ này chỉ thích hợp khi trình bày những văn bản dài 

có trật tự theo đề mục.  

2. Các thành phần cơ bản của một văn bản: 

- Ký tự (Character): Là giá trị trả về khi gõ một phím (trừ các phím chức năng) 

- Từ (Word): Một nhóm ký tự được phân cách bằng một khoảng trắng hoặc một khoảng Tab.  

- Đoạn (Paragraph): Một đoạn văn bản được kết thúc bằng phím Enter.  

3. Cách nhập văn bản Tiếng Việt:  

- Kiểu gõ VNI: Dùng dãy phím số phía trên để bỏ dấu 

1 2 3 4 5 6 7 8 9 

Sắc Huyền Hỏi Ngã Nặng â, ê, ô Ư, ơ ă đ 

- Kiểu gõ Telex:  

aw  ă 

aa  â 

ee  ê 

ow  ơ 

oo  ô 

dd  đ 

uw  ư 

s  Sắc 

f  Huyền 

r  Hỏi 

x  Ngã 

j  Nặng 

- Sử dụng phần mềm UniKey: Kích phải vào biểu tượng  ở góc phải phía dưới màn hình 

(Thanh TaskBar): 

 

 

 

 

 

 

4. Tạo mới một tệp tin văn bản: 

o  Cách 1: Chọn Menu Files  New 

o Cách 2: Chọn biểu tượng New Blank Document () trên thanh công cụ chuẩn (Standard) 

o Cách 3: Nhấn tổ hợp phím Ctrl + N 

5. Lƣu tệp tin văn bản:  

o Cách 1: Chọn Menu File  Save 

o Cách 2: Chọn biểu tượng Save () trên thanh công cụ chuẩn (Standard) 

o Cách 3: Nhấn tổ hợp phím Ctrl + S 

 Nếu muốn lưu tệp tin văn bản đã có với một tên mới hoặc một nơi mới: Chọn Menu File 

 Save as (F12) 

 Nếu muốn lưu tất cả các tệp tin đang mở, đè giữ phím Shift trong khi chọn Menu File  

Save All 
Trong lần lƣu đầu tiên hoặc khi chọn lệnh Save as (F12) xuất hiện hộp thoại: 

Lựa chọn các kiểu gõ 

Chọn các bảng mã ký tự 
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- Save in: Chọn ổ đĩa, thư mục làm nơi lưu trữ tệp tin. Nếu muốn tạo thêm thư mục mới trước 

khi lưu chọn nút Create New Folder.  

- File name: Tên tệp tin, nên đặt tên có tính gợi nhớ để tiện việc sử dụng về sau.  

- Save as type: Kiểu tệp tin, đối với tệp tin văn bản nên chọn kiểu: Word Document (*. DOC) 

 Lưu ý: Trong suốt quá trình soạn thảo văn bản, bạn nên thường xuyên lưu văn bản (Ctrl + S) để 

bảo toàn dữ liệu. Đối với những văn bản đã có, trước khi hiệu chỉnh nên tạo bản sao dự phòng 

(Save as hoặc nhấn phím F12) 

6. Mở tệp tin văn bản có sẵn:  

o Cách 1: Chọn Menu File  Open 

o Cách 2: Chọn biểu tượng Open () trên thanh công cụ chuẩn (Standard) 

o Cách 3: Nhấn tổ hợp phím Ctrl + O 

 
- Look in: Nơi tệp tin đã được lưu trữ.  

- File name: Tên tệp tin.  

- Files of type: Kiểu tệp tin.  

7. Chọn tệp tin để làm việc:  
Khi có nhiều tệp tin đang được mở ra, tại một thời điểm xác định chỉ có một cửa sổ chứa một 

văn bản hoạt động, người dùng chỉ có thể làm việc trên cửa sổ đó. Để chuyển đổi sang một cửa 

sổ văn bản khác: 

o Cách 1: Chọn Menu Window  Chọn tên tệp tin đang mở.  

Nơi lưu 
Tạo 1 thư mục mới 

(Create New Folder) 

Tên 

tệp 

tin 

Kiểu 

tệp tin 

Kích đôi vào tên tệp tin 

cần mở hoặc kích chọn 

nút OPEN 
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o Cách 2: Kích chọn trực tiếp đối tượng cần chuyển đến trên thanh Taskbar.  

o Cách 3: Nhấn tổ hợp phím Alt + Tab 

8. Thay đổi đơn vị đo trên thƣớc:  

Chọn Menu Tools  Options…  General  Measurement units 

 
9. Đóng tệp tin văn bản đang mở: 

o Cách 1: Chọn Menu File  Close 

o Cách 2: Kích chọn nút Close Window () trên thanh Menu 

 

 Lƣu ý: 

  - Để đóng tất ca các tệp tin đang mở, đè giữ phím Shift trong khi chọn Menu File  Close 

All.  

 - Trước khi đóng tệp tin đã có sửa đổi chương trình sẽ hỏi bạn có muốn lưu lại hay không: 

  
+ Yes: Lưu tệp tin với sự thay đổi mới.  

+ No: Không lưu.  

+ Cancel: Bỏ qua và tiếp tục làm việc với tạp tin văn bản 

10. Đóng chƣơng trình: 

o Cách 1: Chọn Menu File  Exit 

o Cách 2: Kích chọn nút Close () trên thanh Tiêu đề.  

o Cách 3: Nhấn tổ hợp phím: Alt + F4 
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Bài 2.  ĐỊNH DẠNG VĂN BẢN 
I. Các thao tác trên khối: 

1. Chọn khối: 

 Cách 1: Giữ phím Shift và ấn các phím mũi tên   (có thể kết hợp thêm phím Ctrl để 

việc chọn nhanh hơn) 

 Cách 2: Giữ nút trái chuột và kéo rê từ đầu khối đến cuối khối.  

 Chọn nhanh một số đối tƣợng: 
 + Chọn nhanh một từ (Word): Kích đôi vào từ cần chọn.  

 + Chọn nhanh một đoạn (Paragraph): Giữ phím Ctrl + kích chuột trái vào đoạn cần chọn.  

 + Ctrl + Shift + End: Chọn nhanh từ vị trí con trỏ đến cuối văn bản.  

+ Ctrl + Shift + Home: Chọn nhanh từ vị trí con trỏ đến đầu văn bản.  

 + Shift + End: Chọn nhanh từ vị trí con trỏ đến cuối dòng văn bản.  

+ Shift + Home: Chọn nhanh từ vị trí con trỏ đến đầu dòng văn bản.  

 Ctrl + Shift + Alt + Kéo rê chuột trái: Chọn khối văn bản chữ nhật.  

2. Sao chép (Copy) khối văn bản: 

 Chọn khối văn bản muốn sao chép.  

 Chọn lệnh Copy bằng một trong các cách sau: 

o Cách 1: Chọn menu Edit  Copy 

o Cách 2: Nhấn tổ hợp phím Ctrl + C 

o Cách 3: Nhấp chọn nút lệnh Copy  trên thanh công cụ chuẩn (Standard).  

 Di chuyển dấu nháy đến vị trí mới 

 Chọn lệnh Paste bằng một trong các cách sau: 

o Cách 1: Chọn menu Edit  Paste 

o Cách 2: Nhấn tổ hợp phím Ctrl + V 

o Cách 3: Nhấp chọn nút lệnh Paste  trên thanh công cụ chuẩn (Standard).  

3. Di chuyển (Move) khối văn bản: 

 Chọn khối văn bản muốn di chuyển.  

 Chọn lệnh Cut bằng một trong các cách sau: 

o Cách 1: Chọn menu Edit  Cut 

o Cách 2: Nhấn tổ hợp phím Ctrl + X 

o Cách 3: Nhấp chọn nút lệnh Cut  trên thanh công cụ chuẩn (Standard).  

 Di chuyển dấu nháy đến vị trí mới 

 Chọn lệnh Paste bằng một trong các cách sau: 

o Cách 1: Chọn menu Edit  Paste 

o Cách 2: Nhấn tổ hợp phím Ctrl + V 

o Cách 3: Nhấp chọn nút lệnh Paste  trên thanh công cụ chuẩn (Standard).  

4. Xoá (Delete) khối văn bản: 

 Chọn khối văn bản muốn xoá.  

 Nhấn phím Delete trên bàn phím.  

II.> Định dạng khối văn bản: 

1. Sử dụng hộp thoại Font: 

 Chọn khối văn bản muốn thay đổi.  

 Chọn menu Format  Font… (Ctrl + D) 

 Thẻ Font: 
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- Font: Lựa chọn font chữ cho đoạn văn bản.  

- Font Style: Thay đổi kiểu chữ:  

 Regular: Bình thường 

 Bold: Kiểu chữ đậm 

 Italic: Kiểu chữ nghiêng.  

 Bold Italic: Kiểu chữ vừa đậm vừa nghiêng.  

- Size: Thay đổi kích cỡ chữ.  

- Font Color: Thay đổi màu chữ.  

- UnderLine Style: Chọn kiểu đường gạch dưới 

- Underline color: Chọn màu cho đường gạch dưới.  

- Effect: Các thuộc tính: 

 
 Strikethrough: Gạch giữa bằng đường đơn.  

 Double strikethrough: Gạch giữa bằng đường đôi.  

 Superscript: Chỉ số trên (x
2
,…) 

 Subscript: Chỉ số dưới (H2O,…) 

 Shadow: Chữ có bóng đổ.  

 Outline: Chữ viền ngoài.  

 Emboss: Chữ nổi trắng bóng xám.  

 Engrave: Chữ nổi xám bóng trắng.  

 Small caps: Tất cả thành chữ in hoa nhỏ.  

 All caps: Tất cả thành chữ in hoa.  
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 Hidden: Ẩn 

- Nút Default… áp dụng các thiết lập hiện tại thành mặc nhiên để sử dụng cho các văn bản 

sau này.  

 Thẻ Character Spacing: 

 
- Scale: Thay đổi văn bản theo tỷ lệ nhất định.  

- Spacing: Thay đổi khoảng cách giữa các từ theo chiều ngang: 

 
 Normal: Bình thường 

 Expanded: Trải rộng.  

 Condensed: Thu hẹp.  

- Position: Thay đổi khoảng cách giữa các từ theo chiều dọc: 

 
 Normal: Bình thường 

 Raised: Nâng cao chữ.  

 Lowered: Hạ thấp chữ.  

 

 Thẻ Text Effects: Thiết lập các thuộc tính trang trí không in được cho văn bản.  

 
 

 

2. Sử dụng thanh định dạng (Formating): 

 

 

 
 

Chọn font Cỡ chữ Canh lề 

Tô màu nền 

Tô màu chữ 
B: Chữ đậm 

I: Chữ nghiêng 

U: Chữ gạch chân 
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III.  Định dạng đoạn (Paragraph) văn bản:  
Đoạn văn bản là phần giới hạn bởi 2 lần gõ phím Enter. Muốn định dạng đoạn nào đưa dấu 

nháy đến đoạn đó, việc định dạng sẽ có tác dụng trên toàn bộ đoạn.  

 Nếu muốn ngắt dòng mà không sang đoạn văn bản mới nhấn tổ hợp phím Alt + Enter.  

1. Sử dụng hộp thoại Paragraph: 

 Chọn đoạn văn bản muốn thay đổi.  

 Chọn menu Format  Paragraph… 

 Thẻ Indents and Spacing:  

 
- Alignment: Canh lề cho đoạn văn bản: Left: Canh trái; Centered: 

Canh giữa; Right: Canh phải; Justified: Canh đều 2 bên.  

- Indentation: Xác định khoảng dịch vào phía trái, phải của đoạn văn 

bản.  

 First line: Chỉ dòng đầu tiên dịch trái theo 

khoảng cách trong hộp By.  

 Hanging: Chỉ phần văn bản từ dòng thứ 2 của 

đoạn văn bản thụt vào so với dòng đầu tiên 1 

khoảng By.  

- Spacing:  
 Before: Khoảng cách giữa đoạn hiện tại so với đoạn trước 

nó.  

 After: Khoảng cách giữa đoạn hiện tại so với đoạn sau nó.  

 Line spacing: Khoảng cách giữa các dòng trong một đoạn: 

2. Sử dụng thanh định dạng (Formating): 

 
 

 

3. Sử dụng thƣớc ngang: 

Alignment Line spacing 
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 Có thể thay đổi nhanh các khoảng dịch trái, dịch phải bằng cách điều chỉnh các nút trượt trên 

thước ngang 

Thụt đầu dòng dòng đầu tiên (First line Indent) 

Thụt đầu dòng từ dòng thứ 2 (Hangging Indent) 

Khoảng dịch vào phía trái (Left Indent) 

Khoảng dịch vào phía phải (Right Indent) 

IV. Sao chép định dạng :  
Trong quá trình soạn thảo văn bản có những thành phần (Khối hoặc đoạn…) trong văn bản có 

định dạng giống nhau, ta chỉ cần định dạng cho một đối tượng sau đó thực hiện việc sao chép định 

dạng nhờ vào công cụ Format Painter (Cọ định dạng)  trên thanh công cụ chuẩn (standard). 

Cách làm như sau: 

- Đặt con trỏ vào đối tượng mẫu.  

- Kích đôi chuột vào nút  trên thanh công cụ chuẩn.  

- Kích trái chuột đến lần lượt các đối tượng muốn sao chép.  

- Nhấn phím Esc để kết thúc quá trình sao chép.  

 

 

Bài 3.   TABS – BULLETS & NUMBERING - SYMBOL 
I. Định dạng Tabs: 

Trên bàn phím có phím Tab, phím này có tác dụng tạo ra một khoảng trống có độ dài được định 

trước hay tùy người sử dụng định nghĩa. Có các loại Tab:  căn trái;  căn giữa;  căn phải;  lấy 

chuẩn là dấu thập phân.  

1. Cách đặt Tab trên thƣớc: 

Bấm chọn biểu tượng Tab ở góc trên trái của thanh thước để có được Tab căn trái, giữa, phải, 

thập phân,… theo ý muốn sau đó kích chuột trái trực tiếp vào vị trí cần đặt Tab trên thước.  

 
Để gỡ bỏ Tab trên thước, chỉ cần nhấn và giữ nguyên chuột trái trên dấu Tab muốn bỏ kéo ra 

khỏi thanh thước.  

2. Đặt ký tự dẫn trƣớc Tab:  

Chọn menu Format  Tabs… 

- Tab stop position: Chọn các vị trí đã đặt 

Tab.  

- Alignment: Loại Tab căn trái, phải, giữa, 

thập phân,… 

- Leader: Chọn loại ký tự dẫn trước Tab 

- Nút Set: Gán những thiết lập cho Tab 

- Nút OK: Chấp nhận những thiết lập và đóng 

hộp thoại.  

- Nút Clear, Clear All: Xoá vị trí đặt Tab 

hiện tại hay xoá hết tất cả các vị trí đặt Tab.  

- Nút Cancel: Huỷ bỏ.  

II. Bullets and Numbering: 

Bullets, Numbering là các biểu tượng hoặc số dẫn 

đầu một đoạn văn bản. Mỗi khi xuống hàng sang một 

đoạn mới thì các Bullets và Numbering sẽ tự động 

điền vào cho đoạn.  

 Sử dụng nút lệnh Numbering hay Bullet Trên thanh công cụ:  

 Chọn menu Format  Bullets and Numbering … 
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 Thẻ Bulleted:  

 
Gồm có 7 ô mang các ký tự dẫn trước đã được sử dụng gần nhất và 1 ô có giá trị None, nếu ô 

này được chọn thì không có ký tự nào dẫn trước cho đoạn.  

Để thay đổi hay lựa chọn các ký tự khác kích chọn nút Customize… 

Font…: Chọn Font và các xác lập kiểu dáng khác.  

- Character…: Lựa chọn các ký tự đặc biệt.  

- Picture…: Lựa chọn 1 hình ảnh làm ký tự dẫn trước.  

- Bullet position: Khoảng cách từ lề trái đến ký tự dẫn trước.  

- Text position: Khoảng cách từ lề trái đến dòng văn bản.  

 Tab space after: Khoảng cách của dòng đầu tiên.  

 Indent at: Khoảng cách của các dòng còn lại.  

 Thẻ Numbered:  

 
Gồm có 7 ô mang các số chỉ mục đã được sử dụng gần nhất và 1 ô có giá trị None, nếu ô này 

được chọn thì không có số chỉ mục nào dẫn trước cho đoạn.  

- Restart numbering: Bắt đầu từ số chỉ mục đầu tiên.  

- Continue previous list: Tiếp theo với số chỉ mục phía 

trước. Để thay đổi hay lựa chọn các số chỉ mục khác kích chọn 

nút Customize… 

- Number Style: Kiểu số chỉ mục (I, II,…; 1,2,…; a,b,…) 

- Number position: Vị trí và phương thức đặt số chỉ mục.  

- Text position: Vị trí của dòng văn bản so với lề trái.  

III. Chèn ký tự đặt biệt (Symbol): 
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Ký tự đặc biệt là những ký tự chúng ta không thể nhập trực tiếp từ bàn phím. Để chèn những ký tự 

đặc biệt vào văn bản thực hiện theo các bước sau: 

 Chọn vị trí muốn chèn.  

 Chọn menu Insert  Symbol… 

 Chọn bộ font của các ký tự đặc biệt. Thường 

dùng các font: Symbol, Wingding, Wingding2, 

Wingding3, Webding,… 

 Chọn menu Insert để chèn và nút Close để 

đóng hộp thoại.  

 

 

 

 

 

Bài 4:  CÁC ĐỊNH DẠNG KHÁC 
Định dạng chữ rơi (Drop Cap): Chữ đầu tiên của một đoạn 

được in cỡ lớn và được bố trí sao cho đỉnh của ký tự ngang bằng 

với đỉnh của dòng thứ nhất và phần còn lại thì thút xuống phía dưới. 

Thực hiện theo trình tự sau: 

 Chọn ký tự đầu của đoạn văn bản cần định dạng Drop Cap.  

 Chọn menu Format  Drop Cap… 

Position: Vị trí của Drop Cap 

1. None: Không định dạng Drop Cap 

2. Dropped: Drop Cap chiếm một vị trí hình vuông ở đầu 

đoạn. 

3. In Margin: Drop Cap nằm ở ngoài đường biên văn bản. 

Options: Các tùy chọn.  

- Font: Thay đổi font cho Drop Cap.  

- Lines to drop: Độ lớn của Drop Cap.  

- Distance from text: Khoảng cách từ Drop Cap đến văn bản.  

 Kích chọn OK.  

I. Định dạng cột cho văn bản (Columns): Các bước thực hiện:  

 Chọn đoạn văn bản cần chia cột. (Đoạn văn bản cần chia phải được kết thúc đoạn bằng phím 

Enter) 

 Chia cột văn bảng theo một trong những cách sau:  

o Cách 1: Sử dụng nút lệnh Columns… trên thanh công cụ 

chuẩn (Standard), rê chuột quét chọn số cột muốn chia.  

 Với cách này các cột được chia sẽ có độ rộng bằng nhau.  

o Cách 2: Sử dụng Menu lệnh Format  Columns… 
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Presets: Lựa chọn cách chia cột theo các thiết lập định sẵn.  

Number of columns: Số cột muốn chia.  

Width and spacing: Độ rộng và khoảng cách của các cột.  

Col #: Số thứ tự cột.  

Width: Độ rộng cột.  

Spacing: Khoảng cách giữa cột hiện tại và cột kế tiếp.  

Equal column width: Nếu chọn chức năng này các cột sẽ có độ rộng bằng nhau.  

Apply to: Lựa chọn đối tượng để áp dụng các thiết lập: 

Selected text: Áp dụng cho văn bản được chọn.  

Whole Document: Áp dụng cho toàn bộ tài liệu.  

Line between: Nếu chọn chức năng này giữa các cột sẽ có dòng kẻ phân cách.  

 Kích chọn nút OK.  

 Đối với các đoạn văn bản vừa định dạng Drop Cap 

và chia cột, phải tiến hành chia cột trước và tạo Drop 

Cap sau.  

 Việc chọn đoạn văn bản để chia cột nên chọn vừa đủ 

hết đoạn, tức vùng chọn chỉ đến hết dòng cuối cùng của 

đoạn, không chọn xuống dòng trống bên dưới.  

 Muốn đưa văn bản từ cột bên trái sang bắt đầu cột 

phải liên kế thực hiện như sau: 

 Kích chọn vị trí văn bản cần di chuyển sang cột 

kế.  

 Chọn Menu Insert  Break  Column break 

 OK 

 

Bài 5.  XỬ LÝ BẢNG BIỂU 
 Bảng biểu (Table) có cấu trúc gồm nhiều dòng (Row) và nhiều cột (Column). Giao của một 

dòng và một cột gọi là ô (Cell).  

I. Tạo bảng:  

1. Sử dụng Menu lệnh: 

Chọn Menu Table  Insert  Table… 

Table size: Kích cỡ của bảng 

                     + Number of columns: Số cột trong bảng.  
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                     + Number of rows: Số dòng trong bảng.  

AutoFit behaviour: Tự động thay đổi kích thước ô một cách tốt nhất.  

Remember dimentions for new tables: Ghi nhớ lại kích cỡ bảng hiện tại để sử dụng cho 

các bảng tạo mới sau này.  

2. Sử dụng thanh công cụ chuẩn: 

 Kích chọn nút lệnh Insert table trên thanh công cụ chuẩn (Standard), rê chuột 

quét chọn số dòng, cột của bảng muốn tạo.  

II. Các thao tác trên bảng:  

1. Nhập liệu trong bảng: 

a. Di chuyển con trỏ:  

 Cách 1: Kích chuột trực tiếp vào ô muốn đến.  

 Cách 2: Khi con trỏ đang ở trong bảng dùng các phím mũi tên hoặc phím Tab để di chuyển 

sang các ô liên kế.  

b. Đặt Tab trong ô: 

 Di chuyển con trỏ đến ô muốn đặt Tab.  

 Lựa chọn loại Tab và đặt Tab trên thanh thước ngang.  

 Di chuyển con trỏ đến các vị trí đặt Tab trong ô bằng tổ hợp phím Ctrl + Tab.  

2. Chọn (Select) ô, dòng, cột,… trong bảng: 

Chọn 1 ô: Kích chuột vào phía trái ô khi con trỏ có dạng . Hoặc chọn menu Table  

Select  Cell 
Chọn nhiều ô: Thực hiện như trên sau đó kéo rê chuột để chọn nhiều ô.  

Chọn 1 dòng: Chọn menu Table  Select  Row.  

Chọn 1 cột: Kích chuột trái vào đỉnh cột khi con trỏ có dạng . Hoặc chọn menu Table 

 Select  Column.  

Chọn cả bảng: Chọn menu Table  Select  Table.  

3. Chèn (Insert) thêm ô, dòng, cột,… trong bảng: 

 Xác định vị trí cần chèn thêm.  

 Chọn menu Table  Insert … 

- Columns to the left: Thêm 1 cột phía trái.  

- Columns to the Right: Thêm 1 cột phía phải.  

- Rows Above: Thêm dòng phía trên.  

- Rows Below: Thêm dòng phía dưới.  

- Cell: Thêm 1 ô 

4. Xoá (Delete) ô, dòng, cột,… trong bảng: 

 Xác định vị trí cần xoá.  

 Chọn menu Table  Delete … 

Table: Xóa bảng.  

Columns: Xóa cột.  

Rows: Xoá dòng.  

Cells: Xóa ô.  

5. Trộn ô (Merge cell): Ghép các ô lại với nhau.  

 Chọn các ô muốn trộn.  

 Chọn menu Table  Merge cells 

6. Chẻ ô (Split cell): Chia 1 ô thành nhiều ô theo dòng, cột.  

 Chọn ô muốn chia.  

 Chọn menu Table  Split cells… 

Number of columns: Số cột muốn chia.  

Number of rows: Số dòng muốn chia.  
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Merge cells before split: Trộn các ô trước khi chia.  

 

7. Hiệu chỉnh độ rộng của dòng, cột: 

o Cách 1: Rà chuột trên đường lưới bên phải của cột, đường lưới phía dưới của dòng khi xuất 

hiện mũi tên 2 chiều   , đè chuột trái đồng thời rê chuột để thay đổi độ rộng của cột, dòng. 

(Có thể kích đôi chuột trái để hiệu chỉnh tự động).  

o Cách 2: Sử dụng các chức năng thay đổi tự động: Chọn menu Table  AutoFit 

o Cách 3: Chọn menu Table  Table Properties: 

Chọn thẻ Table: Hiệu chỉnh cho bảng.  

Chọn thẻ Row: Hiệu chỉnh cho dòng.  

Chọn thẻ Column: Hiệu chỉnh cho cột.  

Chọn thẻ Cell: Hiệu chỉnh cho ô.  

 Trong thẻ Row khi hiệu chỉnh dùng nút Previous Row hoặc Next 

Row để di chuyển đến dòng trên hoặc dòng dưới và hiệu chỉnh kích 

thước trong ô Specify height.  

 Trong thẻ Column khi hiệu chỉnh dùng nút Previous Column 

hoặc Next Column để di chuyển đến cột trước hoặc cột sau và hiệu 

chỉnh kích thước trong ô Preferred width.  

8. Định dạng đặc biệt trong bảng: 

a. Chọn hƣớng cho văn bản: 

 Chọn các ô muốn định dạng.  

 Thay đổi hướng chữ bằng các cách sau: 

o Cách 1: Kích chuột phải chọn mục Text Direction 

o Cách 2: Chọn menu Format  Text Direction 

 Chọn hướng chữ trong mục Orentation 

 Chọn nút OK 

b. Canh chỉnh văn bản trong ô: 

 Chọn các ô muốn định dạng.  

 Kích chuột phải chọn mục Cell Alignment 

 Chọn loại canh chỉnh thích hợp 

9. Sắp xếp dữ liệu trong bảng: 

 Chọn vùng văn bản cần sắp xếp.  

 Chọn Menu Table  Sort… 

 Chọn phương thức sắp xếp: 

o Sort by: Chọn cột sắp xếp chính, theo kiểu (Type). 

Phương thức sắp xếp Ascending: tăng dần; 

Decending: giảm dần.  

o Then by: Chọn cột sắp xếp phụ.  

 Chọn nút OK 

10. Lặp lại các tiêu đề khi sang trang: 

 Chọn dòng làm tiêu đề cột 

 Chọn Menu Table  Heading Rows Repeat… 

11. Kẻ khung và tô màu : 

 Chọn vùng.  

 Chọn Menu Format  Borders and Shading 

 Chọn thẻ Borders để kẻ khung.  

Setting: Các loại khung.  

Style: Các kiểu đường kẻ.  
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Color: Màu đường kẻ.  

Width: Độ rộng đường kẻ.  

Apply to: Xác lập vùng áp dụng cho các thiết lập hiện tại 

Preview: Xem trước các xác lập. Để bỏ / thêm bất kỳ đường kẻ nào trong khung kích 

chuột trái trực tiếp vào đường đó trong hộp này.  

Options…: Thay đổi khoảng cách tữ đường kẻ đến văn bản trong khung.  

Showtoolbar: Bật thanh công cụ Tables and Borders.  

 Chọn thẻ Shading để tô màu nền: 

o Fill: Chọn màu tô.  

o Pattern: Kiểu dáng nền.  

o More color…: Chọn thêm những màu khác ngoài 

bảng hiện tại.  

o Apply to: Xác lập vùng ảnh hưởng của các thiết lập.  

 Ngoài ra chúng ta có thể dùng thanh công cụ Tables and Borders để kẻ khung và tô 

màu cho bảng một cách nhanh chóng và đơn giản.  

 

 

 
 

Bài 6.  TRANG TRÍ VĂN BẢN 
I. Sử dụng thanh công cụ Drawing:  

Thanh Drawing khi được bật thường nằm ở phía dưới cuối màn hình có dạng như sau: 

 
 Bật / Tắt thanh Drawing theo các cách sau: 

o Cách 1: Kích chuột phải vào bất kỳ thanh công cụ nào chọn mục 

Drawing.  

o Cách 2: Chọn menu View  Toolbar  Drawing 

o Cách 3: Kích chọn nút lệnh  trên thanh công cụ chuẩn 

(Standard)  

II. Chèn hình ảnh (Picture):  

1. Chèn từ Clip Art: 

 Chọn vị trí cần chèn. 

 Mở hộp thoại Insert Clip Art theo các cách sau: 

o Cách 1: Chọn Menu Insert  Picture  Clip Art… 

o Cách 2: Kích chọn nút lệnh  trên thanh Drawing.  

Search for: Đối tượng muốn tìm.  

Search in: Nơi tìm.  

Everywhere: Tất cả trong máy tính.  

My Collections: Trong những bộ sưu tập cá nhân.  

Office Collections: Trong những bộ sưu tập của office. (thường chọn 

chức năng này) 

Web Collections: Trong những bộ sưu tập trên 

Web.  

Results should be: Kết quả trả về. Thường chọn All media file types.  

Nút lệnh Go: Bắt đầu tìm kiếm.  

 Kích chọn trực tiếp lên đối tượng muốn chèn vào văn bản.  

2. Chèn từ tệp tin hình ảnh: 
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 Chọn vị trí cần chèn.  

 Mở hộp thoại Insert Picture theo các cách sau: 

o Cách 1: Chọn Menu Insert  Picture  

From file… 

o Cách 2: Kích chọn nút lệnh  trên 

thanh Drawing 

 Chọn nơi chứa tệp tin hình ảnh trong mục 

Look in 

 Chọn hình muốn chèn và nút Insert.  

3. Hiệu chỉnh hình ảnh đã chèn: 

a. Thay đổi kích thƣớc: 

 Chọn hình để xuất hiện 8 nút vuông đen  

quanh đường viền hình.  

 Rà chuột chỉ vào các nút  đến khi xuất hiện mũi 

tên 2 chiều, nhấn giữ và kéo chuột để thay đổi kích 

thước của hình.  

b. Sử dụng thanh Picture Toolbar để xác lập các thay đổi 

khác: 

Chọn hình để xuất hiện thanh công cụ. Nếu không xuất hiện thanh công cụ thì kích chuột phải 

vào hình chọn chức năng Show Picture Toolbar. Các nút lệnh trên thanh công cụ gồm: 

 
                                               
: Insert Picture: Chèn hình 

: Color: Thay đổi màu sắc cho hình: Automatic: tự động; Grayscale: Màu 

xám; Black & White: Đen trắng; Washout: Hình mờ (thường dùng làm nền).  

 Contrast: Bộ công cụ điều chỉnh độ tương phản.  

 Brightness: Bộ công cụ điều chỉnh độ sáng.  

 Crop: Cắt xén hình ảnh.  

 Rotate: Xoay hình 1 góa 90 độ.  

 Line style: Lựa chọn các loại đường viền quanh hình.  

 Compress picture: Cắt bỏ phần thừa xung quanh hình sau khi thực hiện chức năng Crop.  

 Text Wrapping: Thiết lập cách bố trí văn bản xung quanh hình. Thường dùng chức 

năng này để có thể di chuyển hình ảnh đến mọi nơi trong văn bản. Gồm có các lựa chọn: 

o Square: Chữ bao quanh hình theo khuôn hình chữ nhật.  

o Tight: Chữ bao quanh hình theo mép viền của hình.  

o Behind text: Hình nằm sau văn bản.  

o In front of text: Hình nằm trên văn bản.  

o In line with text: Hình được xem như một ký tự và nằm trên dòng với văn bản.  

 Format Picture: Mở hộp thoại Format picture. Có thể kích đôi ngay vào hình để mở 

hộp thoại này.  

III. Chèn chữ nghệ thuật (WordArt):  

1. Chèn WordArt: 

 Chọn vị trí cần chèn.  

 Mở hộp thoại WordArt Gallery theo các cách sau: 

o Cách 1: Chọn Menu Insert  Picture  WordArt… 

o Cách 2: Kích chọn nút lệnh  trên thanh 

Drawing 
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 Chọn loại chữ nghệ thuật trong thư viện. Xuất hiện hộp thoại Edit WordArt Text.  

 Nhập nội dung trong hộp Text.  

 Kích chọn nút OK 

2. Hiệu chỉnh WordArt bằng thanh công cụ: 

 
                                                            

 

: Insert WordArt: Chèn chữ nghệ thuật.  

: Edit text…: Soạn văn bản.  

 WordArt Gallery: Mở thư viện chữ nghệ thuật.  

 Format WordArt: Định dạng; Gồm các thiết lập về màu sắc (Fill Color), đường nét 

(Line), Độ trong suốt (Transparency), kích cỡ (Size), thiết lập cách bố trí văn bản xuang quanh 

(Layout),… 

 WordArt Shape: Các lựa chọn về hình dạng WordArt.  

 Text Wrapping: Thiết lập cách bố trí văn bản xung quanh WordArt.  

 WordArt Same letter heights: Kéo giãn tất cả các ký tự để có được độ cao bằng nhau.  

 WordArt Vertical text: Chuyển WordArt sang chiều đứng.  

 WordArt Alignment: Canh lề WordArt.  

 WordArt Character Spacing: Thiết lập khoảng cách giữa các ký tự.  

IV. Hình vẽ (AutoShapes):  

1. Vẽ một đối tƣợng: 

 Chọn một lệnh vẽ trong bộ công cụ AutoShapes theo các cách sau: 

o Cách 1: Chọn Menu Insert  Picture  AutoShapes 

o Cách 2: Kích chọn nút lệnh  trên thanh Drawing 

       
 Giữ nút trái và kéo chuột lên nền để vẽ. Để hình vẽ là một đối tượng độc lập , khi kéo chuột 

để vẽ nên kéo ngoài khung có thông báo: Create your drawing here.  

 Để vẽ được đường tròn, tam giác cân, hình vuông, đường vuông góc,… phải nhấn đè phím 

Shift trong khi kéo chuột để vẽ.  

2. Tô màu nền cho đối tƣợng: 

 Chọn đối tượng.  

 Chọn nút lệnh  trên thanh Drawing và chon màu tô thích hợp.  

3. Định màu đƣờng viền cho đối tƣợng: 

 Chọn đối tượng.  

 Chọn nút lệnh  trên thanh Drawing và chọn màu thích hợp.  

4. Tạo bóng (Shadow) và hiệu ứng 3 chiều (3-D) cho đối 

tƣợng: 

 Chọn đối tượng.  

 Chọn nút lệnh  trên thanh Drawing và chọn mẫu hiệu 

ứng thích hợp.  

  Các nút Shadow Setting, 3-D Setting: Dùng để thay đổi các 

thiết lập mặc nhiên của đối tượng.  
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V. Biểu đồ (Chart), sơ đồ tổ chức (Organization chart):  
 Chọn vị trí cần chèn.  

 Chọn Menu Insert  Picture  Chart / 

Organization Chart) 

 Chọn loại biểu đồ hay sơ đồ cần thiết.  

 Để hiệu chỉnh hay thay đổi nội dung sử 

dụng thanh công cụ đính kèm khi kích 

chon biểu đồ hoặc sơ đồ.  

(Màn hình chọn lựa các loại biểu đồ và sơ 

đồ tổ chức) 

 

 
 

 

Bài 7.  CÁC CÔNG CỤ TRỢ GIÚP SOẠN THẢO 
I. Tìm kiếm (Find) và thay thế (Replace):  

1. Tìm kiếm (Find): 

 Chọn menu Edit  Find (Ctrl + F) 

 
 Nhập nội dung cần tìm vào ô Find What.  

 Chọn nút Find Next để bắt đầu tìm kiếm. Nút Cancle để kết thúc việc tìm kiếm.  

 Khi tìm thấy nội dung sẽ đánh dấu tại vị trí tìm được. Nếu muốn tìm tiếp bấm Find Next.  

 Để đánh dấu (Highlight) những nội dung tìm thấy chọn chức năng Highlight all items 

found in.  
 Để tìm chính xác hơn, cần cung cấp thêm những thông tin liên quan trong chức năng More 

2. Thay thế (Replace): 

 Chọn menu Edit  Replace (Ctrl + H) 

 
 Nhập nội dung cần tìm vào ô Find What.  

 Nhập nội dung muốn thay thế vào ô Replace with  

 Chọn nút Find Next để bắt đầu tìm kiếm. Khi tìm thấy chọn nút Replace để thay thế, muốn 

bỏ qua chọn nút Find next. Nút Cancle để kết thúc việc tìm kiếm và thay thế.  

 Muốn Word tự động tìm và thay thế tất cả thì chọn nút Replace all.  
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 Để tìm và thay thế một cách chính xác hơn, cần cung cấp thêm những thông tin liên quan 

trong chức năng More 

II. Tự động sửa sai (AutoCorrect): 
Microsoft Word trang bị chức năng này nhằm sửa những thao tác nhầm của người sử dụng trong 

quá trình nhập liệu. Để xác lập các tham số cho việc sửa sai thực hiện theo các bước sau: 

 Chọn menu Tools  AutoCorrect options…  

 
 Chọn / bỏ chọn các lựa chọn phục vụ cho việc sửa sai: 

Correct TWo INtial CApitals: Nếu gõ 2 ký tự In ở đầu một từ, Word sẽ tự động đổi ký 

tự thứ 2 thành ký tự thường (VD: WOrd  Word) 

Capitallize first letter of sentences: Tự động viết in ký tự đầu mỗi câu.  

Capitallize first letter of table cell: Tự động viết in ký tự đầu trong ô của bảng.  

Capitallize name of days: Tự động viết in ký tự đầu của tên các ngày trong tuần (Tiếng 

Anh) 

Correct accidental usage of cAPS LOCK key: Khi đang bật Caps Lock và gõ nhầm, 

chẳng hạn như wORD thì sẽ tự động chỉnh lại thành Word và tắt phím Caps Lock.  

Replace text as you type: Thay thế văn bản theo định nghĩa của người sử dụng.  

 Trong ô Replace: Nhập ký tự đại diện (Dùng gõ tắt) Ví dụ: DN 

 Trong ô With: Nhập nội dung văn bản sẽ thay thế. Ví dụ: Đồng Nai.  

 Nút lệnh Add dùng để thêm đối tượng vừa tạo vào danh sách.  

 Nút Delete dùng để xoá đối tượng được chọn khỏi danh sách.  

 Chọn nút OK.  

III. Văn bản tự động (AutoText):  

1. Tạo văn bản tự động: 

 Chọn khối văn bản để làm văn bản tự động.  

 Chọn menu Insert  Auto Text  Auto Text.  

 Nhập tên đại diện cho văn bản trong hộp Create Auto Text. Chọn nút Add và nút OK.  

2. Chèn văn bản tự động: 

 Chọn nơi muốn chèn.  

 Nhập tên đại diện cho văn bản.  

 Nhấn phím F3 

IV. Soạn thảo công thức toán học:  
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 Chọn vị trí cần soạn thảo công thức.  

 Chọn menu Insert  Object  Microsoft Equation 3. 0, hoặc nút  trên 

thanh công cụ.  

 Chọn lựa các ký hiệu toán học thích hợp, di chuyển con trỏ đến vị trí và tiến hành nhập liệu.  

 
 Kích chuột ra phía ngoài nền hoặc nhấn phím Esc để kết thúc việc nhập liệu.  

 Để sửa chữa kích đôi trực tiếp vào công thức đã tạo.  

 

Bài 8.  IN ẤN VÀ CÁC THIẾT LẬP LIÊN QUAN 
I. Định dạng khổ giấy (Page Setup):  

Chọn menu File  Page Setup 

 Thẻ Margins: Xác định kích thước giới hạn các mép giấy.  

- Top: Mép giấy trên 

- Bottom: Mép giấy dưới.  

- Left: Mép giấy trái.  

- Right: Mép giấy phải.  

- Orientation: Chọn hướng giấy: Portrait – Thẳng đứng; 

Landscape: Nằm ngang 

 Thẻ Paper:  
Paper size: Khổ giấy 

Paper Source: Nguồn giấy 

II. Chèn tiêu đề đầu trang (Header) và cuối trang (Footer):  

Chọn menu View  Header and Footer 

Nhập nội dung cho tiêu đề, có thể kết hợp các công cụ có 

sẵn trên thanh công cụ Header and Footer: 

          Chèn ngày tháng  Chèn thời gian  Định dạng trang in 

 

 
 

  Số TT trang Tổng số trang Định dạng số trang  

III. Xem văn bản trƣớc khi in (Print Preview):  

Chọn menu File  Print Preview hoặc chọn nút lệnh  trên thanh công cụ 

chuẩn (Standard). Kích chuột trực tiếp lên trang in muốn xem. Chọn nút Close để kết thúc. Chọn 

nút Print để in văn bản.  



41 

 

 
 

IV. In văn bản (Print):  

Chọn menu File  Print (Ctrl + P) hoặc chọn nút lệnh  trên thanh công cụ 

chuẩn (Standard).  

Printer Name: Chọn máy in sẽ in.  

Page Range: Số trang sẽ in. All: Tất cả; 

Current page: In trang con trỏ đang đứng; 

Pages: In một số trang chỉ định (VD: In từ 

trang 1 đến trang 5 nhập như sau: 1-5; Nếu 

muốn in trang 1 và trang 3 thì nhập 1,3) 

Number of Copies: Số bản sao sẽ in.  

 

 

 

 

BÀI TẬP ÔN TẬP MICROSOFT WORD 

Câu 1: Để chèn một bảng biểu vào văn bản ta thực hiện lệnh 

A. Table\Insert B. Table\Insert\Table 

C. Format\Table D. Insert\Table 

Câu 2: Để chèn thêm dòng vào bên dưới dòng đã chọn trong bảng ta thực hiện: 

A. Table\Insert\Row Below B. Table\Insert\Row Above 

C. Table\Insert\Columns to the left D. Table\Insert\Columns to the right 

Câu 3: Để chèn một bức tranh vào văn bản ta thực hiện 

A. Insert\Page Numbers B. Insert\Pictures\Clip Art 

C. Insert\Objects D. Insert\Symbol 

Câu 4: Để tạo tiêu đề trên tiêu đề dưới ta thực hiện lệnh 

A. Chọn View\ToolsBar B. Chọn View\Header and Footer 

C. Chọn View\Zoom D. Chọn View\Thumbnails 

Câu 5: Để chia cột cho văn bản bạn thực hiện lệnh nào 

A. Format\Column B. Format\Drop Cap… 

C. Format\Borders and Shading D. Format\Bullets and Numbering 

Câu 6: Trong Word, để trình bày trang trước khi in ta thực hiện 

A. Chọn Format\Page Setup B. Chọn Edit\Page Setup 

C. Chọn File\Page Setup D. Chọn Table\Page Setup 

Câu 7: Để chèn thêm cột vào bên trái cột đã chọn trong bảng ta thực hiện: 

A. Table\Insert\Row Below B. Table\Insert\Columns to the right 

C. Table\Insert\Columns to the left  D. Table\Insert\Row Above 
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Câu 8: Trong Microsoft Word để tạo 1 tệp mới: 

A. Tất cả đều đúng B. Chọn biểu tượng  

C. Chọn File\New D. Nhấn tổ hợp phím Ctrl + N 

Câu 9: Để đánh số trang cho văn bản, từ menu Insert ta thực hiện chọn: 

A. Date and time B. Symbol C. Break D. Page Numbers 

Câu 10: Để bật thanh công thức toán học bạn dùng lệnh nào 

A. View\Toolsbar\Objects B. Insert\Objects 

C. Format\Objects D. Table\Objects 

Câu 11: Trong bảng biểu của Word khi bạn đã chọn 1 ô, bạn làm thế nào để tách ô đó ra thành 

nhiều ô? 

A. Chọn Table\Merge Cells B. Chọn Table\Table Properties 

C. Chọn Table\Formula D. Chọn Table\Split Cells 

Câu 12: Để chèn hộp nhập văn bản Texbox bạn dùng lệnh 

A. Format\Textbox B. Insert\Texbox C. Edit\Texbox D. Tất cả đều sai 

Câu 13: Để xóa cột trong bảng biểu bạn dùng lệnh nào 

A. Table\Delete\Rows B. Table\Delete\Columns 

C. Table\Split Cells D. Table\Insert\Column 

Câu 14: Khi tệp congvan123 đang mở, bạn muốn tạo tệp mới có tên là cv-123 có cùng nội dung với 

congvan123 thì bạn phải 

A. Chọn Edit\Save B. Chọn Edit\Save As 

C. Chọn File\Save As D. Chọn File\Save 

Câu 15: Trong Word, khi bạn đã chèn một bảng biểu, bạn muốn gộp nhiều ô đã bôi đen thành 1 ô 

bạn dùng lệnh nào 

A. Chọn Table\Formula B. Chọn Table\Split Cells 

C. Chọn Table\Table Properties D. Chọn Table\Merge Cells 

Câu 16: Bạn đã bôi đen một đoạn văn bản, bạn có thể dùng lệnh nào để sao chép đoạn văn bản đó. 

A. Chọn Format\Copy B. Chọn Edit\Copy 

C. Chọn File\Copy D. Chọn Insert\Copy 

Câu 17: Bạn đã bôi đen một đoạn văn bản, bạn có thể dùng tổ hợp phím nào để sao chép đoạn văn 

bản đó: 

A. Nhấn tổ hợp phím Ctrl + V B. Nhấn tổ hợp phím Ctrl + X 

C. Nhấn tổ hợp phím Ctrl + C D. Nhấn tổ hợp phím Ctrl + D 

Câu 18: Để chèn các ký tự đặc biệt vào văn bản ta thực hiện thao tác nào dưới đây: 

A. Chọn Insert\Picture\AutoShapes B. Chọn Insert\WordArt 

C. Chọn Insert\Symbol D. Chọn Format\Font 

Câu 19: Để tạo văn bản nghệ thuật bạn thực hiện lệnh 

A. Insert\Objects B. Insert\Symbol 

C. Insert\Picture\WordArt D. Insert\Picture\Clip Art 

Câu 20: Để định dạng văn bản theo kiểu danh sách bạn dùng: 

A. Format\Borders and Shading B. Format\Drop Cap… 

C. Format\Column D. Format\Bullets and Numbering 

Câu 21: Để tạo đường viền cho đoạn văn bản, trang văn bản bạn dùng: 

A. Format\Borders and Shading B. Format\Bullets and Numbering 

C. Format\Column D. Format\Drop Cap… 

Câu 22: Với công việc nào bạn cần phải mở thực đơn lệnh FORMAT 

A. Cài đặt máy in B. Đổi phông chữ cho văn bản 

C. Đánh số trang cho văn bản D. Lưu tệp văn bản 

Câu 23: Trong Word, để bật/tắt các thanh công cụ ta thực hiện lệnh: 

A. Chọn Insert\Toolsbar\Chọn thanh công cụ cần bật 
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B. Chọn Edit\Toolsbar\Chọn thanh công cụ cần bật 

C. Chọn View\Toolsbar\Chọn thanh công cụ cần bật 

Câu 24: Khi bạn soạn văn bản bằng kiểu chữ Time New Roman thì bạn phải dùng bảng mã nào: 

A. Unicode B. VNI C. TCVN3 

Câu 25: Trong Word, lưu tệp ta thực hiện 

A. Chọn biểu tượng  B. Chọn File\Save 

C. Nhấn tổ hợp phím Ctrl+S D. Tất cả đều đúng 

Câu 26: Để in văn bản ta có thể dùng tổ hợp phím nào 

A. Ctrl + Shift + P B. Ctrl + P C. Ctrl + Y D. Ctrl + A 

Câu 27: Trong Word, để mở một tệp đã có ta thực hiện lệnh 

A. Nhấn tổ hợp phím Ctrl+O B. Chọn biểu tượng  

C. Chọn File\Open D. Tất cả đều đúng 

Câu 28: Để tăng độ rộng của cột, độ cao của dòng ta dùng lệnh 

A. Table\Table Autoformat B. Table\Table Properties\ 

C. Table\Split Cells D. Table\Merge Cells 

Câu 29: Để tạo chữ cái lớn đầu dòng bạn dùng lệnh nào 

A. Format\Column B. Format\Bullets and Numbering 

C. Format\Drop Cap… D. Format\Borders and Shading 

Câu 30: Bạn muốn thay đổi phông chữ cho văn bản, bạn đã bôi đen văn bản đó rồi bạn thực hiện 

lệnh nào 

A. Chọn Format\Font B. Chọn Insert\Font 

C. Chọn Format\Borders And Shading D. Chọn Format\Column 

Câu 31: Để có thể đánh được chỉ số dưới, ví dụ H2O thành H2O, bạn cần: 

A. Bôi đen số 2, nhấn tổ hợp phím ( Ctrl_Shift_=) 

B. Bôi đen số 2, nhấn tổ hợp phím (Ctrl =) 

C. Bôi đen số 2, nhấn tổ hợp phím (Alt_Shift_=) 

D. Bôi đen số 2, nhấn tổ hợp phím (Ctrl_Alt_=) 

Câu 32: Khi chọn File\Save As ta thực hiện công việc nào dưới đây? 

A. Đóng một tệp văn bản B. Mở một file văn bản đã có 

C. Lưu tài liệu với một tên khác D. Mở một file văn bản mới 

Câu 33: Khi bạn soạn thảo văn bản bằng kiểu chữ Vntime thì bạn phải dùng bảng mã nào 

A. TCVN3 B. VNI C. Unicode 

Câu 34: Để di chuyển một tệp, bạn có thể thực hiện lệnh nào? 

A. Edit\Cut B. File\Cut C. File\Copy D. Edit\Copy 

Câu 35: Cho biết phát biểu nào sau đây là sai: 

A. Bấm tổ hợp phím Ctrl+E tương đương với nút  (Print) trên thanh Standard 

B. Bấm tổ hợp phím Ctrl+C tương đương với nút  (Copy) trên thanh Standard 

C. Bấm tổ hợp phím Ctrl+X tương đương với nút  (Cut) trên thanh Standard 

D. Bấm tổ hợp phím Ctrl+V tương đương với nút  (Paste) trên thanh Standard 

Câu 36: Để trộn văn bản ta phải thao tác trên tệp văn bản nào 

A. Tệp văn bản chính B. Tệp văn bản nguồn 

Câu 37: Để xem một văn bản trước khi in bạn chọn biểu tượng nút lệnh nào dưới đây? 

A.  B.  C.  D.  
Câu 38: Trong Word muốn gộp ô trong bảng, ta chọn menu Table sau đó chọn 

A. Split Cells B. Tất cả đều sai 

C. Cell Height and Width D. Merge Cells 

 Câu 39: Để tìm kiếm và thay thế trong văn bản ta thực hiện tổ hợp phím nào sau đây: 

 A. Ctr+E  B. Ctrl+B  C. Ctrl+H  D. Ctrl+N 
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Câu 40: Trong Word, bạn đang mở cùng một lúc nhiều tệp tin, bạn muốn chuyển từ tệp tin hiện 

hành sang tệp tin khác bạn phải làm gì? 

A. Chọn WindowChọn tệp tin cần mở          C. Nhấn tổ hợp phím Alt+Tab 

B. Kích chuột trực tiếp vào tệp cần chuyển trên thanh Tarkbar    D. Tất cả đều đúng 

 Câu 41. Bộ phần mềm Open Office là: 

 A. Để lập bản vẽ, có phí  B. Phần mềm văn phòng, có phí 

 C. Phần mềm văn phòng, miễn phí  D. Để lập bản vẽ, miễn phí 

 

 

PHẦN III. BẢNG TÍNH ĐIỆN TỬ MICROSOFT EXCEL 

 

BÀI 1. BẮT ĐẦU VỚI MICROSOFT OFFICE EXCEL 

 

Microsoft Office Excel là chương trình thuộc bộ phần mềm Microsoft Office được sử dụng 

trong hầu hết tất cả các văn phòng trên toàn thế giới. Excel là chương trình bảng tính có thể ứng 

dụng cho các công việc quản lý, kế toán, thống kê ...  

 1. Khởi động 

Cách 1: Nhấn nút Start, Chọn Programs, chọn Microsoft Office, chọn Microsoft Office 

Excel 2003. 

 
Hình 1. Khởi động chương trình Excel 

Cách 2: Nhấn chuột vào biểu tượng  Microsoft Office Excel 2003 trên màn 

hình nền.  

 2. Giới thiệu bảng tính Excel 

- Sau khi khởi động chương trình Excel, 

chúng ta có một sổ bảng tính (Workbook). 

Trong một sổ bảng tính có rất nhiều trang bảng 

tính.  

- Một bảng tính gồm có 256 cột được 

đánh chỉ số theo chữ cái A, B, C…Z, AA, AB, 

AC… và 65536 dòng được đánh chỉ số theo số 

thứ tự 1,2,3…65536 

- Theo mặc định, mỗi lần tạo bảng tính 

mới thì Excel tạo 3 trang bảng tính trắng đặt tên 
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Thanh thực đơn 

lệnh 

Thanh tiêu đề 

Thanh công cụ 

Thanh công 

thức 

Thanh trạng thái 

Thanh cuộn dọc 

Thanh cuộn 

ngang 

Đường viền dọc 

Đường viền ngang 

Trang tính Sheet1, … 

Nhập dữ liệu vào đây 

là Sheet1, Sheet2, Sheet3. Sau này chúng ta có thể chèn thêm các trang mới và chúng được đặt tên là 

Sheet4, Sheet5,… 

 
 

- Ô (Cell): Ô của trang tính là giao của một cột và một dòng. Ô trên trang bảng tính có địa 

chỉ viết theo trật tự xác định gồm chữ cái tên cột đứng trước và số thứ tự dòng đứng sau.  

 
 

VD: Địa chỉ ô 

đầu tiên là A1 và địa 

chỉ ô cuối cùng trên 

trang bảng tính là 

IV65536 

 - Cửa sổ bảng 

tính: Cửa sổ bảng tính 

Excel có các thành 

phần chính sau: 

 

 

  

 

 

 

 

 

 

+ Thanh tiêu đề: Cho biết tên chương trình ứng dụng, tên tệp tin. 

 + Thanh thực đơn lệnh: Cung cấp các nhóm lệnh làm việc với bảng tính. 

 + Thanh công cụ: Cung cấp các nút thao tác nhanh. 

 + Thanh công thức (Formula Bar): Gồm ô Name Box hiển thị tọa độ ô soạn thảo và nội dung 

dữ liệu của ô. 

 + Đường viền ngang: Ghi tên cột từ trái sang phải theo chữ cái A, B…Y, Z, AA, AB,…IV. 

Mỗi cột có chứa 65536 ô. 

 + Đường viền dọc: Ghi số thứ tự dòng từ 1 đến 65536. Mỗi dòng chứa 256 ô. 

 + Thanh trượt ngang, dọc: Cho phép hiển thị những ô bị che khuất. 

 + Thanh trạng thái: Ở dưới đáy cửa sổ Excel cho biết thông tin về bảng tính, về trạng thái soạn 

thảo, kết quả cộng đơn giản. 

Ready: Đang sẵn sàng làm việc. 

Enter: Đang nhập dữ liệu hay công thức. 

Pointer: Đang ghi công thức tham chiếu đến một địa chỉ. 

Edit: Đang điều chỉnh dữ liệu hay công thức trong ô hiện tại. 

+ Cửa sổ Bảng tính (Worksheet Window) là phần lớn nhất dùng để nhập dữ liệu, tính toán, vẽ 

đồ thị… 

Giao diện 

chương trình 

Excel 
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Thanh thực 

đơn lệnh 

Thanh 

tiêu đề 

Thanh 

công cụ 
Thanh 

công thức 

Thanh 

trạng thái 

Thanh 

cuộn dọc 

Thanh cuộn 

ngang 

Đường 

viền dọc 

Đường viền 

ngang 
Trang tính 

Sheet1, … 

Nhập dữ liệu 

vào đây 

CÁC THAO TÁC CƠ BẢN 

1. Mở bảng tính mới 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + N 

- Chọn menu File -> New 

 2. Lƣu bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + S 

- Chọn menu File -> Save 

3. Đóng bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + W 

- Chọn menu File -> Close 

 4. Mở bảng tính 

- Chọn biểu tượng:  

- Ấn tổ hợp phím: Ctrl + O 

- Chọn menu File -> Open 

5. Trang hiện hành, ô hiện hành 

 - Trên một bảng tính hiện hành, tại một thời điểm chúng ta chỉ có thể thao tác với các ô trên 

một trang của bảng tính và đó gọi là trang hiện hành. 

 
 

 Để chuyển trạng thái hiện hành đến trang khác, chúng ta chỉ cần thao tác đơn giản là nhắp 

chuột vào phần chứa tên của trang bảng tính. 

 - Trên trang hiện hành, tại một thời điểm chúng ta chỉ thao tác được với một ô, gọi là ô hiện 

hành. 

 
 

6. Nhận dạng con trỏ 

 Trên trang hiện hành, chúng ta sẽ thấy các loại con trỏ sau: 

 - Con trỏ ô: Xác định ô nào là ô hiện hành trên trang. Một đường bao đậm xuất hiện trên ô 

hiện hành. 

 - Con trỏ soạn thảo: Có hình│màu đen, nhấp nháy, xác định vị trí nhập dữ liệu cho ô. 

 - Con trỏ chuột: Thay đổi hình dạng tùy thuộc vị trí của nó trên trang bảng tính. 
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 Con trỏ chuột dạng chữ thập trắng khi ở trên các ô. 

 Con trỏ chuột có dạng chữ I khi ở phía trong ô đang soạn thảo. 

7. Cách nhập và chỉnh sửa dữ liệu trên ô hiện hành 

 - Các phím thường dùng 

 + Phím Tab: Di chuyển con trỏ ô sang phải một cột 

 + Phím Enter: Di chuyển con trỏ ô xuống dòng dưới và kết thúc việc nhập/chỉnh sửa dữ liệu. 

 + Các phím mũi tên : Di chuyển con trỏ ô đến các địa chỉ bất kỳ trên trang. 

 - Nhập dữ liệu: 

 + Nhắp chuột vào ô cần nhập hoặc sử dụng các phím mũi tên để chuyển trạng thái hiện hành 

về ô. 

 + Gõ phím để nhập kí tự vào ô, nếu sai thì sử dụng phím Delete hoặc Backspace để xóa kí tự, 

sử dụng phím Home/End để di chuyển nhanh trên dòng nhập 

 + Nhấn phím ESC nếu muốn kêt thúc nhập nhưng không lấy dữ liệu đã nhập. Nhấn phím 

Enter để đưa dữ liệu cho ô và kết thúc nhập. 

 - Chỉnh sửa dữ liệu: 

 Để chỉnh sửa dữ liệu đã nhập trên một ô, chúng ta nhắp đúp chuột vào ô đó rồi chỉnh sửa dữ 

liệu. Nhấn phím Enter để kết thúc chỉnh sửa. 

 

BÀI 2. SOẠN THẢO NỘI DUNG BẢNG TÍNH 

 

1. Nhập dữ liệu kiểu số và văn bản 

 - Dữ liệu một ô của bảng tính sau khi nhập sẽ được chương trình tự động phân loại và đưa về 

một trong các kiểu dữ liệu sau: Kiểu số (Number), kiểu văn bản (Text), kiểu logic, kiểu mã lỗi 

(Error) 

 + Kiểu số: Khi nhập dữ liệu số vào ô -> số được canh sang phải. 

Dữ liệu kiểu số được tạo bởi các kí tự cho phép đó là: 0 1 2 3 4 5 6 7 8 9 ( ) , / $ + - .  

 Nếu muốn nhập số âm, đánh dấu “-” vào trước số đó hoặc nhập số vào giữa cặp dấu ngoặc đơn 

( ). Để nhập số có phần thập phân, sử dụng dấu “,” ngăn cách với phần nguyên. 

 + Dữ liệu kiểu ngày tháng trong Excel được xem là kiểu số. Kiểu nhập ngày tháng được hệ 

điều hành qui định trong mục Regional Setting đặt trong cửa sổ Control Panel của hệ điều hành. Khi 

nhập kiểu ngày phải chú ý là máy của bạn đang đặt hệ ngày là ngày/tháng/năm (mm/dd/yyyy hay là 

dd/mm/yyyy). 

 
  

Kiểu ngày: khi nhập dữ liệu vào ô -> dữ liệu được canh sang phải. 

 Khi nhập số mà canh sang trái thì phải xoá bỏ định dạng hoặc định dạng lại. 

 - Chương trình Excel tự động điều chỉnh độ rộng hàng, cột để hiển thị hết dữ liệu trong một ô 

nhưng nếu một ô đã cố định độ rộng làm cho dữ liệu số không thể hiện được hết thì chúng ta sẽ nhìn 

thấy dạng thông báo “#########”. 
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 Lƣu ý: Giá trị của dữ liệu số sau khi nhập là không thay đổi khi chúng ta thay đổi khuôn dạng 

hiển thị dữ liệu trên màn hình. 

 Ví dụ: Chúng ta nhập giá trị vào ô D4, D6, D7 đều là 20000000. Sau đó thay đổi khuôn dạng ô 

D6 và D7 chúng ta có được các dạng thể hiện số khác nhau nhưng giá trị dữ liệu vẫn không thay đổi, 

ở ô D7 vẫn là 20000000 được hiển thị rõ ràng trên thanh công thức. 

 

 

 

 

 

 

 

 + Kiểu văn bản: Khi nhập dữ liệu vào ô -> dữ liệu được canh sang trái. 

Dữ liệu kiểu văn bản được tạo bởi các kí tự, kí tự số hoặc là khoảng trống và các kí tự không 

phải là số. 

Khi kí tự nhập vượt quá độ dài ô và ô bên phải còn trống thì Excel tiếp tục hiển thị phần kí tự 

còn lại của ô đó sang bên phải.  

Khi kí tự nhập vào vượt quá độ dài ô mà ô bên phải đã có dữ liệu thì Excel che dấu các kí tự 

vượt quá ô nhưng điều đó không làm thay đổi giá trị dữ liệu nhập của ô. 

2. Chỉnh sửa dữ liệu trong ô 
Có 3 cách để chỉnh sửa dữ liệu trong ô 

Cách 1: Nhắp đúp chuột vào ô mốn chỉnh sửa để chuyển ô sang trạng thái soạn thảo khi đó 

có thể chỉnh sửa dữ liệu. Nhấn phím Enter để kết thúc. 

Cách 2: Chọn ô muốn chỉnh sửa sau đó nhấn phím F2 khi đó ta sẽ thấy con trỏ chuột nhấp 

nháy, chỉnh sửa dữ liệu rồi nhấn phím Enter để kết thúc. 

Cách 3: Di chuyển chuột lên thanh Formula Bar sau đó nháy chuột vào vị trí cần chỉnh sửa, 

nhấn phím Enter để kết thúc. 

3. Thao tác chọn/hủy chọn ô, dòng, cột 
3.1 Chọn một ô 

Để chọn một ô, chúng ta chỉ cần nhắp chuột vào ô đó. 

3.2 Chọn vùng ô liên tục hình chữ nhật 

- Nhắp chuột vào ô trên cùng bên trái 

- Giữ phím Shift và nhắp chuột vào ô dưới cùng bên phải 

- Thả phím Shift để kết thúc việc chọn 

Trong trường hợp này địa chỉ vùng ô được viết theo khuôn dạng (địa chỉ ô trên cùng bên 

trái:địa chỉ ô dưới cùng bên phải), tách nhau bởi dấu hai chấm “:” 

VD: Chọn vùng ô (A1:D6). Nhắp chuột vào ô A1 sau đó nhấn và giữ phím Shift rồi nhắp 

chuột vào ô D6 ta chọn được một vùng ô như hình. 

 
 

3.3 Chọn vùng ô rời rạc 

- Đầu tiên chọn một ô hoặc một vùng ô liên tục hình chữ nhật 

- Giữ phím Ctrl trong khi chọn một hoặc một vùng ô liên tục hình chữ nhật tiếp theo. 
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Lƣu ý: Chúng ta có thể nhanh chóng thay đổi vùng chọn bằng cách nhắp chuột một lần nữa 

trên các ô đã chọn để hủy chọn mà không cần phải làm lại từ đầu. 

- Chỉ thả phím Ctrl khi kết thúc. 

3.4 Chọn một cột, dãy cột liền nhau, dãy cột rời rạc 

 Chọn một cột: Để chọn một cột, chúng ta nhắp chuột vào tên cột có trên đường viền 

ngang. 

 Chọn dãy cột liền kề nhau 
- Nhắp chuột vào tên cột đầu tiên (bên trái hoặc bên phải của dãy) trên đường viền ngang 

- Giữ phím Shift và nhắp chuột vào tên cột cuối cùng cùng của dãy 

- Sau khi lựa chọn xong thì thả phím Shift ra. 

 Chọn dãy cột rời rạc 

- Trước tiên chúng ta chọn cột hoặc dãy cột liền nhau 

- Giữ phím Ctrl trong khi chúng ta nhắp chuột chọn dãy cột tiếp theo. 

- Sau khi lựa chọn xong thì thả phím Ctrl. 

 
 

3.5 Chọn một dòng, dãy dòng liền kề nhau, dãy dòng rời rạc 

 Chọn một dòng 

- Để chọn một dòng, chúng ta nhắp chuột vào số thứ tự dòng có trên đường viền dọc. 

 Chọn dãy dòng liền kề nhau 

- Nhắp chuột vào số thứ tự dòng đầu tiên (trên cùng hoặc dưới cùng của dãy) trền đường 

viền dọc. 

- Giữ phím Shift và nhắp chuột vào số thứ tự dòng sau cùng của dãy. 

- Thả phím Shift ra. 

 
 

 Chọn dãy dòng rời rạc 

- Trước tiên chúng ta chọn dòng hoặc dãy dòng liền nhau 

- Giữ phím Ctrl trong khi chúng ta nhắp chuột chọn số thứ tự dòng tiếp theo, thả phím Ctrl 

khi kết thúc việc chọn dòng. 

3.6 Chọn toàn bộ bảng tính 

Cách 1: Chỉ cần nhắp chuột vào ô giao 

nhau của đường viền ngang và đường viền dọc. 

Cách 2: Bấm tổ hợp phím Ctrl + A 

3.7 Hủy chọn 

Để hủy chọn các ô, chúng ta chỉ cần nhắp đúp 

chuột vào ô bất kỳ trên trang bảng tính. 

4. Điền số thứ tự tự động 

- Nhập một số vào một ô bất kỳ 

- Nhấn và giữ phím Ctrl 

- Trỏ chuột vào hình vuông nhỏ ở góc dưới, 

bên phải ô đó, con trỏ chuyển thành hình dấu cộng có 
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mũ. 

- Nhấn và kéo chuột xuống theo chiều dọc, chúng ta sẽ thấy số thứ tự được điền tự động vào 

các ô tiếp theo, tăng dần. 

 
5. Sao chép, di chuyển, xóa, chèn các ô 

5.1 Sao chép các ô 

Thao tác sao chép một ô trong Excel không chỉ bao gồm sao chép nội dung, định dạng của ô 

đó. Chúng ta có thể nhìn thấy trong bảng dưới đây nhiều mục lựa chọn khi dán một ô đã sao chép. 

 All – Sao chép tất cả (nội dung, định dạng…) 

 Formulas – Sao chép công thức 

 Values – Sao chép giá trị 

 Formats – Sao chép định dạng 

 Comments – Sao chép chú thích 

 All except borders – Sao chép tất cả trừ đường viền 

 Column widths – Sao chép độ rộng cột 

 Formulas and number formats – Sao chép công thức 

và định dạng số 

 Values and number formats – Sao chép giá trị và định 

dạng số 

- Thao tác sao chép giữa các ô trên cùng trang bảng tính. 

+ Chọn ô cần sao chép (ô này có thể là một ô hoặc một vùng ô). 

+ Nhấn nút Copy hoặc bấm tổ hợp phím Ctrl + C để sao chép. 

+ Chuyển con trỏ đến vị trí muốn dán. 

+ Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô. 

- Thao tác sao chép giữa các ô khác trang bảng tính 

+ Trên trang bảng tính hiện hành, chọn các ô cần sao chép 

+ Nhấn vào nút lệnh Copy hoặc sử dụng tổ hợp phím Ctrl + C 

+ Chuyển trạng thái hiện hành đến trang bảng tính khác hay mở tệp bảng tính khác. 

+ Đặt con vào vị trí mốn dán 

+ Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô 

5.2 Di chuyển các ô 

- Chọn các ô cần di chuyển 

- Nhấn nút Cut hoặc bấm tổ hợp phím Ctrl + X 

- Chuyển con trỏ đến vị trí muốn dán 

- Nhấn nút Paste hoặc bấm tổ hợp phím Ctrl + V để dán các ô 

5.3 Xóa nội dung các ô 

- Chọn các ô muốn xóa 

- Nhắp chọn thực đơn lệnh Edit -> Clear -> Contents hoặc nhấn phím Delete 

6. Thêm/xóa dòng, cột 

- Thêm dòng 

+ Chọn vị trí mốn thêm 

dòng, bôi đen một hoặc một số 

dòng muốn thêm. 

+ Nhắp chọn thực đơn lệnh 

Insert -> Rows để tạo một dòng 

trống nằm giữa hai dòng. Dòng mới 

sẽ có định dạng giống như dòng 

được lựa chọn. 
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VD: Muốn thêm 3 dòng vào vị trí dưới dòng số 6 trong danh sách, ta bôi đen 3 dòng số 7, 8, 

9 sau đó nhắp chọn menu Insert chọn Rows, ta sẽ có được 3 dòng mới vào vị trí dưới dòng số 6. 

- Xóa dòng 

+ Chọn một hoặc nhiều dòng muốn xóa. 

+ Vào thực đơn lệnh Edit -> Delete. 

- Thêm cột 

+ Chọn vị trí muốn thêm cột, bôi đen một hoặc một số cột muốn thêm. 

+ Nhắp chọn thực đơn lệnh Insert -> Columns, một cột mới xuất hiện. 

- Xóa cột 

+ Chọn một hoặc nhiều cột muốn xóa. 

+ Vào thực đơn lệnh Edit -> Delete. 

7. Thao tác với bảng tính 

7.1 Chèn một trang vào bảng tính 

Khi tạo bảng tính thì mặc định có 3 trang bảng tính (Sheet), tuy nhiên người dùng có thể 

chèn thêm nhiều trang bảng tính mới.  

Cách 1: Nhắp chọn thực đơn lệnh Insert -> Worksheet. 

Cách 2: Nhấn phải chuột lên trang bảng tính bất kỳ, chọn mục Insert… sau đó lựa chọn 

Worksheet và nhấn vào nút OK. Một bảng tính mới xuất hiện. 

7.2 Đổi tên trang bảng tính 

Để dễ quản lý nội dung có trên các trang bảng tính, chúng ta nên đổi tên các trang bảng tính 

cho phù hợp với nội dung chứa trong trang. Tên trang bảng tính có thể chứa dấu cách, chữ cái, chữ 

số, dấu gạch dưới. 

Thực hiện các bước sau để đổi tên trang bảng tính: 

- Nhấn phải chuột vào tên trang bảng tính muốn thay đổi 

- Chọn Rename 

- Gõ tên mới rồi nhấn Enter 

     
7.3 Xóa một trang bảng tính 

- Nhắp chọn thực đơn lệnh Edit -> Delete Sheet hoặc nhắp phải chuột vào tên của trang 

muốn xóa làm xuất hiện hộp lệnh, chọn lệnh Delete. 

 
 

Trong trường hợp trang bảng tính đang chứa dữ liệu Excel sẽ hiển thị hộp thoại yêu cầu 

người dùng khẳng định việc hủy bỏ. Nhấn nút Delete để thực hiện việc xóa hoặc nhấn nút Cancel 

để bỏ qua thôi không xóa. 

 
7.4 Sao chép bảng tính 

Có thể sao chép một hoặc nhiều trang bảng tính sang vị trí mới hoặc sang bảng tính khác.  

- Để sao chép một trang bảng tính chúng ta thực hiện các bƣớc sau: 

+ Nhắp chọn tên trang bảng tính cần sao chép. 

+ Giữ phím Ctrl rồi kéo - thả tên trang bảng tính đó sang vị trí mới. 
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- Sao chép nhiều trang từ bảng tính này sang bảng tính khác 

+ Chọn các trang bảng tính cần sao chép. Có thể sử dụng phím Shift hỗ trợ để thao tác chọn 

nhiều trang liền kề hoặc sử dụng phím Ctrl hỗ trợ để chọn các trang rời rạc. 

+ Nhắp chọn thực đơn lệnh Edit -> Move or Copy Sheet… hoặc nhắp phải chuột vào vùng 

trang được chọn làm xuất hiện hộp chọn lệnh và sau đó chọn lệnh Move or Copy…  

+ Trong hộp thoại Move or Copy: 

 Trong phần To book hãy chọn bảng tính nhận bảng sao chép 

 Trong phần Before sheet vị trí đặt trang sao chép là trước trang nào hoặc để về cuối 

dãy trang có trên bảng tính (tiếng Anh là move to end) 

 Tích chọn vào ô Create a copy (nếu là di chuyển trang bảng tính thì không tích vào ô 

Create a copy) 

 Nhấn nút OK để hoàn thành việc sao chép 

 

 

BÀI 3. THAO TÁC ĐỊNH DẠNG 

1. Thao tác định dạng ô 

Chúng ta có thể thay đổi cách hiển thị dữ liệu một ô bằng thao tác định dạng. Thao tác định 

dạng không làm thay đổi giá trị của dữ liệu chứa trong ô. Excel cung cấp nhiều dạng biểu diễn dữ 

liệu trong ô gồm: 

 General: Dạng chung do Excel qui định sau khi nhập dữ liệu vào ô. 

 Number: Dạng số. 

 Currency: Dạng tiền tệ. 

 Date: Dạng ngày tháng. 

 Time: Dạng thời gian. 

 Text: Dạng văn bản. 

Custom: Dạng do người dùng tự định 

nghĩa theo các qui định mà Excel hỗ trợ. 

1.1 Định dạng dữ liệu số thực 

- Chọn ô có chứa dữ liệu số 

- Nhắp chọn thực đơn lệnh Format -> 

Cells xuất hiện hôp thoại Format Cells. 

- Chọn thẻ Number 

- Chọn mục Number trong nhóm định dạng Category tích chọn vào ô Use 1000 Separator 

(.) (sử dụng dấu chấm để ngăn cách phần nghìn). Chúng ta có thể thấy giá trị của ô được định dạng 

sẽ hiển thị ở mục Sample. 

- Nhấn nút OK để kết thúc.  

                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                                 

1.2 Định dạng dữ liệu theo dạng ngày tháng 

Khuôn dạng mặc định của Excel khi nhập dữ liệu kiểu 

ngày tháng vào bảng tính là tháng/ngày/năm (mm/dd/yy hoặc 

mm/dd/yyyy). Chúng ta có thể thay đổi cách biểu diễn dữ liệu 

theo ngày/tháng/năm như sau: 

 

- Ta lựa chọn những ô chứa dữ liệu ngày tháng. 

- Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện 

hôp thoại Format Cells. 

- Chọn thẻ Number 

- Trong hộp danh sách Category nhắp chọn mục Custom 

- Ở ô Type nhập chuỗi kí tự dd/mm/yyyy 
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- Nhấn nút OK để kết thúc. 

1.3 Định dạng dữ liệu dạng tiền tệ 

- Chọn những ô có chứa dữ liệu dạng tiền tệ 

- Nhắp chọn thực đơn lệnh Format -> Cells xuất 

hiện hôp thoại Format Cells. 

- Chọn thẻ Number 

- Trong hộp danh sách Category nhắp chọn mục 

Custom 

- Ở ô Type nhập dãy kí tự  #.##0 [$VND] 

- Nhấn nút OK để kết thúc. 

 

1.4 Định dạng dữ liệu theo kiểu phần trăm 

Trong một vài trường hợp, người sử dụng muốn biểu diễn một số dưới dạng phần trăm. Ví 

dụ: 0,98 sẽ được hiển thị 98% thì chúng ta thực hiện như sau: 

- Chọn ô có chứa dữ liệu muốn hiển thị dưới dạng phần trăm. 

- Nhấn chuột vào nút   trên thanh công cụ. 

2. Định dạng ô chứa văn bản 

2.1 Thay đổi kiểu chữ, cỡ chữ, dạng chữ 

Trong Excel việc thay đổi kiểu chữ, cỡ chữ, dạng chữ đậm/nghiêng/gạch chân được thao tác 

giống như trong Word. 

2.2 Thay đổi màu chữ và màu nền 

- Thay đổi màu chữ 

+ Chọn chữ muốn thay đổi màu 

+ Nhấn chuột vào mũi tên trỏ xuống trên thanh định dạng Font Color , chọn màu 

theo ý thích. 

- Thay đổi màu nền 

+ Chọn các ô muốn thay đổi màu nền 

Cách 1: Nhấn chuột vào mũi tên trỏ xuống trên thanh định dạng Fill Color , chọn 

màu theo ý thích. 

Cách 2: 

+ Nhắp chọn thực đơn lệnh Format -> 

Cells xuất hiện hôp thoại Format Cells. 

+ Chọn thẻ Patterns  

 Lựa chọn màu nền trong bảng 

màu Color. Thao tác này tương 

tự như thao tác tô màu nền ô 

bằng cách nhấn vào mũi tên trỏ 

xuống trong hộp Fill Color trên 

thanh định dạng rồi chọn màu 

muốn tô. 

 Lựa chọn mẫu họa tiết trang trí 

cho ô trong bảng mẫu Patterns 

2.3 Sao chép định dạng ô 

- Chọn ô đã được định dạng trước. Nếu 

chọn cả vùng ô thì vùng ô đó phải có cùng kiểu 

(kiểu chữ, màu chữ…) 
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- Nhấn nút Format Painter , di chuyển con trỏ chuột tới vị trí muốn sao chép định 

dạng khi đó bên phải con trỏ xuất hiện thêm một chổi quét sơn nhỏ. 

- Quét lên ô hoặc vùng ô để áp dụng sao chép định dạng. 

 2.4 Đặt thuộc tính Wrap Text cho ô 

 Đây là một công cụ cho phép tự động xuống dòng trong một ô nếu 

như dữ liệu nhập vào vượt quá độ rộng ô. 

 - Chọn ô muốn áp dụng đặt thuộc tính 

+ Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện hôp thoại 

Format Cells. 

+ Chọn thẻ Alignment 

 

+ Trong phần chọn Text Control, tích chọn ô Wrap Text để đặt thuộc tính tự động đưa nội 

dung ô xuống dòng làm cho nội dung được hiện đầy đủ. 

Lƣu ý: Để xóa bỏ định dạng ô ta lựa chọn ô cần gỡ bỏ định dạng sau đó nhắp chọn thực đơn 

lệnh Edit -> Clear -> Format. 

 

3. Căn lề, vẽ đƣờng viền ô 

3.1 Căn vị trí chữ trong ô: Giữa, trái, phải, trên, dƣới 

Khi nhập dữ liệu vào bảng tính, Excel sẽ phân tích xem nếu dữ liệu dạng văn bản thì tự động 

căn lề bên trái, nếu dữ liệu dạng số thì căn lề bên phải. Tuy nhiên, chúng ta có thể chọn cách căn lề 

khác cho phù hợp với mục đích trình bày bảng tính. Cách thực hiện như sau: 

- Chọn ô muốn áp dụng định dạng. 

Cách 1: Nếu căn nội dung ô đó theo chiều ngang thì nhắp chuột vào một trong ba nút căn 

trái, căn phải, căn giữa trên thanh công cụ. 

Cách 2: Nếu muốn căn nội dụng ô đó theo cả chiêu ngang và chiều dọc thì ta nhắp chọn thực 

đơn lệnh Format -> Cells xuất hiện hôp thoại Format Cells. 

+ Chọn thẻ Alignment 

Trong phần Text alignment có 2 hướng căn chỉnh lề 

 Horizontal (theo chiều ngang): Dùng để căn chỉnh theo lề trái và lề phải của ô. 

 Vertical (theo chiều dọc): Dùng để căn chỉnh theo lề trên và lề dưới của ô. 

+ Nhấn nút OK để kết thúc 

3.2 Hòa nhập dãy ô để tạo tiêu đề bảng biểu 

Có thể hòa nhập nhiều ô liền nhau thành một ô.  

 
Cách thực hiện như sau: 

- Chọn các ô cần hòa nhập 

Cách 1:  

+ Nhắp chọn thực đơn lệnh Format -> Cells xuất hiện 

hôp thoại Format Cells. 

+ Chọn thẻ Alignment 

+ Trong phần chọn Text Control, tích chọn Merge 

cells để hòa nhập các ô. 

+ Nhấn nút OK để kết thúc 

Cách 2: Nhấn nút Merge and Center  trên 

thanh công cụ. 
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3.3 Thay đổi hƣớng chữ trong ô 

Muốn thay đổi hướng chữ trong ô thì thực hiện các thao tác sau: 

- Chọn vùng ô muốn thay đổi hướng chữ 

- Nhắp chọn thực đơn lệnh Format -> Cells -> chọn thẻ Alignment. 

- Trong phần Orientation, nhắp chuột vào mũi tên màu đỏ, kéo quay trên đường cung tròn 

đến độ nghiêng phù hợp. Ở trong ô Degrees sẽ hiển thị độ nghiêng của văn bản. 

- Nhấn vào nút OK để hoàn thành. 

        
 

 

3.4 Thêm đƣờng viền cho ô, vùng ô 

Cách 1: Sử dụng nút Borders trên thanh công cụ 

- Chọn vùng ô muốn vẽ đường viền 

- Trên thanh công cụ Formatting, nhắp chuột vào tam giác nhỏ 

 làm xuất hiện bảng lựa chọn đường viền. 

Cách 2: Sử dụng hộp thoại Format Cells 

 Cách này dùng để tạo đường viền ô 

hay vùng ô theo yêu cầu phức tạp hơn. Ta 

thực hiện như sau: 

 - Chọn ô, vùng ô cần kẻ đường viền 

 - Nhắp chọn thực đơn lệnh Format 

-> Cells -> chọn thẻ Border  

 - Trong thẻ Border, nhắp chọn kiểu 

dáng đường viền ở phần Line Style 

(đường viền mảnh, đậm, đường viền đôi, 

đứt quãng…), chọn màu đường viền ở 

phần Line Color. 

 - Trong phần Presets có 3 kiểu tạo 

đường viền 

 None: Không tạo đường 

viền 

 Outline: Kẻ nhanh đường viền ngoài 

 Inside: Kẻ nhanh đường viền trong vùng ô 

- Trong thẻ Border, Excel còn cho phép người dùng tự vẽ đường viền bằng cách nhấn vào 

một trong 8 nút (ngang, dọc, chéo) nằm xung quanh mẫu ô. Đây cũng là công cụ dùng để xóa bỏ 

đường viền đã có trước. 
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BÀI 4. CÔNG THỨC VÀ HÀM 

1. Tạo công thức cơ bản 

1.1 Tạo công thức số học cơ bản 

- Công thức được tạo ra để tính toán và trả lại giá trị cho ô bảng tính. Phải nhập kí tự “=” 

trước khi nhập nội dung công thức. Kí tự này giúp Excel nhận biết và thực hiện công thức. 

Ví dụ: Muốn tính tổng giá trị có trên ô C5, C6 và kết quả đặt ở trên ô D6, chúng ta nhập 

công thức “=C5 + C6” vào ô D6. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Kết quả tính toán sẽ hiển thị tại ô, còn nội dung công thức (gồm cả kí tự =) có thể nhìn thấy 

trên thanh công thức Formula Bar. 

- Chúng ta có thể chỉnh sửa nội dung công thức và cuối cùng là nhấn phím Enter để công 

thức được tính toán lại và trả về giá trị cho ô. 

1.1.1 Phép toán trong công thức số học 

Danh sách các phép toán và các kí tự khác dùng trong công thức số học được liệt kê trong 

bảng sau: 

Kí tự Diễn giải 

+  (cộng) Phép cộng 

-   (trừ) Phép trừ 

*   (sao) Phép nhân 

/    (gạch chéo) Phép chia 

( )  (cặp dấu ngoặc đơn) Toán tử trong dấu ngoặc luôn được tính toán trước 

^   (dấu mũ) Phép mũ (VD: 2^3 tương đương 2*2*2) 

1.1.2 Phép so sánh trong công thức LOGIC 

 Công thức logic có kết quả trả về chỉ là TRUE (đúng) hoặc FALSE (sai). Danh sách các phép 

so sánh dùng trong công thức logic được liệt kê trong bảng sau: 

Toán tử Diễn giải (Ví dụ) 

= Bằng (A1=B1) 

> Lớn hơn (A1>B1) 

< Nhỏ hơn (A1<B1) 

>= Lớn hơn hoặc bằng (A1>=B1) 

<= Nhỏ hơn hoặc bằng (A1<=B1) 

<> Không băng (A1<>B1) 

 

 

 

Thanh công thức 

Formula Bar 
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1.1.3 Thứ tự tính toán 

Khi tính toán, Excel sẽ ưu tiên các phép toán logic trước rồi mới đến phép toán số học. Thứ 

tự thực hiện các phép toán số học trong Excel có mức ưu tiên như sau: 

Thứ tự Phép toán Chức năng 

1 - Đảo dấu 

2 % Lấy phần trăm 

3 ^ Phép lũy thừa 

4 * và / Phép nhân và chia 

5 + và - Phép cộng và trừ 

6 & Phép nối chuỗi, ví dụ =“Viet”&“Nam” sẽ cho 

chuỗi kí tự VietNam 

7 Các phép toán so sánh  

 

Để làm thay đổi trật tự tính toán, chúng ta chỉ được dùng cặp dấu ngoặc đơn để nhóm các 

biểu thức ưu tiên tính trước. 

VD: =10+5*2 kết quả được 20. 

        =(10+5)*2 kết quả được 30. 

1.1.4 Cách nhập công thức vào ô 

- Nhắp đúp chuột chọn ô 

- Trước tiên nhập kí tự “=” sau đó nhập nội dung công thức 

- Nhấn phím Enter để kết thúc và thực hiện tính toán công thức. 

1.2 Nhận biết và sửa lỗi 

- Lỗi ##### 

Lỗi xảy ra khi chiều rộng cột không đủ để hiển thị kết quả tính toán. Sửa lỗi bằng cách tăng 

chiều rộng cột đó hoặc thu nhỏ kích thước phông chữ. 

- Lỗi #VALUE! 

Lỗi xảy ra do người sử dụng dữ liệu hoặc toán tử tham gia vào công thức không đúng yêu 

cầu của công thức. 

 Công thức toán học song lại tính toán trên ô chứa dữ liệu kiểu văn bản. Sửa lỗi bằng 

cách nhập lại địa chỉ hoặc định dạng lại ô chứa dữ liệu. 

 Công thức sử dụng dữ liệu là địa chỉ ô chứa công thức khác. Sửa lỗi bằng cách thay 

đổi công thức. 

- Lỗi #DIV/0! 

Lỗi xảy ra khi chia một số cho 0 hoặc mẫu số của phép tính là một ô không có dữ liệu. Sửa 

lỗi bằng cách nhập công thức khác. 

- Lỗi #NAME? 

Lỗi xảy ra khi Excel không xác định được các kí tự trong công thức. Ví dụ sử dụng một tên 

vùng ô chưa được định nghĩa. 

- Lỗi #N/A 

Lỗi xảy ra do không có dữ liệu để tính toán 

- Lỗi #NUM! 

Lỗi xảy ra do sử dụng dữ liệu không đúng kiểu số. Cần định dạng lại dữ liệu tham gia vào 

công thức. 

2. Địa chỉ tuyệt đối và địa chỉ tƣơng đối 

2.1 Địa chỉ tƣơng đối và tuyệt đối 

Các ô là thành phần cơ sở của một bảng tính Excel. Ô có thể chứa các kết quả tính toán theo 

một công thức nào đó với sự tham gia của nhiều ô khác, chẳng hạn chứa tổng số của các ô trong 

cùng cột hay cùng dòng. 
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Địa chỉ ô được phép có mặt trong công thức và tự động điều chỉnh theo thao tác sao chép 

công thức nên chúng ta có khái niệm địa chỉ tham chiếu tuyệt đối, địa chỉ tham chiếu tương đối, địa 

chỉ tham chiếu hỗn hợp. 

- Địa chỉ tuyệt đối: Chỉ đến một ô hay các ô cụ thể. 

- Địa chỉ tương đối: Chỉ đến một ô hay các ô trong sự so sánh với một vị trí nào đó. 

- Địa chỉ tham chiếu hỗn hợp: Có một thành phần là tuyệt đối, phần còn lại là tương đối. 

2.2 Địa chỉ tham chiếu tƣơng đối 

Địa chỉ tham chiếu tương đối gọi tắt là địa chỉ tương đối có trong công thức sẽ thay đổi theo 

vị trí ô khi chúng ta thực hiện sao chép công thức từ một ô đến các ô khác. 

Ví dụ: Chúng ta nhập công thức trong ô C1 là =(A1+B1)/2 

Khi sao chép công thức này đến ô C2 thì nó tự động thay đổi địa chỉ để trở thành công thức 

là =(A2+B2)/2. Khi sao chép công thức này đến ô C3 thì nó sẽ tự động thay đổi địa chỉ để trở thành 

công thức là =(A3+B3)/2 

2.3 Địa chỉ tham chiếu tuyệt đối 

Địa chỉ tham chiếu tuyệt đối gọi tắt là địa chỉ tuyệt đối. Dấu (đô la) $ thêm vào trước chữ cái 

chỉ cột hoặc trước số thứ tự dòng khi viết địa chỉ tuyệt đối trong công thức. Lúc này, địa chỉ ô ghi 

trong công thức sẽ cố định không thay đổi theo thao tác sao chép công thức từ giữa các ô.    

Nếu có công thức F2=$C$4+$D$4/5 thì khi sao chép sang ô F3 nó vẫn là =$C$4+$D$4/5, 

khi sao chép sang bất kỳ ô nào công thức vẫn là =$C$4+$D$4/5. 

 

3. Thao tác với hàm 

3.1 Giới thiệu về hàm 

- Hàm có thể tham gia như một phép toán trong công thức. Hàm sẽ trả về một giá trị (kiểu 

số, kiểu ngày tháng, kiểu xâu kí tự…) hay một thông báo lỗi. 

- Dạng thức chung của hàm như sau: 

<Tên hàm> (Đối số 1, Đối số 2,…, Đối số n) 

- Danh sách đối số: Phần lớn các hàm trong Excel đều có một hoặc nhiều đối số. Đối số có 

thể là một giá trị kiểu số, một xâu kí tự, địa chỉ ô hay vùng ô, tên vùng, công thức, hay những hàm 

khác.  

Ví dụ: Hình dưới minh họa một công thức có sử dụng hàm. Ô D9 chứa giá trị trung bình 

cộng của các số từ ô C5 đến C9. Hàm EVERAGE sẽ tính giá trị trung bình các ô trong danh sách 

đối số. 

 
 

* Các bƣớc để nhập một hàm: 

Khi con trỏ nhập văn bản đang ở tại vị trí cần nhập 

hàm thì nhấn chuột vào menu Insert -> chọn x Function. 

 

Hộp thoại Insert Function xuất hiện 

 Trong hộp Or select a category: chọn All để 
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hiện thị tất cả các hàm. 

 Trong mục Select a function: 

lựa chọn hàm cần thực hiện ở 

khung bên dưới. 

 Nhấn OK để kết thúc. 

 

Nếu biết chính xác tên hàm và cách 

điền các tham số chúng ta có thể gõ trực tiếp 

trên thanh công thức. 

- Thông thường Excel ngầm định dấu 

phẩy “;” để ngăn cách các đối số trong hàm. 

- Tiêu chuẩn nhận hai giá trị :  

0 - xếp hạng giảm dần (số lớn nhất xếp thứ nhất). 

   1 - xếp hạng tăng dần (số nhỏ nhất xếp thứ nhất). 

3.2 Các hàm thƣờng dùng 

 Hàm ROUND: Làm tròn một số đến một số 

thập phân nhất định 

Dạng thức: ROUND(Đối số 1;Đối số 2) 

Đối số 1 là số muốn làm tròn; Đối số 2 là số 

thập phân muốn làm tròn. 

Ví dụ: =ROUND(9,98;1) – Kết quả là 10 

 Hàm MAX, MIN: Cho giá trị cao nhất và 

thấp nhất trong danh sách đối số. 

Dạng thức: MAX(Đối số 1;Đối số 2;…;Đối số 

n) 

Dạng thức: MIN(Đối số 1;Đối số 2;…;Đối số n) 

Ví dụ: =MIN(G4:G10) – Cho giá trị thấp nhất 

trong danh sách đối số. 

 Hàm AVERAGE: Tính trung bình cộng các 

giá trị của danh sách đối số. 

Dạng thức: = AVERAGE(Đối số 1;Đối số 2;…;Đối số n) 

Đối số có thể là giá trị số, địa chỉ ô, vùng ô… 

Ví dụ: =AVERAGE(A1;B5:B10) – Tính trung bình cộng các ô trong phạm vi từ B5 đến B10 

và ô A1 

 Hàm COUNT: Đếm những ô chứa dữ liệu số trong vùng. 

Dạng thức: = COUNT(Đối số 1;Đối số 2;…;Đối số n) 

Ví dụ: =COUNT(H4:H20) – Đếm những ô chứa dữ liệu số, các ô kiểu khác không được 

đếm. 

 Hàm COUNTA: Đếm những ô chứa dữ liệu trong vùng. 

Dạng thức: = COUNTA(Đối số 1;Đối số 2;…;Đối số n) 

Ví dụ: =COUNTA(H4:H20) – Đếm những ô chứa dữ liệu cùng kiểu từ ô H4 đến H20 

 Hàm SUM: Tính tổng các giá trị của danh sách đối số. 

Dạng thức: SUM(Đối số 1;Đối số 2;…;Đối số n). 

Đối số có thể là giá trị số, địa chỉ ô, vùng ô… 

Ví dụ: =SUM(G4:G10) – Tính tổng số trong phạm vi từ G4 đến G10. 

 Hàm IF: Nếu biểu thức điều kiện đúng thì hàm nhận giá trị khi đúng, nếu không sẽ nhận 

giá trị khi sai. 

Dạng thức: =IF(Biểu thức điều kiện;giá trị nếu đúng;giá trị nếu sai) 

Biểu thức điều kiện là biểu thức logic bất kì, nhận giá trị đúng hoặc sai. 
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 Hàm SUMIF: Tính tổng theo điều kiện đơn giản 

Dạng thức: =SUMIF(vùng ước lượng;điều kiện;vùng tính toán) 

- Vùng ước lượng: Là một vùng ô 

- Điều kiện: Có thể là hằng số, địa chỉ của một ô, hay dạng thức “>1500000” 

- Vùng tính toán: Các ô thật sự cần tính toán. Nếu bỏ qua tham số này thì vùng ước lượng 

được lấy làm vùng tính toán. 

 Hàm COUNTIF: Đếm theo điều kiện đơn giản. 

Dạng thức: =COUNTIF(vùng ước lượng;điều kiện) 

Điều kiện: Có thể là hằng sô, tọa độ của một ô, hay dạng thức “>1500000” 

 Hàm VLOOKUP:  

Dạng thức của hàm:  

=VLOOKUP(Giá trị tìm kiếm;vùng bảng đối chiếu;cột trả kết quả;sắp xếp vùng đối chiếu) 

 

Bài tập:  
1. Mở bảng tính mới và nhập dữ liệu vào Sheet1 bao gồm các mục như hình. 

 
2. Bảng đối chiếu được nhập trên cùng trang bảng tính trong vùng ô D13:E18 gồm cột chức 

vụ và phụ cấp. 

3. Thực hiện điền phụ cấp vào bảng lương chính một cách tự động tại ô F6 theo công thức 

=VLOOKUP(D5;$D$13:$E$18;2;0). 

Giải thích công thức VLOOKUP(D5;$D$13:$E$18;2;0) như sau: 

- Vùng giá trị tìm kiếm là giá trị tại ô D5 

- Vùng bảng đối chiếu là $D$13:$E$18, với địa chỉ tuyệt đối. 

- Cột trả lại kết quả là cột thứ 2 trong bảng đối chiếu – cột phụ cấp. 

- Cuối cùng số 0 cho biết không cần sắp xếp cột đầu tiên trong bảng đối chiếu theo trật tự giá 

trị tăng dần. 

4. Cuối cùng là sao chép công thức tại ô F5 đến các ô dưới. 
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BÀI 5. BIỂU ĐỒ, ĐỒ THỊ 

 Tự động vẽ biểu đồ là một chức năng được ưa thích nhất của bảng tính Excel. Các biểu 

đồ, đồ thị là những hình ảnh minh họa rất trực quan, đầy tính thuyết phục. Người xem rút ra ngay 

được những kết luận cần thiết từ các biểu đồ, đồ thị mà không cần giải thích. Ngoài ra chúng ta dễ 

dàng tạo ra nhiều kiểu biểu đồ, đồ thị khác nhau dựa vào những số liệu trên bảng tính hiện hành. 

Excel còn cho phép thay đổi cách trình bày, điều chỉnh đường trục, đường biểu diễn, thêm ghi chú… 

1. Tạo các kiểu biểu đồ, đồ thị khác nhau 

Bôi đen vùng dữ liệu cần lập biểu đồ 

Cách 1: Nháy vào biểu tượng Chart Wizard  trên thanh công cụ. 

Cách 2: Nhắp chuột vào menu Insert -> Chart -> xuất hiện hộp thoại Chart Wizard. 

 
Chọn kiểu biểu đồ (VD: Biểu đồ hình cột đứng) -> Next chuyển sang bước tiêp theo -> Next 

chuyển sang bước tiếp. 

 
 

- Gõ tiêu đề cho biểu đồ vào dòng Chart title. 

- Gõ tiêu đề trục Y vào trong ô Value (Y) axls. 

- Nhấn nút Next để chuyển sang bước chọn nơi đặt biểu đồ, đồ thị, chọn Sheet2 trong ô As 

object In. 
- Nhấn nút Finish để kết thúc. 

2. Sửa đổi biểu đồ, đồ thị  

2.1 Thêm tiêu đề, chú thích ý nghĩa các trục đồ thị 

 Thêm tiêu đề 
- Nhắp phải chuột vào vùng trống trong đồ thị làm xuất hiện hộp lệnh, chọn lệnh Chart 

Option. 
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- Trong hộp thoại Chart Option, chọn thẻ Titles sau đó đánh tiêu đề mới hoặc chỉnh sửa lại 

tiêu đề. 

- Nhấn OK để kết thúc. 

 Chú thích ý nghĩa các trục đồ thị 

- Nhắp phải chuột vào vùng trống trong đồ thị làm xuất hiện hộp lệnh, chọn lệnh Chart 

Option. 

- Trong hộp thoại Chart Option, chọn thẻ Legend sau đó tích vào ô Show Legend (hiển thị 

chú thích). 

- Trong mục Placement, chúng ta lựa chọn chế độ hiển thị chú thích (trên, dưới, trái, phải…) 

- Nhấn OK để kết thúc. 

 Xóa bỏ tiêu đề, chú thích 
- Nhắp chuột chọn tiêu đề hay chú thích. 

- Nhấn phím Delete để xóa bỏ. 

2.2 Hiển thị dữ liệu kèm đồ thị 

 Trong những trường hợp người dùng muốn 

dữ liệu cơ sở phải đi kèm cùng với biểu đồ thì thực 

hiện thao tác sau: 

 - Nhắp phải chuột vào vùng trống 

trong đồ thị làm xuất hiện hộp lệnh, chọn lệnh 

Chart Option. 

- Trong hộp thoại Chart Option, chọn thẻ 

Data Table sau đó đánh dấu chọn vào ô Show 

data table. 
- Nhấn OK để kết thúc. 

 

 

 

 

 

BÀI 6. HOÀN THIỆN TRANG BẢNG TÍNH VÀ IN ẤN 

1. Thay đổi lề của trang in 

- Để thay đổi lề của trang in ta nhắp chuột vào File -> Page Setup…-> Chọn thẻ Margin. 
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Trong thẻ Margin có các hộp thoại sau: 

+ Top/Bottom/Left/Right: Để thiết lập khoảng cách lề trên/dưới/trái/phải của trang in. 

Thông thường, đơn vị đo là Inches. Có thể nhập giá trị trực tiếp vào ô hoặc sử dụng mũi tên lên 

xuống để tăng giảm khoảng cách. 

+ Header: Thiết lập khoảng cách dành cho vùng đầu trang. 

+ Footer: Thiết lập khoảng cách dành cho vùng chân trang. 

+ Center on page: Căn chỉnh dữ liệu vào giữa theo hai chiều. 

 Horizontally: Chiều ngang trang in. 

 Veritically: Chiều dọc trang in. 

Có thể nhấn vào nút Print Preview để xem các thiết đặt trên được áp dụng vào tài liệu như 

thế nào. Nhấn vào nút Print nếu muốn in ngay, nhấn vào nút Options nếu muốn thay đổi thông số 

của máy in. 

2. Thay đổi trang in 

- Nhắp chuột vào File -> Page Setup…-> Chọn thẻ Page. Thiết đặt các thông số sau: 

- Mục Orientation: Cho phép thay đổi hướng trang in 

 Portrait: In theo chiều dọc của trang giấy. 

 Landcape: In theo chiều ngang của trang giấy. 

- Mục Scaling: Cho phép thay đổi tỷ lệ, kích thước nội dung trang in. 

 Adjust to: Có thể phóng to hoặc thu nhỏ nội dung theo tỉ lệ phần trăm so với kích 

thước chuẩn 100% ban đầu. 

- Mục Paper size: Cho phép chọn khổ giấy (A3, A4, Letter,…) 

- Nhấn OK để kết thúc. 

3. Đánh số trang in: File -> Page Setup…-> Chọn thẻ Page 

3. Chỉnh sửa để in vừa trong số trang định trƣớc 

- Nếu muốn thu nhỏ nội dung để in trong một trang ta thực hiện như sau: 

+ Vào menu File -> Page Setup…-> Chọn thẻ Page. 

+ Trong hộp chọn Fit to, gõ số 1 và xóa bỏ giá trị trong ô bên phải. Khi đó, tất cả dữ liệu 

trong một bảng tính, dù nhiều hay ít, đều được sắp xếp để chỉ in ra một trang giấy. 

 
- Tương tự như vậy ta có thể căn chỉnh để cho in vừa số trang như mong muốn (VD: Muốn 

in tổng số là 5 trang, ta cũng chỉ việc gõ số 5 vào hộp chọn Fit to). 
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4. In ấn 

Nhắp chọn thực đơn lệnh File -> Print hoặc bấm tổ hợp phím Ctrl + P làm xuất hiện hộp 

thoại. 

 
 

 Chọn máy in: Trong mục Printer, nhấn vào ô Name để chọn máy in. 

 In toàn bộ bảng tính: 

Một bảng tính gồm nhiều trang bảng tính, mỗi trang bảng tính lại chứa dữ liệu độc lập với 

nhau, vì vậy cần thận trọng khi thực hiện thao tác này, tránh lãng phí giấy. 

- Trong phần Print What, nhấn chọn Entire workbook. 

- Nhấn nút Preview để xem lại các trang sắp in. 

 In toàn bộ trang bảng tính hiện hành 

- Trong phần Print What, nhấn chọn Active sheet(s). 

- Trong phần Print Range, nhấn chọn vào All. 

- Nhấn vào nút Preview để xem lại các trang sắp in. 

 In một vùng ô định trƣớc 

 Để in một phần trang bảng tính hiện hành (VD: Một dãy cột, vùng ô…), chọn vùng ô định in 

(sử dụng phím Shift và Ctrl hỗ trợ thao tác chọn) trước khi mở hộp thoại Print. 

 - Trong phần Print What, nhấn chọn Selection. 

 - Nhấn vào nút Preview để xem lại các trang sắp in. 

  In một phần trang bảng tính 

 Trong một trang bảng tính mà ta có 10 trang nhưng ta chỉ muốn in từ trang 2 đến trang 5 thì ta 

làm như sau: 

 - Trong phần Print Range, nhấn chọn vào Page(s). 

 Gõ số thứ tự trang muốn in đầu vào ô From, số thứ tự trang in cuối vào ô To 

 Trong trường hợp chỉ muốn in ra một trang thì gõ số thứ tự tờ đó vào cả hai ô From 

và To. 

 In bảng tính ra nhiều bản 

- Chúng ta có thể đặt số bản in sẽ in ra giấy trong phần Copies chọn ô Number of copies. 

- Thường là máy mặc định là in hết bản in này đến bản in khác (nhấn chọn Collate) 

- Nếu muốn in song song các trang giống nhau thì bỏ chọn trong ô Collate. 
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BÀI TẬP ÔN TẬP MICROSOFT EXCEL 

 

Câu 1: Trong Excel, khi nhập dữ liệu vào: 

a. Dữ liệu số mặc nhiên sẽ canh trái trong ô 

b. Dữ liệu chuỗi sẽ mặc nhiên canh phải trong ô 

c. Dữ liệu số mặc nhiên sẽ canh phải trong ô 

d. Cả a và b cùng đúng  

Câu 2: Ðịa chỉ của một khối dữ liệu hình chữ nhật trong Excel đƣợc xác định bởi địa chỉ nhƣ 

sau: 

a. <ô đầu tiên góc trên phải> : <ô cuối cùng góc dưới trái> 

b. <ô đầu tiên góc trên trái> : <ô cuối cùng góc dưới phải> 

c. <ô đầu tiên góc trên trái> : <ô cuối cùng góc dưới trái> 

d. Cả ba câu đều sai  

Câu 3: Nếu gõ vào ô A2 công thức = ABS(-9)= SQRT(-81) thì kết quả trả về: 

a. True   b. Sai (False)  c. #NUM! d. Không có câu đúng 

Câu 4: Kết quả của biểu thức AVERAGE (5;6) + ABS (3) + SQRT (9) -INT(81,13) là: 

a. -70   b. 70   c. - 69,5 d. Một kết quả khác 

Câu 5: Tại một địa chỉ ô, ta thực hiện một hàm tính toán nhƣng bị sai tên hàm thì thông báo 

lỗi là: 

a. FALSE  b. #NAME  c. #VALUE d. #N/A 

Câu 6: Tại ô A5 nhập chuỗi ”TINHOC”, cho biết kết quả khi thực hiện lệnh =LEFT(A5) 

a. “TINHOC”  b. FALSE  c. #VALUE d. “T” 

Câu 7: Để chèn thêm một hàng vào bảng tính thì di chuyển con trỏ ô đến vị trí cần chèn và: 

a. Chọn Format\Cells   b. Chọn Insert\Row   

c. Chọn Format\Column  d. Chọn Insert\Column 

Câu 8: Để lọc dữ liệu tựđộng ta chọn khối dữ liệu cần lọc, sau đó: 

a. Chọn Format\ Filter   b. Chọn View\AutoFilter 

c. Chọn Data\Filter\AutoFilter d. Chọn View\Filter\AutoFilter 

Câu 9: Khi nhập dữ liệu trong ô, để ngắt xuống dòng trong ô đó thì: 

a. Ấn tổ hợp phím Ctrl+Shift   b. Ấn tổ hợp phím Alt+Shift 

c. Ấn tổ hợp phím Ctrl+Enter   d. Ấn tổ hợp phím Alt+Enter 

Câu 10: Tại địa chỉ A1 chứa giá trị ngày tháng năm sinh của học sinh Nguyễn Văn A là 

12/10/1978, công thức nào sau đây cho kết quả là số tuổi của học sinh A: 

a. =2011-year(A1)  b. =Now  c. =Today   d. Year(Today) 

Câu 11: Trong bảng điểm học sinh của toàn Trƣờng Đông Á, nếu ta muốn in ra danh sách học 

sinh bị điểm môn Chính trị dƣới 5 để cho thi lại thì ta có thể dùng lệnh gì sau đây: 

a. Data – SubTotal b. Data – Consolidate    c. Data – Sort        d. Data - Filter – AutoFilter 

Câu 12: Kết quả của công thức =INT(1357.879) là: 

a. 1357.0   b. 1357  c. 1358             d. Không có đáp án đúng 

Câu 13: Kích thƣớc của một bảng tính trong Excel là: 

a. 65536 dòng x 255 cột  b. 256 dòng x 65536 cột  

c. Không hạn chế   d. 65536 dòng x 256 cột 

Câu 14: Chọn kết quảđúng nhất: RIGHT(“Thành phố Lào Cai”, 7) sẽ trả về: 

a. “Thành phố”  b. “Thành p”      c. “Lào Cai”            d. Không có câu nào đúng 

Câu 15: Các phép so sánh hay các phép toán Logic trong Excel bao giờ cũng cho ra kết quả là: 

a. True hoặc False    b. True   c. Cả True và False d. False 

Câu 16: Để nhóm dữ liệu theo một trƣờng nào đó trên một CSDL và thống kê số liệu cuối mỗi 

nhóm ta dùng lệnh: 

a. Data – SubTotal  b. Data – Consolidate     c. Data – Sort    d. Cả a và c đều đúng 
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Câu 17: Nếu thí sinh đạt từ 5 điểm trở lên, thí sinh đó đƣợc xếp loại Đạt, ngƣợc lại nếu dƣới 5, 

thì xếp loại Không đạt. Theo bạn, công thức nào dƣới đây thể hiện đúng điều này (Giả sử ô K8 

đang chứa điểm thi) 

a. =IF(K8>=5,“Đạt”) Else (“Không đạt”) 

b. =IF(K8<5,“Không đạt”,“Đạt”) 

c. =IF(K8<=5,“Đạt”,“Không đạt”) 

d. =IF(K8>=5,“Đạt”,“Không đạt”) 

Câu 18: Với công thức =RIGHT(“OFFICE2003”,4) thì kết quả trả về sẽ là: 

a. Một kiểu dữ liệu dạng số 

b. Một kiểu dữ liệu dạng chuỗi 

c. Cả câu a và b đều đúng 

d. Cả câu a và b đều sai 

Câu 19: Chọn kết quả đúng nhất: IF(18<19,“SAI”,“DUNG”) trả về: 

a. “DUNG” 

b. Sai 

c. “SAI” 

d. Không có câu đúng 

Câu 20: Muốn tính trung bình của hàng hay cột, bạn sử dụng hàm nào trong số các hàm dƣới 

đây? 

a. Hàm SUM(TOTAL)/TOTAL()   c. Hàm Medium 

b. Hàm TOTAL(SUM)/SUM()   d. Hàm Average 

Câu 21: Kết quả trả về của công thức: =OR(2>3,4<1) sẽ là: 

a. True    b. False 

c. Đúng   d. Sai 

Câu 22: Để tổng hợp số liệu từ nhiều bảng tính khác nhau, ta sử dụng công cụ: 

a. CONSOLIDATE 

b. SORT 

c. FILTER 

d. SUBTOTAL 

Câu 23: Kết quả của công thức =ROUND(1257.879,1) là: 

a. 1257.80   b. 1257.8  c. 1257.9  d. 1257.1 

Câu 24: Đểđổi tên cho một Sheet ta thực hiện nhƣ sau: 

a. Right click vào tên Sheet cần đổi tên, chọn Rename, gõ tên mới và Enter 

b. Tại Sheet cần đổi tên chọn lệnh Format - Sheet - Rename, gõ tên mới và Enter 

c. Double click vào tên Sheet cần đổi tên, gõ tên mới và Enter 

d. Tất cả các cách trên đều đúng  

Câu 25: Trong các ký hiệu sau, ký hiệu nào không phải là địa chỉ ô: 

a. $Z1   b. AA$12  c. $15$K d. Cả ba đều là địa chỉ ô 

Câu 26: Để sắp xếp cơ sở dữ liệu đang chọn thì sử dụng lệnh nào sau đây: 

a. Data – Sort    b. Tools – Sort  c. Table – Sort  d. Format – Sort 

Câu 27: Trong bảng tính Excel, giả sử tại ô F12 ta có công thức =”Lào Cai,” &Average(5,5) thì 

sẽ cho ra kế quả là: 

a. Lào Cai, 

b. Lào Cai,5 

c. FALSE 

d. Lào Cai,2 

Câu 28: Địa B$5 là địa chỉ 

a. Tươngđối   b. Tuyệt đối  c. Hỗn hợp  d. Biểu diễn sai 

Câu 29: Cho biết kết quả của công thức =SQRT(100) 
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a. 100    b. 0.1   c. 1000   d. 10 

 

Câu 30: Để tính tổng các số ghi trên cùng một dòng không liên tục gồm ô A3, C3 và khối 

E3:G3 thì sử dụng công thức nào sau đây: 

a. =SUM(A3,C3,E3:G3) b. =A3+C3+E3..G3  c. =SUM(E3..G3) 

Câu 31: Với ĐTB cuối năm là 6.5, Lê Hoàng Yến sẽ đạt xếp loại gì khi biết công thức xếp loại 

học tập IF(ĐTB<5, “Yếu”, IF(ĐTB<6.5, “TB”, IF(ĐTB<8, “Khá”, “Giỏi”)))? 

a. Giỏi   b. Yếu   c. TB  d. Khá 

Câu 32: Tại ô A1 chứa giá trị là 12, B2 chứa giá trị 28. Tại ô C2 có công thức 

AVERAGE(A1:B2) thì kết quả tại ô C2 là: 

a. 30   b. 20   c. 40    d. 50 

Câu 33: Giả sử tại ô D2 có công thức = B2*C2/100. Nếu sao chép công thức này đến ô G6 sẽ có 

công thức là: 

a. =E2*C2/100  b. =E6*F6/100 c. =B2*C2/100 d. =B6*C6/100 

Câu 34: Ký tự phân cách giữa các đối số của hàm (List Seperator) là: 

a. Dấu phẩy (,) 

b. Dấu chấm (.) 

c. Dấu chấm phẩy (;) 

d. Tùy thuộc vào cách thiết lập cấu hình trong Control Panel 

Câu 35: Tại ô B3 có công thức =D2+SUMIF($C$2:$C$6, A5, $E$2:$E$6)-C$3 khi sao chép 

công thức này đến ô D5 thì có công thức nhƣ thế nào? 

a. =F4+SUMIF($C$2:$C$6, E7, $E$2:$E$6)-E$3 

b. =F5+SUMIF($C$2:$C$6, C7, $E$2:$E$6)-E$3 

c. =F4+SUMIF($C$2:$C$6, C7, $E$2:$E$6)-E$3 

d. =F4+SUMIF($C$2:$C$6, C7, $E$2:$E$6)-D$5 

Câu 36: Kết quả của biểu thức =ROUND(1200200,-3) sẽ là 

a. False   b.1201000   c. #VALUE   d. 1200000 

Câu 37: Công thức nào dƣới đây là đúng 

a. =SUM(A1),SUM(A7) 

b. =SUM(A1):SUM(A7)  

c. =SUM(A1-A7)  

d. =SUM(A1:A7) 

Câu 38: Biểu thức =IF(2>3,”Sai”) cho kết quả là: 

a. False  b. “Dung”  c. True  d. “Sai” 

Câu 39: Cho trƣớc cột “Điểm trung bình” có địa chỉ E1:E10. Để đểm số học sinh có điểm 

trung bình từ 7 trở lên thì sử dụng công thức nào sau đây: 

a. =COUNT(E1:E10)    b. =COUNTIF(E1:E10,>=7) 

c. =COUNTA(E1:E10,9)   d. =COUNTIF(E1:E10,”>=7”) 

Câu 40: Chọn phát biểu đúng: 

a. Trong Excel, các cột được đánh số thứ tự từ 1 đến 65536. 

b. Một tập tin Excel còn được gọi là một Worksheet. 

c. Trong Excel, có thể chọn (quét khối) các vùng không liên tục. 

d. Không có đáp án nào đúng.  
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PHẦN IV. CÔNG CỤ TRÌNH CHIẾU  

MICROSOFT POWERPOINT 

 

BÀI 1. LÀM QUEN VỚI GIAO DIỆN POWERPOINT 

 

I. LÀM VIỆC VỚI CÁC TẬP TIN 

1.1. Tạo mới một tập tin: 

- Chọn File / New (Ctrl+N) hoặc clik vào biểu tượng  trên thanh công cụ 

- Chọn mẫu trình bày trong cửa sổ Slide Layout, lớp Text Layouts 

 
 Mỗi một trang trong Powerpoint được gọi là một Slide. 

1. 2. Mở một tập tin đã có sẵn: 

- Chọn File / Open (Ctrl+O) hoặc clik vào biểu tượng  trên thanh công cụ  

- Trong cửa sổ Open, chọn tên ổ đĩa và thư mục chứa tập tin cần mở trong khung Lookin, sau 

đó chọn tập tin cần mở và click nút Open (hoặc double click tập tin cần mở) 

Chú ý: Tập tin Powerpoint có dạng .ppt hoặc pps … 
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1.2. Lƣu một tập tin:  

- Chọn File / Save (Ctrl+S) hoặc click vào biểu tượng  trên thanh công cụ  

- Trong cửa sổ Save as, chọn ổ đĩa và thư mục muốn lưu tập tin trong khung Save in, nhập tên 

tập tin trong File name. Click nút Save để bắt đầu lưu. 

 

 
 

II. QUẢN LÝ CÁC SLIDE: 

2.1. Tạo thêm Slide: 

-  Chọn Insert / New Slide, Hoặc nhấn tổ hợp phím Ctrl + M. 

Chỉ định ổ đĩa và thư 

mục chứa tập tin 

Chọn tập tin 

cần mở 

Chọn ổ đĩa và thư  

mục cần lưu tập tin 

Đặt tên cho 

tập tin 
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- Vị trí slide vừa tạo được sẽ đứng sau Slide hiện hành, do đó để chèn thêm một Slide mới giữa 

các Slide đã có, nên click chọn Slide đứng trước vị trí muốn chèn thì Slide mới sẽ có vị trí ngay sau 

đó. 

2.2. Thay đổi vị trí của các Slide: 

Trong màn hình Slide show, chọn slide muốn thay đổi vị trí click giữ nguyên và kéo đến vị 

trí mới, khi đó các slide khác sẽ tự động thay đổi lại số thứ tự. 

2.3. Thay đổi vị trí của các Slide: 

Click chọn slide muốn xóa và gõ phím Delete (hoặc right click tại slide muốn xoá chọn Cut 

hoặc Edit/Cut)  

2.4. Sao chép các Slide: 

- Click chuột phải tại Slide muốn sao chép và chọn Copy hoặc từ menu Edit / Copy (Ctrl+C) 

-  Click chọn slide đứng trước vị trí muốn sao chép đến (có thể đến một tập tin Powerpoint khác 

cũng được), click chuột phải và chọn Paste hoặc từ menu Edit / Paste (Ctrl+V) 

 

 

BÀI 2. THIẾT KẾ, TRÌNH BÀY NỘI DUNG VỚI POWERPOINT 

 

I. CHỌN MÀU NỀN: 

1.1. Chọn mẫu Template (Mẫu màu nền): 

- Chọn Format / Slide Design  

 

 

- Cửa sổ  Slide Design hiển thị, chọn mục Design 

Templates 
 

 

 

1. 2. Chọn màu cho Template: 

- Trong cửa sổ  Slide Design chọn mục Color Shemes 

 
 

Ngoài ra bạn có thể click chọn Edit Color Schemes hộp thoại  
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1. 3. Chọn màu nền cho Template: 

- Vào Format \ Background  

 
Hộp Background hiển thị  

 
 

Trong khung này có hai mục chọn là: 

- More Colors… Mở bảng màu chuẩn và chọn màu tuỳ ý 

Nhấn Apply để 

chấp nhận sự 

thay đổi 
Lựa chọn mục 

muốn đổi màu 

Click mở bảng 

màu tự chọn 

Click chọn mở 

khung màu 
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- Fill Effects… Các dạng màu hiệu ứng gồm các lớp: 

+ Gradient : Các dạng pha màu 

+ Texture : Mẫu màu nền Texture 

+ Pattern : Dạng mẫu Pattern 

+ Picture : Lấy ảnh có sẵn làm màu nền  

1.4. Hiệu ứng cho Schemes: 

- Trong cửa sổ  Slide Design chọn mục Animation Schemes 

 

 
 

II. NHẬP VĂN BẢN: 

- Để nhập văn bản vào PowerPoint 2003, Bạn Click vào biểu tượng Text Box  hay chọn 

Insert / Text Box sau đó bạn Click và kéo chuột tạo thành một khung  

 

 
 

Để nhập văn bản vào khung, bạn Click chuột phải vào khung và chọn Edit Text 

Chọn kiểu hiệu ứng 

cho Schemes 

 Click Chọn hiệu ứng bạn muốn thay đổi 

 Click Play để xem lặp lại hiệu ứng bạn chọn 

 Click Slide Show để xem trước, nếu vừa ý nhấn  

Apply to All Slides để chọn tất cả các Slide. 
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Bạn có thể nhập dòng văn bản vào trong hộp Text Box bình thường như ở Word. Bạn có thể 

tạo ra nhiều Text Box như vậy cho nhiều đoạn dòng văn bản. 

 

III. HIỆU CHỈNH VĂN BẢN: 

 

3.1. Hiệu chỉnh định dạng chữ: 

- Vào Format \ Font.  

 

 

 

 

 

 

Hộp thoại Font hiển thị:  

 

 
+ Font : Chọn các loại font chữ   + Underline : Gạch dưới chữ. 

+ Font style : Chọn dạng chữ  + Shadow : Tạo bóng mờ cho chữ. 

+ Size : Chọn cỡ chữ   + Emboss : Tạo chữ nổi. 

+ Color : Chọn màu chữ 
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3.2. Tạo Bullets và Numbering: 

- Vào Format \ Bullets and 

Numbering.  

 

 

 

 

Hộp thoại Bullets and Numbering hiển thị: 

 

 

+ Color : Màu hiển thị  

+ Picture : Chọn hình ảnh mà PowerPoint 

đưa ra sẵn để thay thế cho định dạng đang 

chọn 

+ Customize : Chọn thay đổi định dạng 

theo ý bạn trong Symbol 

 

3.3. Canh đầu dòng: 

- Vào Format \ Alignment.  

+ Align Left : Canh đều bên trái   

+ Align Right : Canh đều bên phải  

+ Center : Canh đều ở giữa 

+ Justify : Canh đều hai bên  

 

 

3. 4. Khoảng cách giữa các dòng: 

- Vào Format \ Line Spacing  
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Hộp thoại Line Spacing hiển thị: 
Line Spacing : Khoảng cách giữa các dòng 

Before Paragraph : Khoảng cách phía trên đoạn văn bản 

After paragraph : Khoảng cách phía dưới đoạn văn bản 

 

3. 5. Đổi dạng chữ: 

- Vào Format \ Change Case  
Sentence case : Viết hoa đầu 

câu 

Lowercase : Viết thường 

UPPERCASE : Viết hoa 

Title Case  : Viết hoa đều chữ 

tOGGLE cASE : Viết thường 

đầu chữ 

  

 

 

 

Hộp thoại Change Case hiển thị: 

 

3. 6. Tô màu: 

Giống như Word, bạn có thể click mở các của sổ chọn màu cho Text Box bằng các biểu 

tượng trên thanh công cụ vẽ (Nếu không tìm thấy hiển thị thanh công cụ vẽ, bạn có thể chọn từ 

View \ Toolbars \ Drawing) 

 

 
 

 Font Color : Chọn màu chữ 

 Line Color : Chọn màu đường viền cho Text Box 

 Fill Color : Chọn màu nền cho Text Box 

 

IV. CÁC CÔNG CỤ VẼ: 

Các công cụ vẽ trong PowerPoint cũng giống như trong Word. Thanh công cụ vẽ Drawing 

thường hiển thị ở phía dưới màn hình. (Nếu thanh công cụ bị ẩn thì vào View \ Toolbar \ Drawing) 
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4.1. Vẽ đƣờng thẳng, hình chữ nhật, hình tròn: 

Click biểu tượng cần vẽ trên thanh công cụ Drawing 

      

        
 

+ Line : Đường thẳng 

+ Rectangle : Hình chữ nhật  

+ Ovan: Đường tròn   

 - Đưa con trỏ đến vị trí cần vẽ trong Slide, click & drag để vẽ 

         - Trước khi vẽ nếu ấn Shift bạn chỉ vẽ được đường thẳng, hình vuông hoặc hình tròn tuỳ theo 

biểu tượng mà bạn đã chọn. Nếu nhấn và giữ phím Ctrl thì tâm của đối tượng sẽ ở ngay vị trí bắt đầu 

vẽ. 

        - Trong trường hợp muốn vẽ nhiều đối tượng liên tiếp, thay vì Click để chọn biểu tượng vẽ, bạn 

cần double click và sau đó vẽ bình thường cho đến khi hoàn thành, double click tại điểm vẽ để kết 

thúc. 

4. 2. Sử dụng các hình mẫu: 

Trong mục AutoShapes trên thanh có rất nhiều 

hình mẫu, click vào hình mẫu mà bạn muốn chọn, 

click & drag trên màn hình thiết kế để vẽ. 

  

 

 

 
 

4.3. Thay đổi nét vẽ: 

         Click chọn đối tượng muốn thay đổi và chọn các biểu tượng sau trên thanh công cụ Drawing 

         + Line Style : Mở bản chọn độ lớn nét vẽ 

 + Dash Style : Mở bản chọn kiểu nét vẽ  

      + Arrow Style: Chọn đầu nét vẽ (hình mũi tên….) 

      + Shadow: Tạo bóng cho nét vẽ   

         + 3D: Tạo hình nổi 3 chiều 

4.4. Tạo màu cho đối tƣợng: 

Màu xanh dùng để  
 

xoay đối tƣợng vẽ 

Màu vàng dùng để 

hiệu chỉnh hình dạng 

Màu trắng dùng để 

thay đổi kích thƣớc 
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           Chọn đối tượng muốn tô màu, sau đó Click vào hình mũi tên trên các đối tượng tô màu  trên 

thanh công cụ Drawing 

  + Line Color : Tô màu viền 

+ Fill Color : Tô màu nền 

 
          Khi mở bảng màu, nếu muốn có thêm màu để lựa chọn, bạn click mục More line Color... 

 

V. SỬ DỤNG WORDART: 

         Sử dụng Word Art trong Powerpoint cũng giống như trong Word. Chọn biểu tượng Word 

Art trên thanh công cụ vẽ Drawing (Nếu thanh công cụ bị ẩn thì vào View \ Toolbar \ Drawing) 

 

 
 

 
 

           Trong cửa sổ WordArt Gallery , Bạn chọn dạng WordArt muốn tạo và ấn OK. Hộp thoại 

Edit WordArt Text hiển thị bạn nhập dòng chữ và nhấn OK để chọn 

 



78 

 

 
             

            - Cũng tương tự như các đối tượng vẽ, mỗi đối tượng của WordArt đều có các nút hiệu 

chỉnh đối tượng, bạn Click & drag nút này để hiệu chỉnh hình dạng của đối tượng WordArt 

 - Trên màn hình thiết kế của Powerpoint 2003 khi bạn muốn hiệu chỉnh một đối tượng 

WordArt, bạn cần chọn đối tượng và lúc này sẽ hiện thị thanh WordArt với các biểu tượng sau: 

(Nếu không thấy hiển thị thanh WordArt, bạn cần Click chuột phải trên đối tượng và chọn Show 

WordArt Toolbar). 

 

 
 

 

+ 1: Chèn thêm WordArt      + 6: Xoay WordArt (click & drag để xoay) 

+ 2: Sửa nội dung       + 7: Đổi dạng chữ chữ thường thành chữ hoa và ngược lại 

+ 3: Chọn lại WordArt      + 8: Đổi chữ hàng ngang thành hàng dọc và ngược lại  

+ 4: Định dạng WordArt      + 9: Hiệu chỉnh dạng WordArt 

+ 5: Chọn kiểu hiệu ứng 

 

VI. CHÈN HÌNH ẢNH, PHIM, ÂM THANH: 

6.1. Chèn Clip Art: 

         Vào Insert \ Picture \ Clip Art… 

  

1           2    3   4   5    6   7   8   9 
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 Hộp thoại Sports – Microsoft Clip Organizer hiển thị, bạn chọn hình cần chèn và click right 

chọn Copy  

 

           Trở lại 

Slide và click 

right chọn 

Paste 
 

 

 

6.2. Chèn tập 

tin ảnh: 

           Vào 

Insert \ 

Picture \ From File… 

  

 

           

 

Hộp thoại Insert Picture hiển thị, 

bạn chọn hình cần chèn và ấn nút Insert để 

chèn 
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6.3. Chèn sơ đồ tổ chức: 

         Vào Insert \ Picture \ Organization Chat 
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Để  thay đổi cấu trúc sơ đồ, bạn right click chuột vào khung sơ đồ và chọn Layout sẽ hiển 

thị các dạng sơ đồ cho bạn chọn. 

 
6.4. Chèn phim, chèn âm thanh: 

        Vào Insert \ Muvies and Sounds\  … 

 

 
 

+ Movie from Clip Organizer…: Chèn phim từ thư viện của chương trình Microsofr Office 

2003 

+ Movie from File…: Chèn tập tin dạng .avi tự chọn 

+ Sound from Clip Organizer…: Chèn tập tin sound từ thư viện Microsofr Office 2003 

+ Sound from File…: Chèn tập tin âm thanh tự do  

+ Play CD Audio Track …: Chèn âm thanh từ đĩa Audio CD (Muốn chèn bạn cho đĩa 

Audio CD vào ổ CD ROM) 

+ Record Sound: Ghi âm thanh để chèn vào, có thể là lời thuyết minh của bạn.  
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VII. THIẾT LẬP BIỂU ĐỒ : 

Việc chèn biểu đồ vào Powerpoint cũng giống như trong Word hoặc Excel. Một số bước 

chính như sau: 

 Vào Insert \ Chart… 

 

 

* Trên màn hình Powerpoint sẽ hiện: 

 

 
 

 Chọn dạng biểu đồ: Vào Chat \ Chat Type… 

 
 

Chú ý: Nếu khung Datasheet ẩn đi, bạn sẽ không thấy trình đơn Chat, để hiện lại khung 

Datasheet bạn right click chuột lên khung biểu đồ và chọn Chart Object / Edit 

 

Khung nhập 

số liệu, tƣơng 

tự nhƣ trong 

Excel 
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Sẽ hiển thị hộp thoại Chat Type, bạn chọn các mẫu biểu đồ có sẵn trong lớp Standard 

Types Click OK nếu chấp nhận biểu đồ đó. 

 

 
 Nhập tiêu đề cho biểu đồ: 

        Trong trình đơn Chart / Chart Options… 

 
         Sẽ hiển thị hộp thoại Chart Options 
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+ Bạn chọn lớp Titles 

+ Bạn tiêu đề trong mục Chart Title 

+ Quy định tên cho các cột X, Y, Z 

 Nhập tiêu đề cho biểu đồ: 

          Vào Format / Font, chọn lại kiểu chữ, cỡ chữ và màu sắc và nhấn OK 

Chú ý: 

 + Khi muốn chọn Font cho cả biểu đồ, bạn phảI click chọn biểu đồ. 

 + Muốn chọn Font, màu cho đối tượng nào trong biểu đồ, cần click chọn đối tượng đó rồi 

chọn lại Font, màu bình thường. 

 + Khi hiệu chỉnh biểu đồ xong, click vào vị trí trống trên màn hình thiết kế để kết thúc, bảng 

Datasheet sẽ ẩn đi và màn hình thiết kế trở lại bình thường. Khi muốn hiệu chỉnh lại, double click 

vào biểu đồ để chuyển sang chế độ hiệu chỉnh. 

 

VIII. QUẢN LÝ CÁC ĐỐI TƢỢNG: 

8.1. Chọn đối tƣợng: 

            Click vào đối tượng, muốn chọn nhiều đối tượng cùng một lúc, nhấn và giữ phím Shift sau 

đó click vào các đối tượng cần chọn. Nếu đối tượng nào là dạng chữ bạn cần click vào đường viền 

Text box để chọn. 

8.2. Tạo nhóm: 

 Sau khi chọn nhóm các đối tượng cần tạo nhóm sau, bạn cần click chuột phải lên một đối 

tượng nào đó, sẽ hiển thị một menu bạn chọn Grouping / Group. Để bỏ nhóm, cũng tương tự như 

vậy bạn chọn Ungroup và lấy lại nhóm ban đầu sau khi đã bỏ bạn chọn Regroup 
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8.3. Sắp xếp các đối tƣợng: 

 Trên một trang thiết kế có rất nhiều các đối tượng. Ở chế độ mặc định, đối tượng nào được tạo 

ra sau sẽ nằm trên các đối tượng đã được tạo ra trước và có thể che khuất các đối tượng khác, để sắp 

xếp lại vị trí các đối tượng cần thực hiện như sau: 

 + Chọn đối tượng 

 + Click chuột phải lên đối tượng, 

chọn Order 

+ Bring to Font : Đưa đối tượng 

lên phía trên  

+ Send to Back: Đẩy đối tượng 

xuống sau cùng 

+ Bring Forward: Đưa đối tượng 

lên một vị trí 

+ Send Backward: Đưa đối tượng 

xuống một vị trí. 

8.4. Sao chép các đối tƣợng: 

 Chọn đối tượng và: 

+ Nhấn Ctrl + C (Edit \ Copy) để 

copy đối tượng 

+ Nhấn Ctrl + V (Edit \ Paste) để 

dán đối tượng 

+ Nhấn Ctrl + D để tự copy và 

dán đối tượng 

+ Chọn đối tượng và nhấn phím 

Delete để xoá đối tượng. 
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BÀI 3. THIẾT LẬP CÁC HIỆU ỨNG 

 

I. THIẾT LẬP HIỆU ỨNG 

1.1. Mở của sổ Custom Animation...: 

- Chọn Slide Show / Custom Animation… 

 

 
 

Lúc đó trên màn hình sẽ hiển thị như sau: Bên trái là màn hình thiết kế, bên phảI là cửa sổ 

Custom Animation 

 

 
- Bạn chọn đối tượng cần hiệu ứng trên màn hình thiết kế. 

- Click chọn Add Effect trên cửa sổ Custom Animation sẽ hiển thị tất cả các hiệu ứng, ngoài 

ra bạn có thể chọn More Effects… để tạo ra các hiệu ứng khác nhiều hơn do Power tạo sẵn. 

- Lần lượt như vậy, chọn từng đối tượng và tạo hiệu ứng. 

1.2. Xác định hoạt động hiệu ứng: 

- Xác định hiệu ứng hoạt động như sau: Click vào nút mũi tên phải của mục Start bạn sẽ có ba 

sự lựa chọn. 
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+ On click : Đối tượng được tạo hiệu ứng sẽ lần lượt hiển thị sau mỗi click chuột của bạn lúc 

trình diễn. 

+ With Previous: Đối tượng sẽ tự động hiển thị trình diễn 

+ After Previous: Đối tượng này sẽ hiển thị sau cùng khi các đối tượng khác đã trình diễn 

- Xác định tốc độ hiệu ứng hiển thị: Click vào nút mũi tên phải của mục Speed, Powerpoint sẽ 

cho bạn các lựa chọn tốc độ hiển thị  

 

 
 

1.3. Bỏ hiệu ứng cho đối tƣợng: 

- Click chọn đối tượng và nhấn vào nút Remove trên cửa sổ Custom Animation và cuối cùng 

là bạn nhấn F5 để xem Powerpoint 2003 trình diễn 

 

II. PHIM VÀ ÂM THANH: 

 

- Khi bạn chèn một tập tin hoặc âm thanh vào trong Slide, mặc nhiên các đối tượng này đã được 

thiết lập các thông số để hoạt động, tuy nhin bạn có thể kiểm soát từng chi tiết của các đối tượng 

này. 

- Trong màn hình thiết kế, bạn chọn đối tượng tập phim và Clich chuột phải lên đối tượng. 

Chọn Edit Movie Object  
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 Hộp thoại Movie Options hiển thị sẽ chọn các thông số lựa chọn: 

 

 
 

+ Loop until stopped: Trình chiếu liên tục  

+ Rewind movie when done playing: Tự động trình chiếư 

+ Hide while not playing: ẩn trong lúc không trình chiếu 

+ Zoom to full screen: Phóng to toàn màn hình 

Chú ý: Bạn nên thiết lập thời gian trình ciếu của trang lớn hơn thời gian của phim để tránh 

hiện tượng lật sang trang khác khi đang trình chiếu phim. (Bạn xem trong mục Thiết Lập Trình 

Diến để biết thiết lập thời gian của một trang) 
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III. CHÈN NÚT ĐIỀU KHIỂN: 

- Vào Slide Show / Action Button /… 

 
- Bạn chọn một Button sẽ hiển thị hộp thoại Action Settíng 

 
 

Đưa ra cho bạn hai lớp để chọn biến cố: 

+ Mouse Click: Biến cố Click chuột  

+ Mouse Over: Biến cố đưa trỏ chuột đến 

Trong khung Action on click Có các lệnh sau: 

* Hyperlink to: (Liên kết đến)  

+ Next Slide: Đến trang sau 

+ Previous Slide: Về trang trước  

+ First Slide: Về trang đầu  

+ Last Slide:  Đến trang cuối cùng  

+ End show: Kết thúc trình chiếu 

       * Run Program: (Chạy chương trình khác) 
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         Nhập đường dẫn và tệp tin chạy chương trình hoặc Click nút Browse để tìm và chọn tập tin  

* Object Action: Bạn tuỳ chọn loại đối tượng nào thì sẽ có các lện khác nhau cho đối tượng 

đó 

* Play Sount: Click mở khung để chọn loại âm thanh 

 

IV. THIẾT LẬP TRÌNH DIỄN: 

 Trước khi trình chiếu, bạn cần thiết lập chế độ chuyển đồi từ trang này sang trang khác và các 

dạng kiểm soát trình chiếu như sau: 

4.1. Chuyển đổi giữa các trang: 

 Vào Slide Show / Slide Transition… 

 

 

 

             

 

 

 Cửa sổ Slide Transition hiển 

thị 

Chọn hiệu ứng chuyển đổi 

trong khung của mục chọn Apply 

to selected slide 

Chọn tốc độ hiệu ứng 

chuyển trang (Speed ) và âm thanh 

chuyển trang (Sound) trong mục 

Modify transition 
Lựa chọn click chuột bất kỳ 

trên trang để chuyển sang trang 

khác (On mouse click) hoặc xác 

lập thời gian chuyển trang 

(Automatically after) trong mục 

chọn Advance slide 

 

4.2. Thiết lập trình chiếu: 

 Vào Slide Show / Set Up Show … 

 

      

 Hộp thoại Set Up Show hiển thị sẽ cho bạn các thông số lựa chọn 
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* Show type: 

 + Presented by a speaker (full screen): Trình chiếu đầy màn hình 

 + Loop continuously until „ESC‟: Lặp lại liên tục cho đến khi nhấn phím ESC + Show 

without animation: Không trình chiếu hiệu ứng 

 +… 

Tuỳ từng mục bạn thiết lập sẽ có các lựa chọn khác nhau 

* Show slides: 

 + All: Trình chiếu lần lượt tất cả các trang 

 + From… to …: Trình chiếu từ trang ….đến trang … 

* Advance slide: 

 + Manually: Không chuyển đổi trang theo thời gian đã xác lập, chuyển đổi bằng trình đơn. Ở 

chế độ này sau khi trình chiếu xong, các hiệu ứng của các đối tượng trong trang hiện hành màn hình 

sẽ dừng lại và hiển thị một trình đơn điều khiển bên góc trái để bạn điều khiển.  

           + Using timings, If present: Trình chiếu với thời gian đã được thiết lập 

 

 

BÀI 4. LƢU VÀ ĐÓNG GÓI TẬP TIN 

 

I. CHUẨN BỊ VÀ TRÌNH DIỄN 

1.1. Mở của sổ Custom Animation...: 

           Khi thiết kế xong, để tiện sử dụng việc trình diễn bạn nên lưu tập tin thành dạng Powerpoint 

Show như sau: 

- Chọn File / Save As 

- Hộp thoại  Save As hiển thị, trong hộp thoại Save As bạn chọn PowerPoint Show trong 

khung chọn Save as type. Bạn nhập tên và nhấn nút Save đẻ lưu lại. 
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- Tập tin dạng .pps chính là tập tin bạn dùng để trình diễn, vì khi chạy tập tin này bạn không 

cần mở lại Powerpoint. 

- Nhấn phóm ESC để thoát khi chạy tập tin dạng .pps và chương trình sẽ thoát trở lại Windows 

chứ không phải trở lại Powerpoint. 

- Để đưa chương trình đi trình diễn ở máy khác, bạn chỉ cần chép theo tập tin .pps (máy tính 

trình diễn cần phải có chương tình Microsoft Powerpoint, nếu không bạn phải đóng gói tập tin) 

 

II. ĐÓNG GÓI TẬP TIN: 

2.1. Đóng gói tập tin: 

- Khi chạy tập tin Powerpoint dạng .ppt hay .pps thì trong máy tính phải có sẵn chương trình 

Powerpoint. Khi đóng gói tập tin, chương trình sẽ tự động ghép thêm các tập tin hệ thống giúp bạn 

có thể trình diễn ở bất cứ máy tính nào có hệ điều hành mà không cần cài sẵn Microsoft Powerpoint. 

- Ngoài việc đóng gói các tập tin sẽ giúp bạn thu nhỏ tập tin để dễ dàng sao chép đến các máy 

khác. 

Lưu ý: Nếu máy tính mà bạn dự định sử dụng để trình diễn đã có sẵn Microsoft Powerpoint 

thì bạn có thể chỉ cần chép tập tin dạng .pps theo là đủ. Khi muốn đóng gói tập tin Powerpoint show 

nào, bạn dùng Microsoft Powerpoint mở tập tin đó ra và thực hiện như sau: 

- Chọn File / Pack and Go … 

 

III. CHUYỂN THÀNH DẠNG WEB: 
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Để dể dàng chuyển tải những trang trình diễn của Powerpoint lên Internet bạn sẽ chuyển các 

trang này thành dạng trang web (dạng .html) 

Trước khi quyết định chuyển tập tin thành dạng Web bạn có thể xem các Slide dưới dạng Web 

bằng cách chọn File / Web Page Review.  

 

3.1. Chuyển tập 

tin thành dạng 

Web: 

* Vào File /  

Save as Web 

Page… 

 

 

            Hộp thoại 

Save As hiển thị, 

bạn chọn mục Web 

Page và click Save 

để tạo và lưu thành 

trang Web. 

 

 

 

 

3.2. Sử dụng tập tin .html 

- Tập tin dạng .html 

thông thường được mở 

bằng các phần mềm trình 

duyệt Web như Internet 

Explorer… 

- Bạn có thể mở tập 

tin này bằng cách click vào 

tập tin trong cửa sổ 

Windows Explorer, hoặc từ 

các phần mềm trình duyệt 

Web bình thường. Các thao 

tác trang giống như các 

trang web bình thường. 
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BÀI TẬP 

 

1. Bấm chuột phải tại một đối tƣợng trong PowerPoint có nghĩa là :  
a. Xoá đối tượng.   

b. Mở menu tắt  liệt kê các lệnh có thể thực 

hiện.  

c. C. Chọn đối tượng  

d. D. Không làm gì.  

2. Đang trình chiếu một bài trình diễn, muốn dừng trình diễn ta nhấn phím 

A. Tab   B. Esc   C. Home   D. End 

3. Để định dạng dòng chữ “Giáo án điện tử” thành “Giáo án điện tử” (kiểu chữ đậm, nghiêng, 

gạch dƣới), toàn bộ các thao tác phải thực hiện là 

A. đưa con trỏ văn bản vào giữa dòng chữ đó, nhấn Ctrl + U, Ctrl + I và Ctrl + B  

B. đưa con trỏ văn bản vào giữa dòng chữ đó, nhấn Ctrl + B, Ctrl + U và Ctrl + I 

C. chọn dòng chữ đó, nhấn Ctrl + U, Ctrl + I và Ctrl + B 

D. nhấn Ctrl + U, Ctrl + I và  Ctrl + B 

4. Để tạo một slide giống hệt nhƣ slide hiện hành mà không phải thiết kế lại, ngƣời sử dụng 

A. chọn Insert -> Duplicate   B. chọn Insert -> New Slide 

C. chọn Insert -> Duplicate Slide  D. không thực hiện được 

5. Để tô màu nền cho một slide trong bài trình diễn ta thực hiện 

A. chọn View ->  Background  B. chọn Format ->  Background 

C. chọn Insert ->  Background  D. chọn Slide Show ->  Background 

6. Thực hiện thao tác chọn Slide Show -> Custom Animation là để 

A. tạo hiệu ứng cho một đối tƣợng trong slide 

B. tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  

C. đưa hình ảnh hoặc âm thanh vào bài trình diễn 

D. định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 

7. Thực hiện thao tác chọn Slide Show -> Side Transition là để 
A. tạo hiệu ứng cho một đối tượng trong slide 

B. tạo hiệu ứng chuyển trang cho các slide trong bài trình diễn  

C. đưa hình ảnh hoặc âm thanh vào bài trình diễn 

D. định dạng cách bố trí các khối văn bản, hình ảnh, đồ thị ... cho một slide 

8.  PowerPoint cho phép ngƣời sử dụng thiết kế một slide chủ chứa các định dạng chung của 

toàn bộ các slide trong bài trình diễn. Để thực hiện điều này, ngƣời dùng phải 

A. chọn Insert -> Master Slide 

B. chọn Insert -> Slide Master  

C. chọn View -> Master -> Slide Master 

D. chọn View -> Slide Master -> Master 

9. Chọn câu sai trong các câu sau 

Trong khi thiết kế giáo án điện tử bằng PowerPoint,  

A. không thể tạo chỉ số trên (ví dụ số 2 trong X2) nhƣ trong MS-Word 

B. có thể sao chép (copy/paste) một đoạn văn bản từ tập tin Word sang   

C. có thể dùng WordArt để tạo chữ nghệ thuật trang trí trong powerpoint 

D. có thể chèn các biểu đồ vào powerpoint 

10.  Khi đang trình chiếu (Slide Show) một bài trình diễn, muốn chuyển sang màn hình của 

một  chƣơng trình ứng dụng khác (đã mở trƣớc) để minh họa mà không kết thúc việc trình 

chiếu, ta phải 

A. nhấn tổ hợp phím Ctrl + Tab 

B. nhấn tổ hợp phím Shift + Tab 

C. nhấn tổ hợp phím Alt + Tab  
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D. nhấn tổ hợp phím Esc + Tab 

11.  Để các slide đều có tên của mình khi trình chiếu ta vào chọn? (sau đó gõ vào Footer) 
A.  Chọn View -> Chọn Header and Footer B.  Chọn View -> Chọn Footer and Header 

C.  Chọn Insert -> Chọn Header D.  Chọn Insert -> Footer 

 

12. Cách nào sau đây không phải là cách tạo ra một bản trình diễn mới (Presentation)?  
A. Tạo một bản trình diễn trắng.  

B. Dùng template  

C. Dùng chức năng Scan-In Slides.   

D. Dùng chức năng  AutoContent Wizard.  

13. Chế độ view nào sau đây không phải của PowerPoint?  
A. Normal View  

B. Presentation View  

C. Slide Show View  

D. Outline View  

14. Kỹ thuật nào sau đây không phải để di chuyển xung quanh một bản trình diễn?  
A. Nhấn <Ctrl> + <Home> để di chuyển về slide đầu tiên.  

B. Nhấn <Page Down> để di chuyển  đến slide kế tiếp.  

C. Chọn Edit → Move từ menu và chỉ định slide bạn muốn tới.  

D. Dùng thanh cuộn đứng để di chuyển lên hoặc xuống.  

15. Để lƣu một bản trình diễn: (Có thể chọn nhiều câu trả lời.)  
A. Nhấn <Ctrl> +<F5>.  

B. Chọn File → Save từ menu.  

C. Bấm nút Save trên thanh công cụ chuẩn.  

D. Bấm Save trên nút Windows Start .  

16. Chế độ view tốt nhất để duyệt qua một bản trình diễn?  
A. Normal View  

B. Slide Sorter view  

C. Outline view  

D. Notes view  

17. Câu nào sau đây là không đúng?  
A. Nhấn phím <Tab> trong Outline view  sẽ giáng cấp các đoạn .  

B. Nhấn <Ctrl> + <Enter> trong Outline view  sẽ thêm một slide mới cho đoạn.  

C. Nhấn phím <Shift> + <Tab> trong Outline view sẽ nâng cấp các đoạn.  

D. Outline view là chế độ xem tốt nhất để thêm và làm việc với đồ họa .  

18. Phím nào xoá văn bản trƣờc con trỏ?  
A. <Page Up>  

B. <Page Down>  

C. <Delete>  

D. <Backspace>  

19. Câu nào sau đây là không đúng?  
A. WordArt là 1 chương trình độc lập và có thể dùng với bất kỳ  chương trình Microsoft Office 

nào, như Word hoặc Excel.  

B. WordArt có thanh công cụ riêng gồm những nút để thay đổi shape, angle, và color của đối 

tượng WordArt .  

C. Bạn có thể thay đổi  color hoặc texture của  đối tượng WordArt  bằng cách bấm Format  

E. WordArt trên thanh công cụ WordArt , bấm thẻ Colors và Lines , và chọn màu từ danh sách 

Fill Color .  

D. Bạn có thể cho chuyển động đối tượng WordArt   

20. Giả sử ta cần đƣa vào trong tài liệu nhiều hình ảnh minh họa. Khi tiếp tục hiệu chỉnh và 

dàn trang, các hình đó khó giữ đƣợc các vị trí tƣơng đối ban đầu. Giải pháp nào sau đây giúp 
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ta xử lý tình huống trên?  
A. Xóa hình và chèn hình lại khi định dạng trang bị thay đổi.  

B. Chọn tất cả các hình, bấm nút phải và chọn lệnh Group.  

C. Chọn Edit -> Select pictures từ menu mỗi khi di chuyển và làm việc  với nhiều hình.  

D. Không phải các cách trên.  

21. Một số AutoShapes có hình thoi màu vàng. Hình thoi đó là gì và có tác dụng ra sao?  
A. Đó là nút kích cỡ, dùng để thay đổi kích thước của đối tượng AutoShapes.  

B. Đó là nút di chuyển, dùng để kéo đối tượng AutoShape tới một vị trí khác.  

C. Đó là nút điều chỉnh, dùng để thay đổi hình dạng của đối tượng AutoShapes.   

D. Không phải ba tác dụng trên.  

22. Phím nào dùng thuận tiện nhất để nhập liệu và di chuyển trong một table?  
A. <Tab> để di chuyển to  ô kế tiếp, <Shift> + <Tab> để  di chuyển ngược lại.  

B. <Enter> để di chuyển to  ô kế tiếp, <Shift> + <Enter> để  di chuyển ngược lại.  

C. <→> để di chuyển to  ô kế tiếp, <Shift> + <←> để  di chuyển ngược lại.  

D. Không phải các cách trên.  

23. Câu nào sau đây là không đúng?  
A. Bạn có thể tạo một slide với table bằng cách bấm nút Insert Slide trên Standard  

A. thanh công cụ và chọn Table layout.  

B. Thanh công cụ Tables và Borders  dùng để làm việc với tables.  

C. Font chữ trong table là cố định và không thể định dạng.  

D. PowerPoint 2002 không còn cần Microsoft Word để tạo và làm việc với table.  

24. Trong chế độ view nào thì ta làm việc tốt nhất với các chuyển cảnh (slide transitions)?  
 A. Normal View  

 B. Slide Show view  

 C. Slide Sorter view  

 D. Notes view  

25. Cách nào sau đây không phải dùng để xoá cột ?  
 A. Chọn cột và nhấn  <Delete> .  

 B. Chọn cột và bấm nút Delete Column trên thanh công cụ định dạng.  

 C. Đặt điểm nháy tại bất cứ đâu trong cột, bấm nút Table trên thanh công cụ  

 A. Tables và Borders và chọn Delete Column từ menu.  

 D. Chọn cột và chọn Table → Delete Column từ menu.  
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PHẦN V. MẠNG MÁY TÍNH VÀ INTERNET 

BÀI 1. MẠNG MÁY TÍNH 

1. Mạng máy tính là gì? 

Hiểu một cách đơn giản, mạng là một tập hợp các máy tính được kết nối theo một phương 

thức nào đó sao cho chúng có thể trao đổi dữ liệu và dùng chung thiết bị. Các máy tính được kết nối 

có thể trong cùng một phòng, một toà nhà, một thành phố hoặc trên phạm vi thế giới. 

 
Việc kết nối các máy tính thành mạng là cần thiết để giải quyết các vấn đề như: 

 Cần sao chép một lượng lớn dữ liệu từ máy này sang máy khác trong thời gian ngắn mà việc 

sao chép bằng đĩa mềm, thiết bị nhớ flash hoặc đĩa CD không đáp ứng được; 

 Nhiều máy tính có thể cùng  

 dùng chung dữ liệu, các thiết bị, phần mềm hoặc tài nguyên đắt tiền như bộ xử lí tốc độ cao, 

đĩa cứng dung lượng lớn, máy in laser màu tốc độ cao,... 

2. Phƣơng tiện và giao thức truyền thông của mạng máy tính 

Để chia sẻ thông tin và sử dụng các dịch vụ mạng, các máy tính trong mạng phải có khả 

năng kết nối vật lí với nhau và tuân thủ các quy tắc truyền thông thống nhất để giao tiếp được với 

nhau. 

a) Phƣơng tiện truyền thông (media) 

Môi trường vật lí được sử dụng để kết nối các máy tính trong mạng gồm hai loại: có dây và 

không dây. 

Kết nối có dây (cable): Cáp truyền thông có thể là cáp xoắn đôi, cáp đồng trục, cáp quang,...  

 
 Máy tính được kết nối bằng cáp mạng 

 

 
Một số thiết bị kết nối máy tính vào mạng 

Mạng máy tính bao gồm ba thành phần: 

 Các máy tính; 

 Các thiết bị mạng đảm bảo kết nối các máy tính với nhau; 

 Phần mềm cho phép thực hiện việc giao tiếp giữa các máy tính. 
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Để tham gia vào mạng, máy tính cần có vỉ mạng được nối với cáp mạng nhờ giắc cắm.  

 
a) Bộ khuếch đại và chuyển tiếp 

 
b) Hub  

c) Bộ chuyển 

mạch 

 
d) Bộ định tuyến 

Một số thiết bị mạng 

Trong mạng còn có thể có các thiết bị thực hiện việc chuyển tiếp các tín hiệu, định hướng, 

khuếch đại tín hiệu,... như:  

Kiểu bố trí các máy tính trong mạng 

Bố trí máy tính trong mạng có thể rất phức tạp nhưng đều là tổ hợp của ba kiểu cơ bản sau: 

đường thẳng, vòng, hình sao.  

   
 a) Kiểu đường thẳng b) Kiểu vòng 

 
c) Kiểu hình sao 

Các kiểu bố trí mạng cơ bản 

Kết nối không dây: Phương tiện truyền thông không dây có thể là sóng rađiô, bức xạ hồng 

ngoại hay truyền thông qua vệ tinh. Mạng không dây có khả năng thực hiện các kết nối ở mọi nơi, 

mọi thời điểm mà không cần sử dụng các thiết bị kết nối cồng kềnh, phức tạp như mạng có dây.  

Để tổ chức một mạng máy tính không dây đơn giản cần có: 

  Điểm truy cập không dây WAP (Wireless Access 

Point) là thiết bị có chức năng kết nối các máy tính trong mạng, 

kết nối mạng không dây với mạng có dây; 

  Mỗi máy tính tham gia mạng không dây đều phải có 

vỉ mạng không dây (Wireless Network Card). 

Người ta thường dùng Bộ định tuyến không dây (Wireless Router), ngoài chức năng như 

WAP nó còn có chức năng định tuyến đường truyền.  

Khi thiết kế mạng, việc lựa chọn dạng kết nối và kiểu bố trí máy tính trong mạng phụ thuộc 

vào điều kiện thực tế, mục đích sử dụng, có thể kể đến các yếu tố như:  
Bộ định tuyến không dây 
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 Số lượng máy tính tham gia mạng; 

 Tốc độ truyền thông trong mạng; 

 Địa điểm lắp đặt mạng; 

 Khả năng tài chính. 

b) Giao thức (Protocol) 

Kết nối vật lí chỉ mới cung cấp môi trường để các máy tính trong mạng có thể truyền thông 

được với nhau. Điều này giống như khi hai người muốn gọi điện thoại cho nhau thì phải có đường 

điện thoại kết nối hai máy điện thoại để họ nói và nghe được giọng nói của nhau. Nhưng để hiểu 

được nhau thì họ phải sử dụng ngôn ngữ chung. Nếu một người chỉ biết tiếng Việt còn người kia chỉ 

biết tiếng Anh thì họ sẽ không hiểu nhau được.  

Tương tự như vậy, để các máy tính trong mạng giao tiếp được với nhau chúng phải sử dụng 

cùng giao thức như là ngôn ngữ giao tiếp chung của mạng. 

 
Có các giao thức đối với tốc độ truyền, khuôn dạng dữ liệu, cơ chế kiểm soát lỗi,... Bộ giao 

thức truyền thông phổ biến hiện nay được dùng trong mạng toàn cầu Internet là TCP/IP 

(Transmission Control Protocol/Internet Protocol). 

3. Phân loại mạng máy tính 

Dưới góc độ địa lí, mạng máy tính có thể được phân thành: mạng cục bộ, mạng diện rộng, 

mạng toàn cầu,... 

Mạng cục bộ (LAN - Local Area Network) là mạng kết nối các máy tính ở gần nhau, chẳng hạn 

trong một phòng, một toà nhà, một xí nghiệp, một trường học,...  

 
Mạng cục bộ ở một văn phòng nhỏ 

       Mạng diện rộng (WAN - Wide Area Network) là mạng kết nối những máy tính ở cách nhau 

những khoảng cách lớn. Mạng diện rộng thường liên kết các mạng cục bộ. 

 

4. Các mô hình mạng  

      Xét theo chức năng của các máy tính trong mạng, có thể phân mạng thành hai mô hình chủ 

yếu sau: 

a) Mô hình ngang hàng (peer-to-peer) 

      Trong mô hình này, tất cả các máy tính đều bình đẳng với nhau. Điều đó có nghĩa là mỗi máy 

vừa có thể cung cấp trực tiếp tài nguyên của mình cho các máy khác, vừa có thể sử dụng trực tiếp 

tài nguyên của các máy khác trong mạng. 

Giao thức truyền thông là bộ các quy tắc phải tuân thủ trong việc trao đổi thông tin trong 

mạng giữa các thiết bị nhận và truyền dữ liệu.  
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 Mô hình ngang hàng 

Mô hình này chỉ thích hợp với các mạng có quy mô nhỏ. Tài nguyên được quản lí phân tán, 

chế độ bảo mật kém. Đây là mô hình phù hợp cho các mạng LAN có dưới mười người dùng. Ưu 

điểm của mô hình này là xây dựng và bảo trì đơn giản. 

b) Mô hình khách-chủ (Client-Server) 

Trong mô hình này, một hoặc một vài máy sẽ được chọn để đảm nhận việc quản lí và cung 

cấp tài nguyên (chương trình, dữ liệu,...), được gọi là máy chủ (Server), các máy khác sử dụng tài 

nguyên này, được gọi là máy khách (Client). 

 

 
Mô hình khách-chủ 

Máy chủ thường là máy tính có cấu hình mạnh, lưu trữ được lượng lớn thông tin phục vụ 

chung.  

Mô hình khách-chủ có ưu điểm là dữ liệu được quản lí tập trung, chế độ bảo mật tốt, thích 

hợp với các mạng trung bình và lớn. 

Ví dụ, các máy tính trong một trường học được nối mạng, một máy chủ có cấu hình mạnh và 

bộ nhớ lớn lưu trữ các phần mềm ứng dụng, chứa thông tin về học sinh, giáo viên, kết quả bài kiểm 

tra, bài thi, phần mềm học tập,... Các máy khác khai thác thông tin ở máy chủ, đóng vai trò 

máy khách. 

 

 

Máy chủ là máy tính đảm bảo việc phục vụ các máy khách bằng cách điều 

khiển việc phân bố tài nguyên nằm trong mạng với mục đích sử dụng chung. 

Máy khách là máy sử dụng tài nguyên do máy chủ cung cấp. 
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BÀI 2. MẠNG THÔNG TIN TOÀN CẦU INTERNET 

1. Internet là gì? 

 

 

 

 

Internet đảm bảo một phương thức giao tiếp hoàn toàn mới giữa con người với con người. 

Những người dùng ở khoảng cách xa vẫn có thể giao tiếp (nghe, nhìn) trực tuyến với nhau thông 

qua các dịch vụ Internet (ví dụ như Chat, Video chat, điện thoại Internet,...). Nhờ Internet, người 

dùng còn có thể nhận được lượng thông tin khổng lồ một cách thuận tiện với thời gian tính bằng 

giây và chi phí thấp. 

 
Có hàng trăm triệu người sử dụng Internet nhưng không có ai là chủ sở hữu của nó. Internet 

được tài trợ bởi các chính phủ, các cơ quan khoa học và đào tạo, các doanh nghiệp và hàng triệu 

người trên thế giới. Tổ chức "Hội đồng về kiến trúc Internet", gồm những người tình nguyện, điều 

khiển mạng này. 

Internet được thiết lập vào năm 1983 và không ngừng phát triển nhờ có nhiều người dùng sẵn 

sàng chia sẻ những sản phẩm của mình cho mọi người cùng sử dụng, nhờ công nghệ cho các máy 

chủ ngày càng cải tiến và nguồn thông tin trên mạng ngày càng phong phú.  

2. Kết nối Internet bằng cách nào?  

Hai cách phổ biến để kết nối máy tính với Internet là sử dụng môđem qua đường điện thoại và 

sử dụng đường truyền riêng. 

a) Sử dụng môđem qua đƣờng điện thoại 

Để kết nối Internet sử dụng môđem qua đường điện thoại: 

   Máy tính cần được cài đặt môđem và kết nối qua đường điện thoại. 

   Người dùng cần kí hợp đồng với nhà cung cấp dịch vụ Internet (ISP - Internet Service 

Provider) để được cấp quyền truy cập (tên truy cập (User name), mật khẩu (Password), số điện thoại 

truy cập). 

Cách kết nối này rất thuận tiện cho người dùng nhưng có một nhược điểm là tốc độ đường 

truyền không cao. 

b) Sử dụng đƣờng truyền riêng (Leased line) 

Để sử dụng đường truyền riêng:  

  Người dùng thuê một đường truyền riêng; 

  Một máy tính (gọi là máy uỷ quyền (Proxy)) trong mạng LAN được dùng để kết nối với 

nhà cung cấp dịch vụ Internet. Mọi yêu cầu truy cập Internet từ các máy trong mạng LAN được thực 

hiện thông qua máy uỷ quyền. 

Ưu điểm lớn nhất của cách kết nối này là tốc độ đường truyền cao. 

Internet là mạng máy tính khổng lồ, kết nối hàng triệu máy tính, mạng máy tính trên 

khắp thế giới và sử dụng bộ giao thức truyền thông TCP/IP. Internet đảm bảo cho mọi 

người khả năng thâm nhập đến nhiều nguồn thông tin thường trực, cung cấp các chỉ 

dẫn bổ ích, dịch vụ mua bán, truyền tệp, thư tín điện tử và nhiều khả năng khác nữa. 
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c) Một số phương thức kết nối khác 

Sử dụng đường truyền ADSL (Asymmetric Digital Subscriber Line - đường thuê bao số bất 

đối xứng), tốc độ truyền dữ liệu cao hơn rất nhiều so với kết nối bằng đường điện thoại. Do giá 

thành thuê bao ngày càng hạ nên việc sử dụng đường truyền này đang được rất nhiều khách hàng lựa 

chọn.  

Ngoài ra, hiện nay đã có nhiều nhà cung cấp dịch vụ kết nối Internet qua đường truyền hình 

cáp. 

 
 Truy cập Internet không dây 

Trong công nghệ không dây, Wi-Fi là một phương thức kết nối Internet mới nhất, thuận tiện 

nhất. Wi-Fi cung cấp khả năng kết nối Internet ở mọi thời điểm, mọi nơi, thông qua các thiết bị truy 

cập không dây như điện thoại di động, máy tính xách tay,... 

 

 

BÀI 3. MỘT SỐ DỊCH VỤ CƠ BẢN CỦA INTERNET 

 

Nhờ các dịch vụ của Internet mà người dùng có thể truy cập, tìm kiếm thông tin, nghe nhạc, 

xem video, chơi game, hội thoại,... Trong những ứng dụng đó phải kể đến các ứng dụng phổ biến là 

tổ chức và truy cập thông tin, tìm kiếm thông tin và thư điện tử. 

1. Tổ chức và truy cập thông tin  

a) Tổ chức thông tin 

Các thông tin trên Internet thường được tổ chức dưới dạng siêu văn bản. Siêu văn bản là văn 

bản tích hợp nhiều phương tiện khác nhau như: văn bản, hình ảnh, âm thanh, video,... và các liên kết 

tới các siêu văn bản khác và thường được tạo ra bằng ngôn ngữ đánh dấu siêu văn bản HTML 

(HyperText Markup Language). 

Ví dụ, với siêu văn bản biểu diễn bản đồ thế giới, khi người dùng nháy chuột vào một quốc 

gia thì có thể nhận được các thông tin đa dạng về quốc gia đó như dân số, diện tích,... (dưới dạng 

văn bản); bản đồ địa lí, quốc kì,... (dưới dạng hình ảnh); quốc ca, nhạc dân tộc,... (dưới dạng âm 

thanh). 

Siêu văn bản được gán một địa chỉ truy cập được gọi là trang web. 

Chú ý: Trong thực tế, siêu văn bản chưa có địa chỉ truy cập cũng được gọi là trang web. 

Để tìm kiếm các trang web nói riêng, các tài nguyên trên Internet nói chung và đảm bảo việc 

truy cập đến chúng, người ta sử dụng hệ thống WWW (World Wide Web). Hệ thống WWW được 

cấu thành từ các trang web và được xây dựng trên giao thức truyền tin đặc biệt, gọi là giao thức 

truyền tin siêu văn bản HTTP (HyperText Transfer Protocol).  

Website là một hoặc nhiều trang web trong hệ thống WWW được tổ chức dưới một địa chỉ 

truy cập. 
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Trang chủ (HomePage) của một website là trang web được mở ra đầu tiên khi truy cập 

website đó. Do đó, địa chỉ truy cập của một website chính là địa chỉ trang chủ của nó. 

Ví dụ, website Mạng giáo dục của Bộ Giáo dục và Đào tạo có địa chỉ www.edu.net.vn. 

Có thể dùng phần mềm soạn thảo văn bản để tạo một trang web đơn giản. Tuy nhiên, hiện nay 

có nhiều phần mềm chuyên thiết kế và quản lí các trang web, chẳng hạn như Microsoft FrontPage. 

Có hai loại trang web: trang web tĩnh và trang web động. ở khía cạnh người dùng thì trang 

web tĩnh có thể xem như là siêu văn bản được phát hành trên Internet với nội dung không thay đổi 

còn trang web động mở ra khả năng tương tác giữa người dùng với máy chủ chứa trang web. Cơ chế 

hoạt động của các trang web động là mỗi khi có yêu cầu từ máy người dùng, máy chủ sẽ thực hiện 

tìm kiếm dữ liệu và tạo trang web có nội dung theo đúng yêu cầu rồi gửi về cho máy người dùng.  

Ví dụ, một trong những trang web động được nhiều người quan tâm và truy cập là trang web 

tra cứu điểm thi đại học. Người dùng chỉ cần nhập vào số báo danh, họ tên thí sinh, trường dự thi là 

có thể nhận được trang web kết quả thi của thí sinh.  

 

 
Trang web động 

Khả năng tạo các trang web động đã làm cho Internet trở thành môi trường tốt để triển khai 

thương mại điện tử, dạy học điện tử, chính phủ điện tử,... 

b) Truy cập trang web 

Để truy cập đến trang web người dùng cần phải sử dụng một chương trình đặc biệt được gọi 

là trình duyệt web. 
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Nhờ các liên kết, trình duyệt web có thể chuyển từ trang web này sang trang web khác một 

cách dễ dàng. Do đó, việc truy cập các trang web còn được gọi là duyệt web. 

Có nhiều trình duyệt web khác nhau, trong đó thông dụng nhất là các trình duyệt: Internet 

Explorer và Netscape Navigator. 

 
Trình duyệt Internet Explorer 

Để truy cập một trang web đã biết địa chỉ, ta phải gõ địa chỉ đó vào thanh địa chỉ (Address) 

rồi nhấn phím Enter hay nháy chuột vào nút Go. Trình duyệt web sẽ tìm và hiển thị trang web đó 

nếu tìm thấy.  

Các trình duyệt web có khả năng tương tác với nhiều loại máy chủ. Thông tin nhận được từ 

máy chủ sẽ được trình duyệt web hiển thị dưới dạng thuận tiện cho việc theo dõi. 

 

2. Tìm kiếm thông tin trên Internet 

Một nhu cầu phổ biến của nhiều người dùng là: Làm thế nào để truy cập được các trang web 

chứa nội dung liên quan đến vấn đề mà mình quan tâm?  

Có hai cách thường được sử dụng: 

 Tìm kiếm theo danh mục địa chỉ hay liên kết được các nhà cung cấp dịch vụ đặt trên 

các trang web; 

   Ví dụ, trang web http://www.echip.com.vn/ cung cấp khá nhiều kiến thức phổ thông về công 

nghệ thông tin hay trang web cung cấp danh mục website của 500 trường đại học hàng đầu của thế 

giới: 

http://ed.sjtu.edu.cn/rank/2004/top500(1-100).htm. 

 Tìm kiếm nhờ các máy tìm kiếm (Search Engine). Máy tìm kiếm cho phép tìm kiếm 

thông tin trên Internet theo yêu cầu của người dùng.  

Trình duyệt web là chương trình giúp người dùng giao tiếp với hệ thống WWW: 

truy cập các trang web, tương tác với các máy chủ trong hệ thống WWW và 

các tài nguyên khác của Internet. 

 

Thanh địa chỉ 

http://ed.sjtu.edu.cn/rank/2004/top500(1-100).htm
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Người dùng nhập từ cần tìm kiếm và nhận được danh mục các địa chỉ có nội dung chứa từ cần 

tìm kiếm. Có thể truy cập các trang web tìm được bằng cách nháy chuột vào liên kết tương ứng. 

Hiện nay có nhiều website cung cấp máy tìm kiếm, trong đó có thể kể đến: 

o Google: http://www.google.com.vn 

o Yahoo: http://www.yahoo.com 

o Alta Vista: http://www.altavista.com 

o MSN: http://www.msn.com 

Để sử dụng máy tìm kiếm, hãy gõ địa chỉ của website tương ứng vào thanh địa chỉ của trình 

duyệt Internet Explorer rồi nhấn phím Enter. 

Ví dụ, để tìm kiếm thông tin bằng máy tìm kiếm trên website Yahoo, gõ dòng địa chỉ 

http://www.yahoo.com rồi nhấn phím Enter. Sau đó, theo các chỉ dẫn trên màn hình để thực hiện 

tìm kiếm. Chẳng hạn, gõ từ khoá liên quan đến vấn đề cần tìm vào ô Search the Web rồi nháy 

chuột vào nút Yahoo!Search để thực hiện tìm kiếm. Kết quả tìm kiếm sẽ được hiển thị ngay sau đó. 

 
Tìm kiếm thông tin bằng Yahoo  

3. Thƣ điện tử  

Thư điện tử (Electronic Mail hay E-mail) là dịch vụ thực hiện việc chuyển thông tin trên 

Internet thông qua các hộp thư điện tử. Sử dụng dịch vụ này ngoài nội dung thư có thể truyền kèm 

tệp (văn bản, âm thanh, hình ảnh, video,...).  

Để gửi và nhận thư điện tử, người dùng cần đăng kí hộp thư điện tử (còn được gọi là tài khoản 

thư điện tử), do nhà cung cấp dịch vụ thư điện tử cấp phát, gồm tên truy cập và mật khẩu để truy cập 

khi gửi/nhận thư điện tử.  

Mỗi hộp thư điện tử được gắn với một địa chỉ thư điện tử duy nhất có dạng: 

<tên truy cập>@<địa chỉ máy chủ của hộp thư>, 

trong đó, tên truy cập do người dùng hộp thư tự đặt. 

        Ví dụ: Với địa chỉ thuhien@yahoo.com thì thuhien là tên truy cập còn yahoo.com là địa chỉ 

của máy chủ.  

Tương tự hệ thống bưu chính, để thực hiện dịch vụ thư điện tử cần có nơi trung chuyển và 

phân phát thư (máy chủ – Mail Server), hộp nhận thư (Inbox), địa chỉ (Address) và nội dung thư 

(Message). Để gửi thư điện tử, người gửi phải chỉ rõ địa chỉ hộp thư điện tử của người nhận. Nội 

dung thư điện tử gửi đi sẽ được lưu trong hộp nhận thư ở máy chủ. Nhờ trình duyệt web hoặc 

chương trình chuyên dụng, người dùng có thể mở thư trong hộp thư để xem và có thể tải về máy của 

mình. 

Do múi giờ các vùng, miền trên thế giới có thể khác nhau (ví dụ khi ở Hà Nội  đang là 2 giờ 

chiều thì ở Niu Oóc đã là 2 giờ sáng) nên việc trao đổi thông tin qua đường điện thoại là khá bất 

tiện. Nhờ dịch vụ E-mail, ta có thể viết thư và nhận thư vào thời điểm thích hợp. Hơn nữa, dùng thư 

Gõ từ hoặc cụm từ cần 

tìm kiếm 

http://www.google.com/
http://www.yahoo.com/
http://www.altavista.com/
http://www.msn.com/
http://www.yahoo.com/
mailto:thuhien@yahoo.com
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điện tử, ta có thể gửi thư đồng thời cho nhiều người ở những địa điểm khác nhau trên thế giới và hầu 

như họ đều nhận được ngay sau đó. Giá thành của dịch vụ E-mail thấp vì chỉ phải trả chi phí cho 

việc sử dụng Internet. Tóm lại, gửi/nhận thư điện tử nhanh, thuận lợi và chi phí thấp.  

Hiện nay có rất nhiều nhà cung cấp dịch vụ thư điện tử cho phép người dùng đăng kí hộp thư 

điện tử không thu phí như các website www.fpt.vn, www.yahoo.com, www.hotmail.com,... 

Ngoài những dịch vụ đã nêu, trên Internet còn có nhiều dịch vụ khác nhằm đáp ứng nhu cầu 

ngày càng cao của người dùng. Chẳng hạn, hội thoại trực tuyến (Chat) giúp cho người dùng trao đổi 

thông tin như đang đối thoại với nhau, chơi trò chơi trực tuyến (Game Online),...  

 

BÀI 4:  BÀI TẬP VÀ THỰC HÀNH 

SỬ DỤNG TRÌNH DUYỆT INTERNET EXPLORER 

1. Néi dung 

a) Khởi động trình duyệt IE 

         Ta sẽ làm quen với việc tìm kiếm thông tin nhờ sử dụng trình duyệt Internet Explorer (viết 

tắt là IE). Để khởi động trình duyệt, ta thực hiện một trong các thao tác sau: 

 Nháy đúp chuột vào biểu tượng của IE trên màn hình nền; 

 Nhấn phím Internet trên bàn phím (nếu có).  

Trên màn hình xuất hiện cửa sổ làm việc của IE: 

  

 
Cửa sổ Internet Explorer 

Biểu tượng của IE 
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b)  Truy cập trang web bằng địa chỉ 

 
Trình duyệt Internet Explorer 

            Khi đã biết địa chỉ của một trang web, ví dụ http://www.vnn.vn là trang chủ của 

VietnamNet, để truy cập trang web đó thực hiện theo các bước sau: 

 Gõ vào dòng Address http://www.vnn.vn; 

 Nhấn phím Enter.  

Trang web được mở ra  

c) Duyệt trang web 

 Nháy chuột vào nút lệnh  (Back) để quay về trang trước đã duyệt qua; 

 Nháy chuột vào nút lệnh  (Forward) để đến trang tiếp theo trong các trang đã duyệt qua; 

 Nháy chuột vào các liên kết để chuyển từ một trang web này đến một trang web khác. 

Chú ý: Các liên kết thường là những cụm từ được gạch chân hoặc được hiển thị với màu 

xanh dương. Có thể dễ dàng nhận biết các liên kết bằng việc con trỏ chuột sẽ chuyển thành hình bàn 

tay  khi di chuột vào chúng.  

   Ví dụ, nháy chuột vào liên kết Văn hoá của trang www.vnn.vn thì trang web về văn hoá của 

www.vnn.vn sẽ được hiển thị. 

 

Dòng 

địa chỉ 

http://www.vnn.vn/
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Người dùng có thể dừng lại để đọc các thông tin hoặc nháy chuột vào các liên kết khác trong 

trang này để mở ra các trang web tương ứng. 

 

d)  Lƣu thông tin 

Nội dung trên trang web (đoạn văn bản hoặc ảnh hoặc 

cả ảnh và văn bản) có thể được in ra hoặc lưu vào đĩa.  

Để lưu hình ảnh trên trang web đang mở, ta thực hiện 

các thao tác: 

 Nháy nút phải chuột vào hình ảnh cần lưu, một bảng chọn 

được mở ra. 

 Nháy chuột vào mục Save Picture As..., khi đó Windows 

sẽ hiển thị hộp thoại để ta lựa chọn vị trí lưu ảnh;  

 Lựa chọn thư mục chứa ảnh và đặt tên cho tệp ảnh (nếu không 

 chấp nhận tên mặc định); 

 Nháy chuột vào nút Save để hoàn tất. 

Để lưu tất cả thông tin trên trang web hiện thời, ta thực hiện các thao tác: 

 

 Chọn lệnh File Save As... (h. 103); 

 Đặt tên tệp và chọn vị trí lưu tệp trong  hộp thoại được 

mở ra; 

 Nháy chuột vào nút Save để hoàn tất việc lưu trữ.  

Để in thông tin trên trang web hiện thời, ta chọn lệnh 

FilePrint... . Khi đó Windows sẽ hiển thị hộp thoại cho 

phép ta tiến hành in. 

 

 

e. Dịch vụ tìm kiếm thông tin bằng Google: 
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f, Sử dụng dịch vụ Google drive trên Gmail để chia sẻ file có dung lƣợng lớn:  
Google Drive - còn được gọi là Google Drive, Google Cloud hoặc Gmail Drive. Đây là dịch 

vụ lưu trữ trực tuyến cho phép người sử dụng lưu tài liệu trên nền đám mây và chia sẻ tập tin khác 

thông qua tài khoản Gmail. Nói theo một cách khác, với Google Drive, người dùng có thể upload 

những dữ liệu quan trọng từ máy tính của mình để tạo một bản sao và có thể download để sử dụng 

những dữ liệu này ở bất kỳ đâu, thông qua máy tính có kết nối Internet. Dịch vụ này cho người sử 

dụng 15Gb lưu trữ miễn phí trên ineternet hay đám mây của Google. Đây được cho là ứng dụng 

rất ưu việt và hoàn toàn miễn phí cho phép người dùng có thể: Sao lưu dữ liệu từ máy tính lên dịch 

vụ đám mây của Google; người sử dụng có thể truy cập dữ liệu từ bất cứ nơi nào, bất cứ lúc nào và 

trên bất kỳ thiết bị nào; người dùng chia sẻ và cùng thao tác lên các tập tin thông qua Google Docs; 

kết nối tài liệu từ trên máy tính của bạn đến các thiết bị di động cầm tay,... 

 

 
 g, Sử dụng phần mềm diệt virus miễn phí: 

 Trên internet, các bạn có thể tìm kiếm được rất nhiều phần mềm diệt virus miễn phí như: 

Avira Antivirus, hay AVG AntiVirus Free 2014.  

B2. GoogleDrive 

B1. Chọn 
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Avira Free Antivirus: Sản phẩm của hãng bảo mật Avira Operations GmbH sẽ giúp hệ 

thống của bạn luôn an toàn nhờ cơ chế bảo vệ theo thời gian thực, có khả năng diệt virus, trojan, 

adware và spyware. Thanh công cụ tích hợp (Avira Search Free Toolbar) cảnh báo kịp thời các liên 

kết web nguy hiểm để bạn tránh không 

truy cập, ngăn chặn hành vi theo dõi người 

dùng của các dịch vụ trực tuyến. 

 

AVG AntiVirus Free 2014 có thể 

tìm diệt virus và các phần mềm độc hại, 

chống đánh cắp dữ liệu; hoạt động nhẹ 

nhàng, chiếm ít tài nguyên bộ nhớ, giao 

diện đẹp mắt mang phong các Modern UI 

của Windows 8. Tính năng cộng thêm File 

Shredder hỗ trợ xóa dữ liệu nhạy cảm triệt 

để, không thể phục hồi.  AVG AntiVirus 

Free 2014 cũng trang bị thanh công cụ 

(AVG Security Toolbar) cho các trình 

duyệt giúp bạn lướt web an toàn hơn. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

h. Một số trang thông tin hữu ích của tỉnh Lào Cai 

- https://mail.laocai.gov.vn: Đây là địa chỉ đăng nhập e-mail của cán bộ, công chức tỉnh 

Lào Cai quy định phải sử dụng. Khi một sở, ban ngành tuyển dụng mới cán bộ, thì cần đăng ký 

với Sở Thông tin và Truyền thông tỉnh để đăng ký địa chỉ e-mail cho cá nhân theo tên miền 

riêng của tỉnh Lào Cai là laocai.gov.vn. 

- http://laocai.gov.vn/: Đây là địa chỉ truy cập Cổng thông tin điện tử của Tỉnh Lào Cai. 

Trên đó tích hợp nhiều cổng thông tin thành viên của các Sở, ban ngành của tỉnh. Tại đây, bạn 

đăng tải đầy đủ các thông tin sự kiện chính trị lớn của tỉnh và nhiều thông tin hữu ích khác tại 

các chuyên mục: Thủ tục hành chính, Hỏi –đáp, Đối thoại trực tuyến,... Ngoài ra, tại đây có 

nhiều đường dẫn đến các website hữu ích khác. 

 

https://mail.laocai.gov.vn/
http://laocai.gov.vn/
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BÀI TẬP 

 

Câu 1. Trong địa chỉ Internet: www.vnn.vn đâu là tên miền: 

A. www.vnn 

B. vnn.vn 

C. www.vnn.vn 

D. Cả 3 mệnh đề trên đều sai 

Câu 2. Trong các thiết bị dưới đây, thiết bị nào không tham gia cấu tạo nên mạng cục bộ LAN 

A. Repeater 

B. Hub 

C. Bridge 

D. Modem 

Câu 3. TCP/IP là gì? 

A. Cấu trúc liên mạng. 

B. Giao thức truyền tin trên mạng. 

C. Phần mềm quản lý truyền tin. 

D. Phần mềm tiện ích internet. 

Câu 4. Giao thức để truyền các tệp tin trên mạng Internet giữa các máy tính với nhau là: 

A. SMTP: Simple Mail Transfer Protocol. 

B. FTP: File Transfer Protocol. 

C. HTTP: HyperText Transfer Protocol. 

D. SNMP: Simple Network Management Protocol. 

Câu 5. Trong các mệnh đề sau mô tả chức năng của mạng Internet, mệnh đề nào đúng: 

A. Internet là mạng máy tính bao gồm các “mạng con” được kết nối với nhau bởi các “cầu 

nối”. 

B. Trên mạng Internet ngoài TCP/IP còn có thể sử dụng nhiều giao thức khác nhau. 

C. Internet là một mạng máy tính cài đặt nhiều dịch vụ khác nhau cùng dựa trên nền giao 

thức TCP/IP. 

D. Internet là mạng máy tính toàn cầu cung cấp dịch vụ TCP/IP cho các mạng khác. 

Câu 6. Trong 2 tên miền laocai.edu.vn và cntt.laocai.edu.vn thì tên miền nào tên miền con của tên 

miền còn lại:  

A. laocai.edu.vn  

B. cntt.laocai.edu.vn  

C. edu.vn  

D. cntt.laocai.edu 

Câu 7. Dung lượng Google Mail (miễn phí) hiện nay là: 

a. 5 GB   

b. 10GB   

c. 15GB   

d. 20GB 

Câu 8. Để xem các website, lịch sử của trình duyệt web (Internet Explorer, FireFox, Chrome,...) ta 

ấn tổ hợp phím: 

A. Ctrl +H   

B. Alt+H   

C. Shift+H   

D. Del +H 

Câu 9. Trình duyệt nào là trình duyệt internet do người Việt xây dựng 

a. Firefox 

b. Chrome 

c. Cốc cốc 

d. Cafef

Câu 10. Địa chỉ e-mail nào bắt buộc cán bộ công chức tỉnh Lào Cai sử dụng 

a. laocai.gov.vn 

b. gmail.com.vn 

c. yahoo.com.vn 

d. email.laocai.vn 

 

http://www.vnn.vn/
http://www.vnn/
http://www.vnn.vn/

